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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Symbols and safety labels

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF supply voltage

Observe product documentation

Caution when handling heavy equipment @ Standby indication

Danger of electric shock - Direct current (DC)

> B>
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Basic Safety Instructions

Meaning Symbol Meaning

Warning! Hot surface o Alternating current (AC)

Protective conductor terminal —~_ Direct/alternating current (DC/AC)

Ground I:l Device fully protected by double (reinforced)
insulation

Ground terminal EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

Be careful when handling electrostatic sensitive
devices

EU labeling for separate collection of electrical
and electronic devices

For additonal information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

> b EEEp

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

Indicates an imminently hazardous situation which, if not avoided, will result
A DANGER in death or serious injury.
Indicates a potentially hazardous situation which, if not avoided, could result
in death or serious injury.

A WARNING

Indicates a potentially hazardous situation which, if not avoided, could result
in minor or moderate injury.

Indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution severity 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the AC supply network, or if the power
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and
accessible at all times. For example, if the power plug is the disconnecting device, the length of the
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing
disconnection from the AC supply network. If products without power switches are integrated into
racks or systems, the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

1.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages V,,s > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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Basic Safety Instructions

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

EMC classes (in line with CISPR 11)

Class A: Equipment suitable for use in all environments except residential environments and
environments that are directly connected to a low-voltage supply network that supplies residential
buildings.

Class B: Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings.

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.
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Basic Safety Instructions

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal/lEnvironmental protection

1.

Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.
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Instrucciones de seguridad elementales

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estdndares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
estd destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacion del producto.

Simbolos y definiciones de seguridad

Simbolo

Significado

Simbolo

Significado

Aviso: punto de peligro general

Observar la documentacion del producto

| O

Tensién de alimentacion de PUESTA EN
MARCHA / PARADA

Atencion en el manejo de dispositivos de peso
elevado

Indicacion de estado de espera (standby)

Peligro de choque eléctrico

Corriente continua (DC)

Advertencia: superficie caliente

Corriente alterna (AC)

Conexién a conductor de proteccion

Corriente continua / Corriente alterna (DC/AC)

Conexion a tierra

El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)

EEE>>P>

Conexiéon a masa

Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacién/proteccion del medio ambiente”,
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Simbolo Significado

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electrénicos

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccion
"Funcionamiento”, punto 7.

Palabras de seiial y su significado

En la documentacioén del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
economica europea. Pueden existir definiciones diferentes a esta definicidn en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacién con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas Yy tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segutn lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, uso solamente en estancias interiores, utilizacion hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No situe el producto encima de superficies, vehiculos, estantes 0 mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacién del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacién del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion maévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €j., el enchufe de conexion a la red es el dispositivo de desconexion, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electronicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacién adecuadas, de que el cable de conexion a red no pueda ser dafiado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.

1171.0000.42 - 06 Page 10



10.

1.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensién Uy > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacién
de tension, corte protector, aislamiento etc.).

Para la conexién con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacién y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningun objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitroceluldsicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracién durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas Y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion/proteccion del medio ambiente", punto 1.

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcion de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo bioldgico a causa de
las propiedades de su radiacion y debido a su concentracion extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacion del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Clases CEM (segun CISPR 11)

Clase A: dispositivo apropiado para el uso en cualquier zona excepto en areas residenciales y en
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensién que alimenta
un edificio de viviendas.

Clase B: dispositivo apropiado para el uso en areas residenciales y en aquellas zonas que se
encuentran conectadas a una red de suministro de baja tensiéon que alimenta un edificio de viviendas.

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.
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2.

Instrucciones de seguridad elementales

El ajuste, el cambio de partes, el mantenimiento y la reparaciéon deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Yy limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. ej. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.
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Instrucciones de seguridad elementales

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacion/proteccion del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencion al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacion de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencién
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacion adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacién de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacion incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde &Schwarz-
Qualitadtsmanagementsystem ist u.a.
nach ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 1ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

11SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systeme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001

1171.0200.11 V 04.01




CE Declaration of Conformity

Certificate No.: 2010-8

This is to certify that:

Equipment type Stock No. Designation
SMBV100A 1407.6004.02 SMBV100A VECTOR SIGNAL
GENERATOR

complies with the provisions of the Directive of the Council of the European Union on the
approximation of the laws of the Member States

- relating to electrical equipment for use within defined voltage limits
(2006/95/EC)

- relating to electromagnetic compatibility
(2004/108/EC)

Conformity is proven by compliance with the following standards:

EN 61010-1: 2001

EN 61326-1: 2006

EN 61326-2-1: 2006

EN 55011: 2007 + A2: 2007, class B

EN 61000-3-2: 2006

EN 61000-3-3: 1995 + A1: 2001 + A2: 2005

For the assessment of electromagnetic compatibility, the limits of radio interference for Class
B equipment as well as the immunity to interference for operation in industry have been used
as a basis.

ROHDE & SCHWARZ GmbH & Co. KG
Miihldorfstr. 15, D-81671 Miinchen

Munich, 2010-02-17 Central Quality Management MF-QZ / Radde

CE E-1



Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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R&S®SMBV100A Preface

Documentation Overview

1 Preface

1.1 Documentation Overview

The user documentation for the R&S SMBYV consists of the following parts:

e Online Help system on the instrument,
e "Quick Start Guide" printed manual,
e Documentation CD-ROM with:
— Online help system (*.chm) as a standalone help,
— Operating Manuals for base unit and options,
— Service Manual,
— Data sheet and specifications,
— Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SMBYV and all available options.

Quick Start Guide

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start working
with the instrument. Basic operations and an example of setup are described. The manual
includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error mes-
sages is also given.

In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S SMBV is not included in the
option manuals.

The following Operating Manuals are available for the R&S SMBV:
e Digital Standard GSM/EDGE, incl. EDGE+
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e Digital Standard 3GPP FDD, 3GPP FDD enhanced MS/BS tests incl. HSDPA, 3GPP
FDD HSUPA, 3GPP FDD HSPA+

¢ Digital Standard CDMA2000® incl. 1XEV-DV

e Digital Standard 1xEV-DO Rev. A

e Digital Standard IEEE 802.11 (a/b/c) WLAN

e Digital Standard IEEE 802.16 WiMAX

e Digital Standard TD-SCDMA, inclusive TD-SCDMA enhanced features
e Digital Standard DVB-H

e Digital Standard DAB / T-DMB

e Digital Standard IEEE 802.11n WLAN-N

e Digital Standard EUTRA/LTE

e Digital Standard XM Radio

e FM Stereo/RDS

e Digital Standard Sirius Radio

e Digital Standard TETRA Release 2

¢ Digital Standard Bluetooth®Enhanced Data Rate
¢ HD Radio™ Test Waveforms

These manuals can also be orderd in printed form (see ordering information in the data
sheet).

Service Manual

This Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. It describes how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).
Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

Typographical Conventions

The following text markers are used throughout this documentation:

|
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Typographical Conventions

Convention Description

"Graphical user interface ele- All names of graphical user interface elements on the screen, such as dia-

ments" log boxes, menus, options, buttons, and softkeys are enclosed by quota-
tion marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quotation
marks.
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2 Preparing for Use

The following topics will help you to get familiar with the instrument and perform the first
steps:

e Front Panel Tour
® Rear Panel Tour
® Putting into Operation

This section explains the control elements and connectors of the Signal Generator R&S
SMBYV with the aid of the front and rear views and describes how to put the instrument
into operation. It also describes the connection of peripherals such as printer, keyboard
or mouse. Specifications of interfaces can be found in the data sheet.

The chapter 3, "Getting Started", on page 50 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating instruc-
tions and an overview of menus follow in chapter 4, "Manual Operation”, on page 63.

For all reference information concerning manual and remote control of the instrument
refer to the online help system or its printed/printable version. A more detailed description
of the hardware connectors and interfaces is also part of the help system.

2.1 Front Panel Tour

The front panel of the R&S Signal Generator consists of the VGA display, some utility
keys (left side) and the hardkey area with connectors and control interfaces (right side).
The subsequent sections provide brief explanations on the controls and connectors, the
hardkey area and the front panel.

Frequency Level

[ ESC ] [mﬁm&] [ num::

PEP
| 2.140 000 000 00 [st: -] | 15.55 dim [ 5.00 [dn ]
I ¥

Info

NRP-Z81 499dBm RF

I On
Mp

(2]
- -
P

L 4= B
I

&
%eﬂb

RFS0S2 (&5

: Graphics NRP-Z
ACERERY | Settings Viewer | | I

Fig. 2-1: Front panel view
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2.1.1 Utility Keys

The keys to the left of the display cause the R&S SMBYV to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings".

PRESET
Sets the instrument to a defined state (see chapter 2.3.4.4, "Default Set-
tings", on page 34).

LOCAL
Switches from remote control to local (manual) control.

SETUP
Opens the "Setup" dialog for configuring presettings.

For more information, see chapter 5.2.3, "General Configuration of Instrument - Setup
Key", on page 105.

HCOPY
Opens the "Hardcopy" menu for configuring and starting printing.

For more information, see chapter 5.2.5, "Generating a Hard Copy of the Dis-
play", on page 133.

INFO
Displays status messages, error messages and warnings.

HELP
Displays context-sensitive help text.

21.2 Standby LEDs and Standby Key

UT ST’T”DBY The standby LEDs and the ON/STANDBY key are located in the bottom left corner of the
= o front panel.

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
e the green LED (left) is on when the instrument is ready for operation,
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Front Panel Tour

e the yellow LED (right) is on in the standby mode.
See also chapter 2.3.4.1, "Standby and Ready state", on page 33.

Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:

e Frequency and level display with info line
— Frequency and level settings containing offset and peak envelope power (PEP).

— Status messages

— Brief error messages.
To access an window with detailed information for a message, use the INFO key.

e Block diagram
The block diagram shows the current configuration and the signal flow in the gener-
ator with the aid of function blocks containing an on/off switch. Selecting a function
block opens a list of associated setting menus. Active menus, info windows and
graphs are displayed on top of the block diagram. The block diagram can be displayed
in the foreground anytime with the DIAGRAM key.

e "Winbar" with labelled softkeys

Open menus are indicated by a labelled button in the "Winbar". The buttons determine
the softkey functions for front-panel control. When a button or softkey is pressed, the
associated menu is displayed either in the foreground or minimized in the "Winbar".
If required, the WINBAR is covered by a row of buttons to which menu-specific func-
tions of the active menu are assigned. By pressing the WINBAR key, the "Winbar"
can be displayed in the foreground again. This allows the user to toggle between the
button and softkey functions.

For detailed information, see chapter 4.2, "Display", on page 68.

Setup Keys

The keys to the right of the display set parameters, select views and control the windows.

Keys for Setting Paramters

These keys provide direct access to the settings in the header of the instrument and can
be used for fast changing the state of the modulation and the RF signal.

[ FREQ ] [LEUEL] [ FILE ]
RF MOD RECAL-
ONJOFF ONJOFF CULATE

For more information refer to chapter "Instrument Functions".
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FREQ
Activates frequency entry.

RF ON/OFF
Switches the RF signal on and off.

"RF OFF" is displayed in the header next to the "Frequency" field.

LEVEL
Activates level entry.

MOD ON/OFF
Switches the modulations on and off.

"MOD OFF" is displayed in the info line of the header next to the "Level" field.

FILE
Activates the menu for storing or loading files (see chapter 4.7, "File Manage-
ment", on page 91).

RECALCULATE
Starts the recalculation of instrument settings.

If time-consuming calculations are required, the active modulation is automatically
switched off and the calculation is interrupted to allow the user to make further settings.
Calculation is restarted by a keystroke and the modulation is switched on again after the
calculation is completed.

Display Keys

The keys on top of the rotary knob and the keys below the numeric key pad arrange
different windows on the display.

[ B'AG“] L'“Ewu Y [wear | f )
ESC mﬁmn REARR | |

DIAGRAM
Brings the block diagram to the foreground. Active menus are minimized.

Active menus are indicated by the buttons in the "Winbar".

ESC

The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or parameter
is retained.

e In dialog boxes that contain a "Cancel" button it activates that button.
Closes all kinds of dialog boxes, if the edit mode is not active.
Quits the edit mode, if the edit mode is active.

|
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e Switches between different entry fields of a menu.

e Shifts the entry cursor from the header display to the previously active menu, or to
the previously highlighted block in the block diagram if no menu is active.

e Shifts the cursor from a function block in the diagram to the first item in the "Win-
bar". If no menus are open, the current cursor position remains unchanged.

TOGGLE

e Switches highlighted elements or a function block on and off.

e Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.

MENU
Calls the menu tree.

CLOSE

Closes the active menu.

e |[f the entry mode is active, changes are cancelled.

e |f settings in this menu require acknowledgement by means of an "Accept" button, a
query is displayed asking whether the changes made should be cancelled.

HIDE
Minimizes the active open menu. The associated button in the "Winbar" remains visible.

REARR
Adjusts the size of the active menu to use the whole hight of the dislay.

WINBAR
Toggles between the active menus.

Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor posi-
tion. Multiple decimal points are not allowed.

+/- Changes the sign of a numeric parameter. In the case of an alphanumeric parameter, inserts
a hyphen at the cursor position.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a recal-
culation without changing the absolute value. The function depends on the time at which the
UNIT key is used during parameter entry (see chapter 4.4.5, "Working with Units

", on page 80).

For unit-free values, the X1 key is equivalent to ENTER. It confirms the previous entry and
deactivates the input field.

Adds a blank in a character input field.

L Enters special characters. Toggles through the available characters if the key is pressed sev-
eral times in a row.

A<->a Toggles between uppercase and lowercase characters.

A, B, C, D, E, | Enters hexadecimal values. The letters assigned to the keys are automatically active when
F an entry field with a hexadecimal value is active.

INSERT
Toggles between insert and overwrite mode (see also chapter 4.4.4, "Entering a
Value", on page 79 ).

BACKSPACE
Deletes the last character before the cursor position or the selected character sequence.

ENTER
Pressing the rotary knob has the same effect.

e Concludes the entry of dimensionless entries. For other entries, this key can be used
instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

e C(Calls the next menu level.

2.1.6 Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.
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ROTARY KNOB

The rotary knob has several functions:

e Increases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the ENTER key, when it is pressed.

e Shifts the selection bar within focused areas (e.qg. lists), if the edit mode is activated.

Note: Turning or pressing the rotary knob is equivalent to pressing the UP and DOWN
keys or the ENTER key in the keypad.

@ NAVIGATION KEYS
@ @ The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
@ to the rotary knob.
UP/ DOWN The up and down arrow keys do the following:
KEYS e In a numeric edit dialog box, increase or decrease the instrument
parameter.
e |n a list, table, window or dialog box, scroll vertically.

LEFT/ RIGHT  The left and right arrow keys do the following:
KEYS e |n an alphanumeric edit dialog box, move the cursor forward and
back.

e In alist, table, window or dialog box, scroll horizontally.

2.1.7 Front Panel Connectors

The RF and I/O connectors and various additional interface connectors are located on
the front panel.

1,Q
1-© -©

® 6

I and Q inputs for external analog modulation signal in case of I/Q modulation.

For more information see:
e chapter 5.8.2, "Data and Signal Sources in Baseband", on page 274

RES0C e RF OUTPUT
= Outputs for RF signal.

NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum permis-
sible back-feed is specified in the data sheet.

UsB USB
=] USB (universal serial bus) interfaces of type A (host USB).

e Connection of peripherals such as mouse or keyboard
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e Connection of memory stick for file transmission
e Firmware update

Note: Another USB interface type A (host USB) and a USB interface type B (device USB
for data transmission) are available on the rear panel.

See also chapter 2.4.1, "Connecting USB Devices", on page 36.

2.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing detailed
information. For technical data of the connectors refer to the data sheet.

'SYSTEM DRIVE
DO NOT REMOVE DURING OPERATION

F1/FEIEC 60127 - T315H / 250V 100.. 240V AC /50 . 80 Hz/ 14 . A5 A

Fig. 2-2: Rear panel view

2.2.1 Description of the Connectors

THNECETIICE | OUT/QOUT
{ Direct output or Differential (non-inverting) output for analog 1/Q signal.

See also chapter 5.6.3, "Output of the Baseband Signal - I/Q Out", on page 264.

1 OUT BAR/Q OUT BAR

Differential (inverting) output for analog 1/Q signal.
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See also chapter 5.6.3, "Output of the Baseband Signal - I/Q Out", on page 264.

MARKER 1, 2
Outputs 1 and 2 for triggering and control of external devices with user-definable marker
signals.

For more information see chapter 5.2.3.12, "Global Trigger/Clock/External Input Set-
tings", on page 121.

USB IN
USB (universal serial bus) interface of type B (device USB).

This interface can be used for remote control of the instrument.

USB CONNECTORS TYPE A
USB (universal serial bus) interfaces of type A (host USB).

e Connection of peripherals such as mouse, keyboard, etc.
e Connection of memory stick for file transmission
e Firmware update

Further USB interface type A are available on the front panel.

See also chapter 2.4.1, "Connecting USB Devices", on page 36.

DIGITAL IQ IN/OUT

Connector for the input/output of a digital I/Q signal from/to an R&S instrument, like a
signal generator, analyzer or the R&S EX-IQ-BOX. The interface requires option R&S
SMBV-K18, Digital Baseband Connectivity.

LAN CONNECTOR

Ethernet interface

e Forintegrating signal generators in a network
e Remote control of signal generator

e Remote access to the signal generator

e Firmware update

See also:
® chapter 2.6, "Setting Up a Network (LAN) Connection", on page 38
e chapter 6.1.3, "LAN Interface", on page 394

HARD DISC
With respect to security concerns the hard disk can be removed from the instrument, but
it is bound to the specific R&S SMBV. Therefore it cannot be changed between different
instruments.

NOTICE! Risk of instrument damage and data loss!. During operation the instrument is
accessing the hard disk. Removing the hard disk while operating will lead to data loss or
even instrument damage.

Do not remove the hard disk during operation.

|
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CLOCK OUT
Output for internal clock signal.

While working in synchronous master\-slave mode, the system clock is output on this
connector.

See also chapter 5.8.2.3, "Clock Signals", on page 276.

CLOCKIN
Input for the external (symbol) clock signal for synchronizing the external data signal and
working in synchronous master-slave mode.

See also chapter 5.8.2.3, "Clock Signals", on page 276.

NEXT
This trigger input indicates the next (i.e. the 2nd, 3rd, 4th, ...) segment of a multi segment
waveform, which can be a compound of e.g. a sine, a rectangular, or a sawtooth signal.

TRIGGER
Input for external triggering of digital modulations and standards and ARB and the exter-
nal trigger in synchronous master\slave mode.

SENSOR
SENSOR

Connector for R&S NRP-Zxx sensors.

With the aid of the "User Correction" function, a table with correction values for external
test assemblies can be automatically determined, e.g. for compensating the frequency
response of cables.

The power sensors are connected by inserting the male connector. To disconnect hold
the connector by its sleeve. Pulling on the sensor cable will not release the sensor con-
nector.

See also chapter 5.4.6, "NRP-Z Power Viewer", on page 163.

LOIN, LO OUT

Local oscillator input and output:

e LO IN: Input for external LO signals

e LO OUT: Output for internal LO signals.

See also chapter 5.4.5, "Local Oscillator - LO Coupling”, on page 161.

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also chapter A.1, "GPIB Bus Interface", on page 734 and chapter 6.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 398.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines, always
terminate any connected IEC-bus cable with an instrument or a controller.
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SIGNAL VALID
Output of valid signal. This signal marks the valid signal times (valid level and frequency
indication). The signal is generated automatically.

INSTR TRIG
Input for external trigger of sweeps and list mode.

See also chapter 5.4.15, "List Mode", on page 227 and chapter 5.4.14.1, "Over-
view", on page 208.

PULSE VIDEO
Output of internal pulse generator signal or external pulse signal fed in via the PULSE
EXT connector (video signal).

See alsochapter 5.4.12.5, "Pulse Modulation (PM)", on page 199 .

PULSE EXT
Input of external pulse signal or input of external trigger/gate signal for internal pulse
generator.

See alsochapter 5.4.12.5, "Pulse Modulation (PM)", on page 199 .

REF OUT
Output of internal reference signal.

See also chapter 5.4.4, "Reference Oscillator", on page 159.

REF IN
Input for external reference signal.

See also chapter 5.4.4, "Reference Oscillator”, on page 159.

OoCcXo
Oven-controlled reference oscillator (option R&S SMBV-B1)

The OCXO generates a very precise 10 MHz reference signal. It needs some minutes of
warm-up time to reach its nominal frequency.

Refer also to the data sheet for detailed information.

AC SUPPLY AND POWER SWITCH

When the R&S SMBYV is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set the
voltage manually or change fuses.

The instrument comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.

The power switch can be set to two positions:

e 0
The instrument is disconnected from the mains.

o |
The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the instru-
ment front.

|
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See also data sheet and chapter 2.3.3, "Connecting the Instrument to the AC Sup-
ply", on page 32.

EXT HOD &) EXT MOD
Input for external analog modulation signals.

See also "External Modulation Sources" on page 190.

LF
Output for internal LF modulation generator signal.

See also data sheet and chapter 5.4.13.1, "Overview of LF Generator", on page 201,
chapter 5.4.13.2, "LF Output", on page 201.

FUSES
The R&S SMBYV is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use only
fuses of the mentioned type.

CAUTION! Danger of shock hazard!. Before replacing the fuses, disconnect the power
cord from the R&S SMBV.

2.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SMBYV for
the first time.

A WARNING

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.

e Do not open the instrument casing.

e Read and observe the "Basic Safety Instructions" at the beginning of this manual or
on the documentation CD-ROM, in addition to the safety instructions in the following
sections. Notice that the data sheet may specify additional operating conditions.

Risk of instrument damage

Note that the general safety instructions also contain information on operating conditions
that will prevent damage to the instrument. The instrument's data sheet may contain
additional operating conditions.
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Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instrument and to
connected devices. Ensure the following operating conditions before you switch on the
instrument:

e All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

e The instrument is dry and shows no sign of condensation.

e The instrument is positioned as described in the following sections.

e The ambient temperature does not exceed the range specified in the data sheet.
e Signal levels at the input connectors are all within the specified ranges.

e Signal outputs are correctly connected and are not overloaded.

Risk of electrostatic discharge

Protect the work area against electrostatic discharge to avoid damage to electronic com-
ponents in the modules. For details, refer to the safety instructions at the beginning of
this manual.

ON\ EMI impact on measurement results

/' Electromagnetic interference (EMI) can affect the measurement results. To avoid any
impact, make sure that the following conditions are met:

Use suitable double-shielded cables.

Do not use USB connecting cables exceeding 1 m in length.

Use only USB devices that remain within the permissible EMI limits.

Always terminate any connected IEC-bus cables with an instrument or controller.

Outputs and lines have to be terminated properly with 50 Ohms.

For digital interfaces only the cable R&S SMBV-Z6 is permitted for connection. The
associated cable is available under part number 1415.0201.02.

2.3.1 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for completeness
proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.

|
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3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

N\ Packing material

Retain the original packing material. If the instrument needs to be transported or shipped
at a later date, you can use the material to protect the control elements and connectors.

2.3.2

Placing or Mounting the Instrument

The R&S SMBYV is designed for use under laboratory conditions, either on a bench top
or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SMBYV is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.

CAUTION

Risk of injury at the operating site

The feet may fold in if they are not folded out completely or if the instrument is shifted.
This may cause damage or injury.

e Fold the feet completely in or completely out to ensure stability of the instrument.
Never shift the instrument when the feet are folded out.

e When the feet are folded out, do not work under the instrument or place anything
underneath.

e The feet can break if they are overloaded. The overall load on the folded-out feet
must not exceed 500 N.
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Rackmounting

The R&S SMBV can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage in a rack

An unsufficient airflow can cause the instrument to overheat, which may disturb the oper-
ation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are unim-
peded, and that the minimum distance from the wall is 10 cm.

2.3.3 Connecting the Instrument to the AC Supply

The R&S SMBYV is automatically adapted to the AC voltage supplied. There is no need
to set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH
is at the rear of the unit.

» Connect the instrument to the AC power source using the AC power cable delivered
with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

2.3.4 Starting the Instrument

The R&S SMBYV comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from all
power supplies.

Starting up instruments with power switch
1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

After power-up, the instrument is in standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

|
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Starting up instruments without power switch

1. Connect the instrument to the AC supply.

After connection to the AC supply, the instrument is in standby or ready state,
depending on the state of the ON/STANDBY key at the front panel of the instrument
when the instrument was switched off for the last time.

2. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

Standby and Ready state
The ON/STANDBY key is located in the bottom left corner of the front panel.

Switching between standby and ready state

» Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S SMBYV initiates its startup procedure.

In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

Start Display and Booting

The instrument boots the operating system, starts the instrument firmware and automat-
ically performs a selftest. If the previous session was terminated regularly, the instrument
uses the last setup with the relevant instrument settings.

Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the cur-
rent setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument

Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

2343

Function Check

The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.
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A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO key.
In response, a description of the error(s) is displayed.

For more information, refer to chapter 9, "Error Messages", on page 727.

Additionaly to the automatic monitoring, the R&S SMBYV offers the following capabilities
to ensure correct functioning:

e Internal Adjustments
Press the SETUP key and select "System > Internal Adjustments" to access the dia-
log for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

e Selftest
A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled.

Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched off. It is also recomen-
ded that you use the PRESET key to return the instrument to its defined preset state

every time a new configuration is required or the current setup is not anymore relevant.

The R&S SMBYV offers a three-stage preset concept:

e Preset of the settings belonging to a digital standard or associated with one dialog.
Most of the dialog boxes provide a special "Set to Default" button that resets directly
the settings associated to the corresponding dialog, e.g. all digital modulation settings
in the "Custom Digital Mod" dialog.

These settings are identical to those which are called up using the PRESET key.

e Preset the instrument to a predefined state
The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument
settings provide a reproducible initial basis for all other settings. However, functions
that concern the integration of the instrument into a measurement setup are not
changed, e.g. GPIB bus address or reference oscillator source settings.

e Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see chapter 5.2.3.18, "Factory Preset", on page 132.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "RF frequency" = 1 GHz
e "RF level" RF output switched off
o "Offsets"=0

|
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e "Modulations State" = Off

e Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

e Internal level control "Level ALC" = AUTO
e User correction "Level Ucor" = OFF

e "LF output State" = Off

e "Sweep State" = Off

e '"List mode State" = Off

Settings that are not affected by the PRESET key

e Reference frequency settings ("Ref Oscillator" menu)

e Power on settings ("Level/EMF" menu)

e Network settings ("Setup" menu)

e GPIB address ("Setup" menu)

e *IDN? Identification and emulation ("Setup" menu)

e Password and settings protected by passwords ("Setup" menu)
e Start/Stop Gui Update ("Setup" menu)

e Display and keyboard settings ("Setup" menu)

@ User-defined instrument states can be stored and called up in the "File" dialog.

2.3.5 Shutting Down the Instrument

To shut down the R&S SMBYV, proceed as described below.

Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data may
be lost.

Press the ON/STANDBY key first to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.

2. To turn the power off:

a) For instruments with power switch, press the main power switch to position 0
(Off).
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b) For instruments without power switch, pull the power cable at the rear of the
instrument.

Tip:
Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from
all power supplies.

None of the front-panel LEDs should be on.

2.3.6 Power Fuses

The R&S SMBV is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use only
fuses of the mentioned type.

A WARNING

Shock hazard

Before replacing a fuse, make sure that the instrument is switched off and disconnected
from all power supplies.

Always use fuses supplied by Rohde & Schwarz as spare parts, or fuses of the same
type and rating.

2.4 Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S SMBV can be used
to connect a variety of accessories.

In addition the instrument provides interfaces for network integration (see chapter 2.6,
"Setting Up a Network (LAN) Connection”, on page 38).

241 Connecting USB Devices

The USB interfaces on the front and (optionally) rear panels of the R&S SMBYV allow you
to connect USB devices directly to the instrument. This number can be increased as
necessary by using USB hubs. Due to the large number of available USB devices, there
is almost no limit to the expansions that are possible with the R&S SMBV.

The following list shows various USB devices that can be useful:

e Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)

e (CD-ROM drives for easy installation of firmware applications

e Keyboard or mouse to simplify the entry of data, comments, file names, etc.

e Power sensors, e.g. of the NRP Zxy family
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Linux Operating System

Installing USB devices is easy under Linux, because all USB devices are plug&play. After
a device is connected to the USB interface, the operating system automatically searches
for a suitable device driver.

If Linux does not find a suitable driver, it will prompt you to specify a directory that contains
the driver software. If the driver software is on a CD, connect a USB CD-ROM drive to
the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S SMBYV, the operating
system immediately detects the change in hardware configuration and deactivates the
corresponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, the operating system
informs you that the device is ready to use. The device is made available as a new drive
(/usb). The name of the drive is manufacturer-dependent.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default keyboard layout
is English — US.

Use the "Setup > Keyboard Settings" dialog to configure the keyboard properties.

Connecting a mouse

The mouse is detected automatically when it is connected.

Linux Operating System

The instrument contains the Linux operating system. To ensure that the instrument soft-
ware functions properly, certain rules must be adhered to concerning the operating sys-
tem.

Risk of causing instrument unusability

The instrument is equipped with the Linux operating system. Additional software can
therefore be installed on the instrument. The use and installation of additional software
may impair instrument function. Thus, run only programs that Rohde & Schwarz has
tested for compatibility with the instrument software.

The drivers and programs used on the instrument under Linux have been adapted to the
instrument. Existing instrument software must always be modified using only update
software released by Rohde & Schwarz.
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The configuration of the operating system is optimally adapted to signal generator func-
tions in the factory. Changes in the system setup are only required when peripherals like
keyboard are installed or if the network configuration does not comply with the default
settings (see chapter 2.6.1, "Connecting the Instrument to the Network", on page 39).
After the R&S SMBYV is started, the operating system boots and the instrument firmware
is started automatically.

ON\ Accessing Operating System

/ The operating system cannot be accessed.

All necessary system settings can be made in the "Setup"” dialog.

The R&S SMBV provides an internal flash memory and a hard disk (R&S SMBV-B92).
Both, the internal flash memory and the hard disk can be used to store data but the
firmaware is always hold on the internal flash card. However, data transfer is only possible
via a memory stick connected to a USB interface. The memory stick, the hard disk and
the flash memory are accessed via the "File Manager".

Accsessing the File System

The instrument also supports two standard methods to access the file system form a
remote client:
e FTP (file transfer protocol)

e File sharing according to the SAMBA/SMB (server message block) protocol.

Both methods allow the access to the folder /var/user/share.

Default password

The FTP and SAMBA file access use the user "instrument" with default password "instru-
ment".

In is highly recomended to change this password in the Setup > Security > Change User
Password dialog before connecting the instrument to the network!

2.6

Screen saver

A screen saver can be activated in the R&S SMBV. When active, the display is shut off
when no entries via front panel, external mouse or external keyboard are made for a
period of time. The screen saver prolongs the life time of the display.

Use the "Setup > Display Settings" dialog to switch on or off the screen saver and to
adjust the screen saver settings.

Setting Up a Network (LAN) Connection

The R&S SMBYV is equipped with a network interface and can be connected to an Ethernet
LAN (local area network). Provided the appropriate rights have been assigned by the
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network administrator and the Linux firewall configuration is adapted accordingly, the
interface can be used, for example:

e To transfer data between a controller and the tester, e.g. in order to run a remote
control program.
See chapter 6, "Remote Control Basics", on page 392.

e To access or control the measurement from a remote computer using the "Remote
Desktop" application, the Ultr@VNC program (or a similar tool)

e To connect external network devices (e.g. printers)
e To transfer data from a remote computer and back, e.g. using network folders

This section describes how to configure the LAN interface. It includes the following topics:

e chapter 2.6.1, "Connecting the Instrument to the Network", on page 39
e chapter 2.6.2, "Assigning the IP Address", on page 40

N\ Accessing Operating System

/ The operating system cannot be accessed.
All necessary system settings can be made in the "Setup" dialog.

2.6.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

e A non-dedicated network (Ethernet) connection from the instrument to an existing
network made with an ordinary RJ-45 network cable. The instrument is assigned an
IP address and can coexist with a computer and with other hosts on the same net-
work.

e A dedicated network connection (Point-to-point connection) between the instrument
and a single computer made with a (crossover) RJ-45 network cable. The computer
must be equipped with a network adapter and is directly connected to the instrument.
The use of hubs, switches, or gateways is not required, however, data transfer is still
performed using the TCP/IP protocol.

In both cases, an IP address has to be assigned to the instrument and the computer, see
chapter 2.6.2, "Assigning the IP Address", on page 40.

The R&S SMBV uses the IP addresses 192.168.xxx.yyy for this purposes, where xxx and
yyy may take values between 1...254; the subnet mask is always 255.255.255.0.

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult your
network administrator. Errors may affect the entire network.

» To establish a non-dedicated network connection, connect a commercial RJ-45 cable
to one of the LAN ports.

Operating Manual 1407.6062.32 — 08 39



R&S®SMBV100A

Preparing for Use

2.6.2

Setting Up a Network (LAN) Connection

To establish a dedicated connection, connect a (crossover) RJ-45 cable between the
instrument and a single PC.

If the instrument is connected to the LAN, the operating system automatically detects the
network connection and activates the required drivers.

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps
Ethernet IEEE 802.3u interface.

Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instrument
can be obtained in different ways.

e If the network supports dynamic TCP/IP configuration using the Dynamic Host Con-
figuration Protocol (DHCP), all address information can be assigned automatically.

e |f the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIA) protocol. If this attempt does not succeed or if the instrument is
set to use alternate TCP/IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support DHCP,
or if you choose to disable dynamic TCP/IP configuration, you must assign valid address
information before connecting the instrument to the LAN. Contact your network admin-
istrator to obtain a valid IP address.

Assigning the IP address on the instrument
1. Press the SETUP key and select the "Network Settings" dialog.
2. Set the "Address Mode" to Static.

3. Select the "IP Address" and enter the IP address, for example 192.168.0.1.. The IP
address consists of four number blocks separated by dots. Every block contains 3
numbers in maximum.

4. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.
The subnet mask consists of four number blocks separated by dots. Every block
contains 3 numbers in maximum.

Assigning the IP address manually on a PC

1. Obtain the IP address and subnet mask for the R&S SMBYV and the IP address for
the local default gateway from your network administrator. If necessary, also obtain
the name of your DNS domain and the IP addresses of the DNS and WINS servers

|
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2.7

Remote Access via an External Controller

on your network. If you use more than one LAN connector, you need separate
address information for each connector.

Press the "Windows" key to access the operating system.
Open the "Control Panel" by selecting "Start > Settings > Control Panel".

Select "Network Connections".

o & 0D

Right-click "Local Area Connection" and select "Properties" from the context-sensi-
tive menu, or
click "Local Area Connection" and then "File > Properties".

6. On the "General" tab, click "Internet Protocol (TCP/IP)" and then select "Properties".

7. Select "Use the following IP address" and enter the address information as obtained
from the network administrator.

8. Ifnecessary, you can also select "Use the following DNS server addresses" and enter
your own DNS addresses.

For more information refer to the Windows XP Help.

Using Computer Names

Alternatively to the IP address, each PC or instrument connected in a LAN can be
accessed via an unambiguous computer name. Each instrument is delivered with an
assigned computer name, but this name can be changed.
Querying and changing a computer name
1. Press the "Setup" key and select "Network Settings".

The computer name is displayed under "Hostname".
2. Press the "Setup" key, select "Protection" and enable the "Protection Level 1".

The parameter "Hostname" in the "Network Settings" dialog is now enabled for con-
figuration.

3. Change the "Hostname".

Remote Access via an External Controller

The R&S SMBYV can be remote accessed from a remote computer (external controller)
via a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.

@

For an overview of the instrument's operating concept and the different ways to control
and operate the instrument, see chapter 3.1, "Brief Introduction to the Instrument's Con-
cept”, on page 50.
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There are different ways to establish a remote access connection to the signal generator
but all of them require an established LAN connection between the instrument and the
remote computer. The simplest way to remote access the instrument is to use a Web
browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alternatively
a remote access via a special application can be used.

The free-of-charge program Ultr@VNC for PCs with Linux/Unix or Windows operating
system is available for setting up the remote access connection. Using this application
requires additional installation.

See the following table for an overview of the different ways to establish a remote access
connection to the signal generator.

Table 2-1: Remote access via an external computer

Remote access via Installation of the additional appli-
LAN cation
connec-
tion on the instru- on the remote
ment computer
Web Browser required no no

e.g. Windows Internet Explorer or Mozilla Firefox

see chapter 2.7.1, "Using a Web Browser for Remote
Access", on page 43

Ultr@VNC required required VNC Viewer
for PCs with Linux/Unix or Windows operating system required

see chapter 2.7.2, "Remote Access via
Ultr@VNC", on page 44

When the connection is set up with Ultr@VNC, direct control on the instrument is possible
while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cutting
the connection, it is still enabled and can be established again any time. The connection
is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access, how
to install the applications for remote access and how to establish the connection between
the instrument and an external computer with Windows operating system. Remote
access via an external computer with Linux/Unix operating system is performed accord-
ingly.

Default password
Remote-access and file access require the user "instrument" with default password
"instrument".
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Changing the default user and security passwords

It is highly recommended to change the default user and security passwords in the menu
"Setup > Security" before connecting the instrument to the network (see section chap-
ter 5.2.3.16, "Security", on page 128).

2.7.1 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any Web browser, like Windows Internet
Explorer or Mozilla Firefox for instance.

To remote access the instrument via \Web browser:

1. Connect the instrument and the remote computer to a LAN, see chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 39.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your PC,
e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

{= TightVMNC applet - Windows Internet Explorer
C e T ] hpf10.11111 v
File Edit Wiew Favortes Toolk Help

U0 4R | @ TightyNC applet

oot | ciseess |  coreen

VNC Authentication

Password: 0K

4. Enter the password and select "OK".
The default password is "instrument”.

After the connection is established, the current signal generator screen with the block
diagram is displayed and the instrument can be remote-accessed from the remote
computer.
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(5 TightVNC applet - Windows Internet Explorer

\\J,C_; |l mppoatssyy - v

o e |@T¢ﬂucapplet | |

Disconnect | options | Clipoard | Sand cir-at-Del | Refesn |

Frequency PEP Level

| 3.124 500 000 00 |6tz | 16.29 &n [ 500 [ém |

REMOTE|| ALC-Auto info_|
oy

AWGN/IMP

config... l[
[T On

IMP

Graphics
config. .
I Cn

2.7.2 Remote Access via Ultr@VNC

Ultr@VNC is an application which can be used to access and control the instrument from
a remote computer through a LAN connection. The program is included in operating sys-
tem Linux/Unix. It is available as a free-of-charge download on the internet for operating
system Window XP (http://www.uvnc.com/download/index.html) and on the instrument's
CD-ROM.

Risk of Unauthorized Access

If the VNC application is enabled on the instrument, any user in the network who knows
the computer name and login data can access it. To prevent this, make sure that the VNC
server service on the instrument is disabled.

Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 39.

2. Install the Ultr@VNC application and enable it on the instrument.
3. Inthe ICF firewall, enable communication on the network via Ultr@VNC program.

4. Install the VNC Viewer on the remote computer with Windows operating system, see
"Installing the VNC Viewer on a Windows PC" on page 47.

|
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Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the VNC
connection on the Linux/Unix remote computer" on page 47;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 48.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1.

Download the program from the internet and copy it to a directory that can be
accessed.

On the instrument, shut down firmware using the ALT+F4 key combination.

Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.

a) Select installation of all components.

ﬁ'ﬁ]SetupUItr@\mC T TY T ——————— e
Select Components H
‘which components should be installed? £,
=

Select the components you wank to nstal: clear the components you do not want to
inztall. Click Mest when vou are ready o continue.

| Full inztallation [q
UltraWfMC Server 1.8MB
ILI ltratMC Wieer 1.0MB
[ liiraE Hiepaater ]

Current selection requires at least 2.7 MB of disk space.

I < Back ” Next > ][ Cancel

|
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b) In the "Additional Task Panel", enable all entries.

Select Additional Tasks
Which additional tasks should be perfomed?

Releasze 1.0.0 RC 18, then click Mext.

Server configuration:

Fiegister UIr@yNC Server a5 a system service
Start or restart UItr@VNC service

Additional icons:

Create a Uln@&WNC Wiewer desktop icon
Create & UIt@VNC Server desktop icon
Create a UIENC Repeater deskiop icon
File Associations:

[v] Azznciate  vne files with LINEWNE Yiewer

Select the additional tasks you would ke Setup to perform while installing LUrEHC

[ <Back ]|

||

Nest > Cancel

A successful installation is indicated by a message.

WInVHC x|
= The Win¥MNC service was successfully rege
\!-I) The service may be started from the Control Panel, and will

automatically be run the next time this machine is reset

At the same time a warning is displayed stating that a password must be set.

WINVHC Error

. Properties dialog now to allow one bo be entered.

WARNING : This machine has no default password set. WinyHC will present the Default

Select "OK".

The "Default Local System Properties" panel opens.
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WinWHC: Default Local System Properties

Incoming Connections Connection Settings
I Force Yiew Only [disable Yiewers Inputs)
I Disable Local Inputs (Keyboard & Mouse]

¥ Remove Desktop Wallpaper

¥ Accept Socket Connections

_—
P. d: [

Display Mumber or Ports to use < Auto
" Display N°
¢ Ports Main: |5900

Update Handling
¥ Poll Full Screen [ Fast)
¥ Poll Foreground Window—]|
[ Poll Window Under Cursor
¥ System HookDII
¥ ¥ideo Hook Driver
I Low Accuracy [ Turbo Speed)

Hittp: | r Poll Console
Windows Only
Poll On Event

Received Only

MS Logon |

¥ Enable Java Viewer (Http Connection)
¥ Enable Xdmcp [X11 Connection)

~¥hen Last Client Di
& Do Nothing

DSM Plugin

¢ Lock Workstation [W2K] I~ Use ]No Plugin detected... j Config I
" Logoff Workstation
Misc. -Share only the Window Named :
v Enable Blank Monitor on Yiewer Request I Share ‘
¥ Enable File Transfer ~Query on i :
I Log debug infos to the Win¥NC.log file [~ Display Query Window Timeout:|10 5
I Allow Loopback Connections
Default Server Screen 14 F 0K Apply | Cancel |

Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other set-
tings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with the
operating system. On mouse over, the IP address of the instrument is indicated.
This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Installing the VNC Viewer on a Windows PC

1.

2.

Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.

Note: The VNC Viewer program is included in the download for the installation of the
Ultr@VNC program on the signal generator if "Full installation" was selected in the
"Select Component" panel. In this case, the program ultr@vncviewer.exe can
be copied to the Windows PC.

Install VNC Viewer program component on the remote computer.

Setting up the VNC connection on the Linux/Unix remote computer

The VNC program is available per default for Linux/Unix operating systems.

1.

Start a Web browser on the remote computer and enter the IP address of the instru-
ment.

Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc://192.168.1.1.

A dialog is opened and the password for the remote VNC connection is requested.
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3. Enter the password as defined in the "Default Local System Properties" panel of the

Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instrument
is not disabled and the instrument can be controlled from the front panel and via the
remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1.

Start VNC Viewer program component on the PC, select "VNC Server" and enter IP
address of the instrument.

bx

Connection

M NCServer [132768.10
r

[ host:display ar host:part )

0 ULTRA [>24bit/z] - Experimental

' LAN (> TMbit/s] - Max Colars
 MEDIUM  [> 128Khit/s] - Max Colors

" MODEM  [19-128Khit/s] - 255 Colars

1 SLOW [« 153kKhbit/z] - 286 Colors, Fuzzy

Cancel

r Buick Options:
& AUTO [Auto select best zattings) | Connect |

™ Wiew Only [~ Auto Sealing DOptions. .. |
I~ Use DSMPhugn INo Plugin detected... x| _ Config |
I Prosy/Repeater |

2. To initialize the connection, select "Connect".

A message requesting the password appears.

¥NC Authentication
),
‘?'
[ Loson | cenes |

Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.
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Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMBYV or
on the external PC. Terminating the connection does not disable it. It can be established
again any time. See the notice above concerning unauthorized access due to VNC con-
nection!

1. Terminate the connection on the R&S SMBV

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. Toterminate the connection on the external Linux/Unix PC, close the internet browser
or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the instru-
ment.
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3 Getting Started

This section helps you to get familiar with the R&S SMBV and provides an introduction
to the general concept of the instrument with a sample of the possible application fields
as well as a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

3.1 Brief Introduction to the Instrument's Concept

The R&S SMBYV provides an entirely digital baseband section for generating 1/Q signals
and an RF section with 1/Q modulator. The instrument uses I/Q (vector) modulation. Dig-
ital data streams are converted to an I/Q baseband signal. The baseband signal is then
D/A-converted and modulated onto the target RF carrier frequency with the aid of an 1/Q
modulator.

For a detailed description of the blocks in the baseband and RF sections, refer to chap-
ter 3.2, "Baseband Section", on page 52 and chapter 3.3, "RF Section", on page 54
respectively.

The operating concept of the R&S SMBV employs the following three ways of instru-
ment control:

e Manual operation
e Remote control
e Remote access

Manual Operation

The R&S SMBYV can be entirely operated from the front panel. Peripherals such as mouse
or keyboard can be connected but are not essential.

The R&S SMBYV is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.

Each block represents a functional unit of the instrument. Thus the user always knows
the position at which a parameter has an effect in the signal flow. The main settings of a
block are indicated in the block. The interconnection of employed inputs and outputs is
also shown. The user is thus always informed about the connection of inputs and outputs
in the signal flow and where they can be configured. A window is opened for each menu
where parameters can be set. When the window is opened, an entry is made in the
"Winbar" below the display. All open menus are of equal priority (not modal) and can be
accessed any time.

The block diagram in the figure below shows a fully equipped instrument.

|
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Frequency mF |lmoo PEP Level
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config... config.... config... config... RF
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config config
[~ On [~ On
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Fig. 3-1: Block diagram of a fully equipped R&S Signal Generator

With the aid of the rotary knob, the user can navigate in the block diagram and the dialogs,
and can operate the instrument with one hand. The cursor is moved line by line through
the block diagram or dialog. Turning the button clockwise advances the cursor. The
selected block can be activated or deactivated with the TOGGLE key. Active blocks are
highlighted by a colored background.

The instrument comprises a comprehensive info and help system. Context-sensitive help
can be called any time with the HELP (F1) key. The help system indicates the currently
selected parameter and offers additional services such as cross references, index and
contents. The content of the help system corresponds to the operating manual of the
instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be reques-
ted from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table is
modified only after the "Accept" button has been pressed. Pressing the "Accept" button
also stores the assistant data.

For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to chapter 4, "Manual Opera-
tion", on page 63.

For an indepth description of the dialog boxes and the instrument functions refer to sec-
tion chapter 5.1, "Overview of Instrument Functions", on page 101.

Remote Control

Remote control is an operation of the instrument by means of remote control commands
or programs that automatize repeating settings. The instrument is connected to a com-
puter running the program.

This way of operation and the instructions how to set up a connection for remote control
are described in the chapter 6, "Remote Control Basics", on page 392. The description
of the remote control commands is provided in chapter 7, "Remote Control Com-
mands", on page 433.

|
Operating Manual 1407.6062.32 — 08 51



R&S®SMBV100A

Getting Started

3.2

Baseband Section

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the R&S
SMBYV and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be oper-
ated from the remote computer as on the unit itself. The individual functions are operated
using the mouse and keyboard. Specific instrument functions can be executed using
specific key combinations on the keyboard or a front panel key emulation that can be
operated with the mouse.

This way of operation and the instructions how to set up a connection for remote access
are described in chapter 2.7, "Remote Access via an External Controller", on page 41.

Baseband Section

The baseband section of the R&S Signal Generator is fully digital and contains the hard-
ware for generating and processing I/Q signals.

For detailed information on available options, refer to the R&S SMBV data sheet and the
R&S SMBYV configuration guide.

Up-to-date information is available at R&S SMBV homepage on the internet http://
www2.rohde-schwarz.com/product/smbv100a.html.

Baseband generator (option R&S SMBV-B10)

The generator produces baseband signals. It contains modules for real time signal gen-
eration and an arbitrary waveform generator (ARB).

The option Baseband Generator contains real time Custom Digital Modulation and ARB.
Software options providing various digital standards are offered in addition. Option R&S
SMBV-K40, for instance, generates signals to GSM/EDGE standard, option R&S SMBV-
K42 signals to 3GPP FDD standard.

This module also offers digital I/Q impairment functions. The I/Q signal can be deliberately
corrupted, e.g. for testing the receiver quality.

Digital Baseband Connectivity (option R&S SMBV-K18)

This option activates the DIGITAL IQ IN/OUT interface in order to apply an external signal
to the baseband path, or to provide the internally generated baseband signal. Equipped
with this option, the instrument indicates the "BB IN/Out" in the blockdiagram.

The interface enables you to directly transmit digital 1/Q signals between R&S instru-
ments. In addition, if you use the digital signal interface module (R&S EX-1Q-BOX), you
get a versatile digital baseband interface for a variety of formats.

|
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€O\ Special features...

/e Option R&S SMBV-K18 is a combined interface, i.e. it operates one direction at a
time.

e The R&S SMBYV processes either the internally generated baseband signal, or the
signal supplied externally. Therefore, the baseband signal generator is turned off with
"BB In", and vice versa.

e If the baseband section and the RF section are decoupled, e.g. with output of the
digital I/Q signal, or if an external anaolg signal is fed to the 1/Q modulator, both
sections can be processed independently.

Further processing of the 1/Q signal

The R&S SMBYV allows further processing of the 1/Q signal, as summarized below:

e Inthe "AWGN/IMP" block, the R&S SMBYV allows the digital I/Q signal to be impaired
or added with noise before it is passed on.
Additionally, a pure noise signal can be used and forwarded. In this case, the 1/Q
baseband signal is disabled, indicated by the interrupted signal flow in the diagram.

o Ifdigital I/Q output is on, the R&S SMBYV routes the signal, or the pure noise, directly
to the digital interface.

o [f digital I/Q output is off, the instrument converts the signal to an analog I/Q signal
and routes it to the analog I/Q output and to the I/Q modulator of the RF path. Pure
noise is also provided at the analog outputs or can be forwarded to the 1/Q modulator.

Additional White Gaussian Noise (option R&S SMBV-K62)

Additive white noise, which may be required for instance for measurements on mobile
radio base stations, can be produced with the AWGN software option (R&S SMBV-K62).

3.2.1 Description of Individual Diagram Blocks of the Baseband Section

\ Each function block can be activated or deactivated with the "ON" check box (on/off tog-
/) gling).

The ON/OFF TOGGLE key at the front panel (see "TOGGLE" on page 22) switches the

currently selected block on or off.

A detailed description of the blocks is provided below.

Baseband A Baseband A block

config... In this block, the (first) baseband source is configured and activated. The block is dis-
- on played only if a baseband generator is available in the instrument.

IO Depending on the installed software options, various digital standards, user-configured

digital real time modulation or the built-in waveform generator (ARB) can be selected.
The selected modulation is displayed in the block.
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BB In/Out
config...
[ On

Qutput

AWGNI/IMP A

config...
[~ On

Graphics

config...
[~ On

3.3

RF Section

The TOGGLE ON/OFF key switches the selected modulation (digital standard, digital
modulation or ARB) on or off.

BB In/Out block
The block is displayed only if the Digital Baseband Connectivity (option R&S SMBV-K18)
is installed.

As input, the "BB In/Out" block controls the baseband input module for external 1/Q sig-
nals. Externally generated realtime baseband signals are fed into the digital signal path
via the digital interface. The signal is transferred directly to the I/Q modulator (I/Q Mod
function block).

Conversely, as output, the block is used to configure the digital I/Q output. The internally
generated baseband signal is configured in the Baseband function block.

The digital settings are performed in the corresponding menus. | and Q components can
also be swapped (I/Q Swap). The status line in a block displays the currently active con-
trol, e.g. "Output" denotes that the 1/Q baseband signal is provided by the digital output.

The ON/OFF TOGGLE key switches the active function(s) of the block on or off.

AWGN/IMP A block
This block is displayed only if a baseband generator (R&S SMBV-B10/B50/B51) is instal-
led.

In this block (digital) I/Q impairments for the baseband path can be set. With the aid of
the software for AWGN generation (option R&S SMBV-K62), an (additive) noise signal
can be produced.

AWGN and impairments can be activated independently of each other in the appropriate
menus. The settings are displayed in the block. The entire block can be activated or
deactivated. If the block is deactivated, the signal passes through the block unchanged.
In addition, the differential 1/Q output is configured in this block.

The TOGGLE ON/OFF key switches the active functions of the block on or off. The func-
tions (AWGN, impairments or both) are activated in the respective menus.

Graphics block
With this block, the baseband signal can be graphically displayed in real time. The block
is displayed only if a baseband generator is installed.

The TOGGLE ON/OFF key opens or closes the graphics window.

RF Section

An RF path is configured by installing a frequency option that comprises all required
modules.

One of the following options must be installed.

e R&S SMBV-B103 (up to 3 GHz)
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e R&S SMBV-B106 (up to 6 GHz)

For detailed information on available options, refer to the R&S SMBV data sheet and the
R&S SMBV Configuration guide.

Up-to-date information is available at R&S SMBV homepage on the internet http://
www?2.rohde-schwarz.com/product/smbv100a.html).

3.3.1 Description of Individual Diagram Blocks of the RF Section

This section gives an overview of the available blocks and a detailed descritption of their

functions.
IfQ Mod A 1/Q Mod A block
EE0TL. The (first) I/Q modulator is configured in this block. Also the Analog Wideband 1/Q mode
 on can be selected here, which allows external I/Q signals to be directly applied to the I/Q
Imp Swap modulator, i.e. not via the baseband section. If no baseband modules are installed, 1/Q

modulation is possible only in the Analog Wideband I/Q mode.

I and Q components can also be swapped (I/Q Swap). (Analog) I/Q impairments can be
set in addition. Unlike the impairments in the "AWGN/IMP" block, impairments in the "I/
Q Mod" block also affect the externally applied signals in the Analog Wideband 1/Q mode.

The status display in the block shows whether I/Q impairments and/or I/Q swap is active.
I/Q modulation is switched on or off with the TOGGLE ON/OFF key.

Note: An I/Q modulator provided in the R&S SMBV is automatically activated when a
connected baseband source is switched on. The I/Q modulator can also be separately
switched on and off (select the "I/Q Mod" block and press the TOGGLE ON/OFF key).
This permits the following configuration to be obtained with a single-path R&S SMBYV.
The baseband source generates an I/Q signal that is output via the analog I/Q output. At
the same time, the RF section generates an unmodulated carrier.

RF/A Mod A RF/A Mod A block
config... | | f2&  In this block, the RF parameters and the analog modulation modes are set.
I~ on The active analog modulation modes are displayed in the block. The TOGGLE ON/
- OFF key switches the RF signal on and off. When the RF signal is switched off, the switch

before the RF output symbol is open.

RF settings include:

e Frequency and reference frequency

e Attenuator settings.

e Frequency and level sweep

e List Mode settings. In this mode, extremely fast frequency and level settings can be
made.

Note: Numeric values for frequency and level are entered best and quickest with the aid
of the FREQ and LEVEL keys.

Available analog modulation modes:
e Amplitude modulation
e Pulse modulation (option R&S SMBV-K22).

Note: For modulation modes that can be simultaneously used, refer to the R&S SMBV
data sheet.

|
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3.4 Example of Setup

This section provides an example on how to configure the instrument to generate and
display a simple QPSK-modulated signal.

Configuring and displaying a QPSK-modulated signal

To generate and display a QPSK-modulated signal, proceed as follow:

1. Activate default (preset) state.
Press the PRESET key to set a defined instrument state.

Frequency rF Il MoD PEP Level
| 1.000 000 000 00 |cHz -|| oFF | oFF 1-30.00 d&m |-30.00 |dBm -
| ALC-Auto Info
1]
out
—
-
Baseband — UQ Mod | /A Mod
config... *| config... config... | R
[T On I~ On [T On €
MSK
Graphics
config... |
I~ On
Graph A

| | | | | |

2. Select and activate digital modulation

a) Turn the rotary knob and select the "Baseband A" block.

Frequency re || Mop PEP Level
BUSY
| 1.000 000 000 00 [st= -|| o | oFF 1-30.00 ¢8m [-30.00 [dBm -]
| ALC-Auto Info |
1
outT
&
Baseband VP [ VQ Mod | RF/A Mod
config... | config... | - *| config... | config... | iy
C On — T On 4 [I0on ] [~ On = E
MSK
Graphics
config...
" On
Graph A

Operating Manual 1407.6062.32 — 08 56



R&S®SMBV100A Getting Started
Example of Setup

b) Press the rotary knob to open the menu where the digital modulation can be
selected (different modulation modes are available depending on the options
installed).

Frequency rF Il MoD = PEP Level

| 1.000 000 000 00 |ctz -]| oFF | o 1-30.00 dém [-30.00 [dbm -]
| ALC-Auto M

[l*]
&

—— TDMA Standards IMP 1/Q Mod RF/A Mod

GSM/EDGE... ’ RF
—— CDMA Standards —— gaa EOMEE N QI | ._/._99

3GPP FDD.. I On A L106n [~ On

WLAN Standards —
IEEE 802.11 WLAN..
IEEE 802.11 n...
Misc

Custom Digital Mad... Graphics

ARB...

Multicarrier CW... M
—— Frequency Offset I” On

0.000 000 000 GHz Graph A

Fhase Offset
0.00 deg

| | | |

c) Turn the rotary knob and highlight "Custom Digital Mod...".

- TDMA Standards -
GSM/EDGE...
—— CDMA Standards —

3GPP FDD...

— WLAN Standards

IEEE 802.11 WLAN. ..

Multicarrier CW.__.

Press the rotary knob to open the "Custom Dig. Mod." dialog.

Frequency rF Il MoD PEP Level

71,000 000 000 00 [6% =], = | o | 30,00 dbm [-30,00 [dem ]

fodul aticn
State Off —

Set to Default | Save/Recall... |
Data Source
Data Source [PRBS =]
PRBS Type | PRBS 9 | RF/A Mod
Select Control List... | None | config... | _/__<R§_}
: 4 DOon
List Management... | |
Set acc to standard | GSM 4|
Save/Recall User... |
Symhbol Rate | 270833 333 | ksym/s x|
Coding | GSM |
‘ Modulation Type | MSK | =
ooues | | |

|
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d) Turn the rotary knob to select parameter "Symbol Rate", press the rotary knob to
allow editing and enter the preffered symbol rate with the aid of the numeric key-
pad and the unit keys.

Digital Hodulatiomn
State off [=
Set to Default | Save/Recall... |
Data Source
Data Source | PRBS =l
PRBS Type | PRBS 9 =|
Select Control List... | None
List Management... I |
Set acc to standard ] User

Save/Recall User...

|S3rmbo| Rate

1.000 000 000 | Msym/s J

Coding

GSM |

‘ Modulation Type

Modulation

| MSK =l

=i

e) Turn the rotary knob to select parameter "Coding".
Press the button to open the selection list.
Turn the rotary knob to select "Off" and press the knob to activate the selected

item.
Digital Modulation
State off =
Set to Default | Save/Recall... |
Data Source
Data Source | PRBS =l
PRBS Type | PRBS 9 =l
Select Control List... | Naone
List Management... I ||
Set acc to standard Jus=
Save/Recall User... |
Symbol Rate | 1.000 000 000 | Msym/s j
|Coding S

‘ Maodulation Type

Modulation

IDER ==
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f) Use the rotary knob in the same way to set "Modulation Type" QPSK and "Fil-
ter" Root Cosine with "Roll Off Factor" 0.3.

on Digital Modulation

Select Control List... | None
List Management... |
Set acc to standard JUser =]

Save/Recall User...

Symbol Rate | 1.000 000 000 [Msym/s =]
Coding | Differential |
Maodulation
Maodulation Type | aPsk =|

| More. ..

Filter

=Ty
T ler

| Root Cosine

Roll Off Factor

Oversampling M Auto

I 2=

g) Finally, select "State" and press the rotary knob to switch on the digital modula-

tion.

on- Digital Hodulation K
State =

Set to Default I Save/Recall... |

Data Source

Data Source ]PRBS d|

PRBS Type | PRBS 9 =l

Select Control List... | MNaone

List Management... I
Set acc to standard I se LI

Save/Recall User. ..

Symbol Rate I 1.000 000 000 | Msym/s j
Cading | Differential
Modulation
Modulation Type | apsK
More... |

Filter
Filter ]Root Cosine
Roll Off Factor |

1 —
59
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h) Press the DIAGRAM key to display the complete block diagram.

Frequency RF PEP Level

["1.000 000 000 00 [6#= o = [-27.24 @n [-30.00 [ ]
| ALC-Auto M

Marker 1: On/Off Ratio
= 2 OniOff Ratio

]
outT
o
et
/A Mod

config... |

[~ On

Graphics

config... |

I” On
Graph A

| | |

To indicate the active state, the "Baseband" block is displayed in blue.

i) The entry in the Winbar indicates that the "Custom Dig. Mod." menu is still open
in the background.
To display the menu in the foreground, press the softkey below the button in the
"Windbar".

Frequency rF [l Mop PEP Level

| 1.000 000 000 00 |6tz =|| o | o 1-30.00 dm {-30.00 |dbm -]

8GR e o o O s Info
Set to Default | Save/Recall... I
Data Source
Data Source | PRBS |
PRBS Type | PRBS 9 4| RF/A Mod
Select Control List... | None 1 config... g GRF
. I~ On
List Management... | L

Set acc to standard | GSM |
Save/Recall User... |
Symbol Rate | 270833 333 [ ksym/s  ¥|
Coding | GSM |
Madulation Type I MSK ;I ILI
| | | | | |

Press the HIDE key to minimize the menu again.

The "I/Q Mod" block is automatically activated.
The "RF/A Mod" is not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

|
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a) Press the FREQ key to activate the editing mode for frequency entry. The "Fre-
quency" entry field in the header section of the display is highlighted.

el 2,000 000 000 00 o= J]

Enter the frequency using the numeric keypad and terminate the entry by press-
ing a unit key.
b) Press the LEVEL key and enter the level settings in the same way.

o] -5.00 [om

c) Press the DIAGRAM key to display the complete block diagram.
d) Turn the rotary knob to select the "RF/A Mod" block.
Press the TOGGLE ON/OFF key to activate the "RF/A Mod" block.

The QPSK modulation signal is now present at the RF output.

| 1.000 000 000 00 |Gt ~| {-27.24 d@m |-30.00 |dm -
| ALC-Auto Info |

Marker 1. OniOff Ratio
2: OniOfT Ratio

e
e
-

Graphics

config... I

I” On
Graph A

| | | | | |

4. Select graphics display of 1/Q signal

a) Turn the rotary knob to select the "Graphics" block and open the respective menu.

Graphics Sattings

Path A
State Off
Smart Graphics [~ On
Made | =l
Trigger Source | Software =l
Sample Rate Mode | Auto =l
Sample rate | 1alise =
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b) Select "State On" with the rotary knob to activate display of the 1/Q diagram.

Constellation Diagram

quadrature q(t)

-0.8-06-0402 0 02040608
inphase i(t)

Zoom Shuw| Copy I
Run out ref to ref

Operating Manual 1407.6062.32 — 08 62



R&S®SMBV100A Manual Operation

Key Features

4 Manual Operation

The R&S SMBYV can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same way.
Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and therefore con-
venient access to entries and settings.

The clear-cut display shows the current signal generator state. Graphs, spectra, vector
diagrams, etc. can be called for a visual check of the output signal. Numerous help func-
tions support the user in signal configuration.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog boxes
and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to sec-
tion "Instrument Functions".

4.1 Key Features

The manual operating concept of the R&S SMBV enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteristics
of the generated signal and of the current instrument state. Numerous online help func-
tions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is pressed.

Permanent frequency and level display

The main characteristics of the RF signal, frequency and level, are permanently displayed
in the header section of the screen and can be directly set in the display fields after the
FREQ (CTRL+F) or LEVEL (CTRL+L) key is pressed. Status messages for the output
signal are displayed in addition to frequency and level.

Frequency MOD PEP Level

11.000 000 000 000tz | [Fonf o | {-30.00 é&m | -30.00 éem ~|

Operation via Graphical User Interface

e Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The function
blocks represent elements of signal generation. Function blocks displayed with a blue
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frame can be directly switched on and off by means of the TOGGLE ON/OFF (CTRL
+T) key. The menus of the highlighted function blocks can be called by pressing the
ENTER key.
— Example:
The "Baseband" block contains all menus required for baseband signal configu-
ration.
Baseband A

config...

[~ On
DigMod

In this block all digital standards and the digital modulation can be selected.

- TDMA Standards -
GSM/EDGE...

—— COMA Standards
3GPP FDD...

WLAN Standards

IEEE 802.11 WLAMN..,
Misc
Custom Digital Mod. ..

ARB...
Multicarrier CW._.

Signal flow
The signal flow between the function blocks and the employed inputs and outputs are
also shown.

hilarker

__

1: slot timing
2 =lot timing

Menu tree

The menu tree can be opened and closed with the MENU (CTRL+M) key. The menu
tree is organized in the same way as the directories under Windows. The function
blocks correspond to the first directory level, the menus to subdirectories.

=+ Baseband
TDMA St
| |~ GSM/EDGE..

andards —

- CDMA Standards —

| |~ 3GPPFDD..

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Windows
user interfaces. All menus and tables are made up of known elements, such as selection
lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element, entries
can be made.

Rotary knob

|
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Wy . Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

e Turning the rotary knob shifts the entry focus to the target element.

e Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

e If avalue is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be operated
independently of each other, i.e. none of the dialogs requires that settings in other dialogs
be completed before it can be closed. This ensures flexible operation at all times.

Frequency RF PEP Level
| 1.000 000 000 00 |6H: =] o 1-30.00 ém [-30.00 [&m -]
| 1/0 Impairments (Digital Baseband)
& Baseban?l A On 1/Q Impairments
Stat
L Save/Recall... I £
36;2';[) 1 Offsat | 0.00 [ % |
e WLAN - = Q Offset | 0.00 | % =l
d (Singl
- IEEE 802 i) Gain Imbalance [ om0 ]
Misc =
. Custlém E—I Quadrature Offset | 0.00 | deg |
. ARB S_I Cosine [/
. Multicarri._l ¥ Optimize Internal /Q Impairments For RF Output
- Freau; Optimization Mode | Fast =]
| |«
Winbar

The Winbar gives an overview of menus and simplifies their access.

The menus are displayed on top of the block diagram but they can be "hidden" with the
aid of the HIDE (CTRL+H) key, i.e. displayed in the form of a button in the "Winbar" at
the lower end of the screen.

They can be displayed again in full size by a keystroke (REARR (CTRL+A) key). This
makes room on the screen for other displays that may be required but the setting menus
can be still accessed any time.

Menu | GSM/EDGE | 1/Q Settings

Keys with assigned simple functions
Most keys on the front panel of the R&S SMBYV directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the RF ON/OFF (CTRL
+R) key the RF output signal can be switched on or off.
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An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
menus for general instrument settings or the FILE (CTRL+S) key which opens the menu
for file management.

Help functions for user support

Numerous help functions support the user in signal configuration.

e Value ranges
The valid setting range is displayed for each numeric parameter. This requires a short
wait after activation of the entry field. The range is then displayed automatically after
a few seconds.

Roll Off Factor | @30

Min = 0.05
Max =099
replace mode

More.___

Fower Ramp Contr ICosine S 1.00 sym

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

e Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

Operating the R&S Vector Signal Generator = Instrument Function = Baseband Signal -

Baseband Block = Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
Interface > General Settings = State - Digital Modulation

State - Digital Modulation

Enables/disables digital modulation.
Switching on digital modulation turns off all the other digital standards.
In case of two-path instruments, this affects the same path.

The digital modulation is generated in realtime (no precalculated signal). and therefore all
parameter changes (in the ON state) directly affect the output signal.

SCPI command:

7

CURce<hw>]

t
i}
=]
Uy
H
=

=1

Top

e Comprehensive online help
Each help page is part of a comprehensive online help function which can be called
by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
HELP (F1) key.
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PEP Level

[-30.00 ¢ [-30.00 ¢ <]

11.000 000 000 000]s- -] .@

ALC-Auto

Graphical display of data structure

The structure of the baseband signal is graphically displayed in the respective menus;
the individual signal elements can be graphically selected for processing.

Frame: Select Slot to Configure

Graphics editor for definition of control signals

Control signals are also graphically configured.

t Harker GSH (Frame 1 3 Slot OJ

Configure Control Signals 5
{Markem ird

Marker 2 [ -
| L I | I 1 - 1 1 |
0 50 100 Position / Bit
Total List Length—
Length ]151"
Marker 1 Cursor Zoom Sale
Preset Type | All down vl Eosition I 9 - Zoom In | Save |
Praset | Edit Table... Position in Tail 5 Bits Visibla |150

Graphical display of output signal in a diagram

The output signal can be graphically displayed in a number of diagrams. This allows a
fast check of signal characteristics. Zoom functions and the insertion of a reference trace
permit in-depth evaluation without an external analyzer being required.

|
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Zoom
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Copy
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4.2 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

e The frequency and level display with info line indicates the main output signal param-
eters and reports the current state with status, error and warning messages.

e The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

e Winbar with labelled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

Frequency rF | moo PEP Level

1 1.000 000 000 000 stz ~|| o | o= [-30.00 ¢&m | -30.00]«n -|
UCorr, ALC-Auto ﬂl

ra
ouT

Baseband AWGN/IMP 1/Q Mod RF/A Mod

config... config... | : * config... | ] config... |_Eg_)
[ On [~ On s/ I On | T on
MSK IMP
[~ Graphics |
config...
[ On

Fig. 4-1: Block diagram of a fully equipped R&S Signal Generator
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Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see chapter 4.2.2, "Status Infor-

mation and Messages", on page 69) are displayed in the header field of the screen.

The display may vary depending on the instrument's operating mode:

e In the sweep mode, the current frequency or level of the output signal is displayed.
The status message "SweepMode" is displayed in the info line.

e In the list mode, neither the current frequency nor level is displayed, the indication is
dimmed.

e If user correction is active, the status message "UCorr" is displayed in the info line.

e In the case of digital modulation, "Freq" indicates the frequency, "PEP" the peak
envelope power and "Level" the average level.

\ The value displayed in the "Freq" and "Level" field does not consider any offset set or
/ multiplier factor.

For more information see chapter 5.4.2, "RF Frequency", on page 156 and chap-
ter 5.4.8.1, "Overview of RF Level", on page 173.

4.2.2

4221

4222

Status Information and Messages

The status information and messages are displayed in the header section of the screen.
The messages differ with respect to their importance (errors, warnings, info) and the time
of their appearance (brief and permanent messages). They require different treatment
by the user. Further information on all messages can be called in the info window (see
chapter 4.2.3, "Info Window", on page 70).

Refer to chapter 9, "Error Messages", on page 727 for an overview of all status infor-
mation and messages as well as instructions for error elimination.

Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
Frequency Pl Level

1.000 000 000 0= == 30,00 = | -30.00 an

| UCorr, ALC-Auto Info |

Messages

Messages indicate errors in the instrument. They are displayed in the info line in different
colors depending on their importance and display duration. Errors (e.g. no calibration
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data) are displayed in red, information (e.g. file not found) and warnings in black. Warn-
ings indicate less significant errors (e.g. the instrument operates outside specified data).

Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background. They
are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

These messages can be read from remote using SYST:ERR? or SYST:ERR:ALL?.

Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in the
info line. After error elimination, the message automatically disappears and is also recor-
ded in the history.

These messages can be read from remote using SYST:SERR?.

Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

[ A UCor, ALC-Auto | B: ALC-Auto [_Infa_1 |nfo line

*| Lev | SCPI | Teat =
Emr

List of current

= messages with
n

Err short message

* Info 0 SawRel Manager Info: operation complete -Racall completad text.

- No pending errors.

Detailed
description for
highlighted
message

Show
e | (oo | o se =

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

|
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The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev" column
(Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.

Del. volatile
Clears all volatile messages.

This button is available only if the history of the messages is displayed.

SCPI command:

SYSTem:ERRor:ALL on page 712

Eachtime a SYST:ERR:ALL? query is sent, the error queue is returned and at the same
time cleared.

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

SCPI command:

SYSTem:ERRor [ :NEXT] on page 714 or STATus : QUEue [ : NEXT] on page 705

Each time a SYST:ERR? or STAT : QUE ? query is sent, the oldest entry in the error queue
is returned and at the same time cleared in the list.

4.2.4 Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation can
be completely operated from the block diagram. The highlighted function block can be
directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the Enter
opens the associated setting menu.
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Marker 1: Trigger ra
2: Pattern

AWGN/IMP
config...
TRIGGER 1 I~ On
IMP

Graphics
config...

[~ On

Fig. 4-2: Block diagram of the R&S SMBV

4.2.41 Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activated/
deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block is dis-
played in blue. Status information is displayed below the check box. It is different for the
different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.

In all function blocks where the signal flow can be influenced, the top menu level for setting
signal routing parameters is offered.

Example: Baseband block

—— TDMA Standards

GSM/EDGE...
—— CDMA Standards —
[v! 3GPP FDD...
— WLAN Standards
IEEE 802.11 WLAN., .,
Misc
Custom Digital Mod. .
ARB...

Multicarrier CW._.

In this block, the digital modulation signal, the digital standards, arbitrary waveform gen-
eration and multicarrier CW are set. The status information of the "Baseband" block indi-
cates the selected modulation and associated additional information, e.g. the number of
channels.

|
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4.2.4.2 Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and outputs
of the signal generator. Unused inputs and outputs are not shown. The lines indicate the
signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example:

AR The symbols indicate the inputs for the analog | and Q signal.
12 I

If several markers are active, the marker characteristics are listed next to the marker
symbol of the active markers.

Symbols and lines are displayed in different colors depending on their function.

Marker 1: Trigger o
out

2: Pattern

AWGN/IMP
config...

[ On
IMP

e The baseband signal is indicated by a three line arrow, the I- and Q-components of
the signal by a single-line arrow.

e Connections are indicated by a "solder point".
e Black is used for the generated signal.
e Green is used for control signals.

The signal flow is configured in the individual menus. User interfaces are configured in:
e the "Setup > Global Trigger/Clock/External Inputs" dialog.

4.2.5 Winbar and Softkeys

The "Winbar" with eight buttons is displayed below the block diagram. Labelled buttons
represent open menus, the label indicates the menu. If several menus are open, the
button of the currently active menu is displayed in a lighter colour. The buttons also assign
functions to the softkeys of the next lower level for front-panel operation. Up to eight
menus may be open simultaneously. When the ninth menu is opened, the menu that was
opened first is automatically closed.
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Some menus, e.g. data and list editor menus, cover the "Winbar" and assign menu-spe-
cific functions to the front-panel softkeys by way of the menu buttons.

Menu | GSM/EDGE | 1/Q Settings

Any of the open menus can be activated either with the respective button in the "Win-
bar" or the front-panel softkey. In combination with the keys for menu operation
(CLOSE (ESC), HIDE (CTRL+H) and REARR (CRTL+A)), convenient menu operation
can be ensured.

Working with menus and dialog boxes is described in chapter 4.3, "Accessing Dia-
logs", on page 75.

Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function blocks
in the diagram or by means of the MENU (CTRL+M) key. The menus are displayed on
top of the block diagram.

If the menu buttons assign menu-specific functions to the softkeys, the "Winbar" is hidden.

Working with menus and dialog boxes is described in chapter 4.3, "Accessing Dia-
logs", on page 75; the setting of parameters in chapter 4.4, "Setting Parame-
ters", on page 76.

The menus are in Windows format. The menus differ in details depending on their function
but they consist of the same main elements. Each menu consists of a menu header and
one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and closing
the menu. To operate the buttons, use the mouse or the front keys HIDE (CTRL+H) and
CLOSE (ESC).

Several fields of associated but separately set parameters are organized in menu areas.
A menu area is framed and labelled with the function common to all parameters.

Example: Impairments

Impairments
State N
I Leakage | 000 % |
Q Leakage | 000 % |
Imbalance | 000 % =]
Quadrature Offset | 0.00 |dEg j

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

|
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4.2.7 Graphical Display of Output Signal Characteristics

The graphical display of the output signal enables the user to rapidly check signal char-
acteristics without connecting an analyzer. Zoom functions and the display of a reference
trace allow in-depth evaluation. The diagram is displayed on top of the block diagram. It
can be minimized and called in the same way as a menu.

Example: Constellation Diagram

H: Constellation Diagram

quadrature q(t)
(=]

inphase i(t)

Show

Zoom
Run ref

out

Copy
to ref

To access the "Graphics Settings" dialog for selecting the graphics display of the output
signal, select the "Graphics" function block in the diagram or press the MENU (CTRL+M)
key.

Operation of the graphics windows is analogous to menu operation.

The menu and the individual graphical displays are described in chapter 5.3, "Graphical
Display - Graphics", on page 144.

4.3 Accessing Dialogs

The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the Winbar buttons or front-panel softkeys
or to use the HIDE (CTRI+H), CLOSE (ESC), DIAGRAM (CTRL+D) and REARR (CTRL
+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground
1. Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized and displayed in the form of Winbar buttons.

2. Press the associated softkey (CTRL+F1 .. F8) to display the dialog in the foreground
again.
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Accessing the menu tree

» Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File, Setup or Hardcopy dialogs

» Use the FILE (CTRL+S), SETUP (CTRL+E) or HCOPY (CTRL+Y) keys to open the
respective dialog.

Minimizing an active menu

» Use the HIDE (CTRL+H) key to minimize an active menu.

It is displayed in the form of a Winbar button.

Automatically arranging displayed menus

» Press the REARR (CTRL+A) key to rearrange all open menus so that they overlap
as little as possible.

Activating the Windbar

» Use the WINBAR (CTRL+W) key to toggle the cursor between a button of the "Win-
bar" and the block diagram.

The button that was active last in the Winbar is highlighted.

Closing an active menu

» Press the CLOSE key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the ESC key to close
the active menu.
Accessing the header area

» Press the FREQ (CTRL+F) and LEVEL (CTRL+L) keys to activate the "Frequency"”
or "Level" entry fields in the header area.

Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the foreground)
provide direct access to all utility dialogs of the instrument (see chapter 4.8, "Legend of
Front-Panel Controls", on page 98).

4.4 Setting Parameters

The R&S SMBYV offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.
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The examples whitin this description focus on the operation from the front panel.

e chapter 4.8, "Legend of Front-Panel Controls", on page 98 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

@ For more information, refer to:

e section "Instrument Functions" for a detailed description of key functions.

Most of the parameters are set in the different menus. The R&S SMBYV provides alter-
native ways for accessing the dialogs. Turn the rotary knob and navigate to the corre-
sponding block in the block diagram and press the knob to open the dialog or perform a
mouse click on the "Config..." button.

An exception are the "Setup”, "File" and "Hcopy" dialogs. In the "Setup" dialog, general
settings are made which are not directly concerned with signal generation, e.g. setting of
the GPIB-bus address. In the "File" dialog, files and lists are managed; in the "Hcopy"
dialog, printout is configured and hardcopies can be made. These menus can only be
called with the SETUP (CTRL+E), FILE (CTRL+S) and HCOPY (CTRL+Y) keys.

Frequency and level are directly set in the header area of the display using the FREQ
and LEVEL keys.

Specific settings can also be made directly in the block diagram, e.g. activating a function
block by means of the TOGGLE ON/OFF (CTRL+T) key or switching the RF output on
and off with the aid of the RF ON/OFF (CTRL+R) key. Changes affecting the signal flow
are immediately visible in the graphics display.

This section provides an information about the parameter handling that comprises of the
following main steps:

e chapter4.4.1, "Working with the Cursor", on page 77

® chapter 4.4.2, "Selecting a Control Element", on page 78

e chapter 4.4.3, "Switching Parameters On/Off", on page 78

e chapter4.4.4, "Entering a Value", on page 79

® chapter 4.4.5, "Working with Units ", on page 80

e chapter 4.4.6, "Selecting a Value from a List", on page 81

e chapter 4.4.7, "Terminating Entries with Confirmation", on page 82

e chapter 4.4.8, "Restoring the Previous Value", on page 83

4.41 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of the
diagram (default setting).

|
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Moving the cursor on the display

» To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.

b) Use the appropriate softkeys (CTRL+F1..F8) to move the cursor to the "Win-
bar".
Ifthe "Winbar" is covered by a menu, press the WINBAR (CTRL+W) key to display
it in the foreground.

c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor position.
The function of this key depends on the current cursor position.

e Calls the next higher selection level.

Closes the open window without accepting new entries; the old value or param-

eter is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or

to the previously highlighted block in the block diagram if no menu is active.

e Shifts the cursor from a function block in the diagram to the first item in the
"Winbar". If no menus are open, the current cursor position remains unchanged.

Moving the coursor to the heading area

» Pressthe FREQ (CTRL+F)or LEVEL (CTRL+L) key to move the cursor to the header
area.

Selecting a Control Element
Control elements are always selected in the same way no matter whether a function block
in the diagram, a menu in the menu tree, a parameter in the menu or an entry in a list or

table is concerned.

» To activate an element, put the cursor on it.

Source |Interna| jl

An active element is highlighted by a blue frame.

Switching Parameters On/Off
A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.

|
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2. To change the state of a parameter, use the "Enter" function of the different control
media:

e Press the rotary knob
e Press ENTER
e Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing mode,
cursors of different colour are used. A blue cursor indicates the overwrite mode, a green
cursor the insert mode.

@

Changing between the Insert and Overwrite mode
The insert mode is the default setting.
Use the INSERT key to toggle between the insert and overwrite mode.

Numeric and alphanumeric values can either be newly entered or the existing value can
be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value

1. Select the parameter.

2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the rotary knob (= Enter) to activate the editing mode.

If the cursor is placed at the right of the total value, the insert mode is always active.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

[{symbol Rate [ 270.833 33 [ksymis =||  [|Symbol Rate | ?Tﬂ.ﬁaﬂﬂiksym‘s | |

-
lsymbol Rate | 270828 333 [ksymis =||  [symbol Rate | 270.86 33 |Kksymis ~|f

Editing a value in the overwrite mode
1. Activate the editing mode.

2. Setthe cursor on the numeric digit to be changed using the LEFT/RIGHT arrow keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

|
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3. Click on a numeric key to overwrite the highlighted value.

ffsymbol Rate |_270.685 33 [ksymis_=|| [Symbol Rate [~ 270.858 33 |woymis j

Varying a value
1. Activate the editing mode.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The value at the cursor position is varied.
3. To vary the selected value, use the UP/DOWN arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value
1. Select the parameter.
2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example) or
in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are auto-
matically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.

File Name: File Name:
Hcchisﬂ]_mc:w] Mcowlist! 0 mecw I

Terminating the entry of a numeric value
To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).

2. Press a UNIT key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.

4.4.5 Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited, the
unit is selected either from the list or by means of the front-panel keys. When the entry

|
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is completed, the unit can be changed. In this case the value remains unchanged but is
automatically adapted to the new unit.

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.

Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a UNIT key on the front panel.

B
[eymbol Rate | 14]| ksymis =] + .ll = [[symbol Rate [14.000 000 00 [Msymss ~]
wy

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a UNIT key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

"
[Isymbor Rate [ 270833 33 [ksymss ;[I + .' = [symbo1 rate [ 0270 833 33 [Msymis -]

The new unit is indicated in the value field of the menu.

4.4.6 Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.

Unframed
amed 0

Framed {Double)

Save/Recall Frame.__.

IMude |Framed ({Single) jll
Modulation__.

To select a item from a list, proceed as follow:
1. Press ENTER key to open the list.

2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the UP/DOWN arrow keys.
The selected item is highlighted.

|
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b) Press TOGGLE ON/OFF key several times until the preferred entry is displayed
in the selection field.

3. To confirm the selection, press the ENTER key.

4.4.7 Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the param-
eter type and the way this parameter is set.

Confirming settings

» To confirm the settings, press the rotary knob or one of the UNIT keys (see also
chapter 4.4.5, "Working with Units ", on page 80) .

Note: Variations by means of the rotary knob are immediately set.

Confirming multiple values

In some cases, like for instance when configuring the carriers for a multicarrier CW signal
in a carrier table, it is useful first to enter few values and to confirm them together. Such
settings require additional confirmation. Not yet confirmed settings are displayed on a
yellow background as an indication that the currently displayed values do not represent
the target signal.

» To confirm these settings, select the "Accept" button.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

If time-consuming calculations are required, signal generation is automatically switched
off and calculation is interrupted to allow the user to make further settings. Calculation is
restarted with the RECALCULATE key and the modulation is switched on again when
the calculation is completed.

Preventing recalculation
If an instrument function requires several parameter settings, switch the function off to
prevent a recalculation.

Enable the function after the entire configuration of the settings have been compleated.
The signal is recalculated only once.
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4.4.8 Restoring the Previous Value
Parameter variations with the rotary knob are immediately set and therefore not reversi-
ble.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.

Restoring values

In the case of front-panel control or operation from the keyboard, previous values can be
restored as long as the new value is not confirmed, i.e. the entry is not completed.

» To restore the values, press the ESC key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

A confirmation query is displayed.

You changed some parameter(s) which require a new calculation of the signal.
Do you really want to abort your changes without ACCEPT ?

OK Cancel |

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are displayed.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" message
displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calculation
that requires longer calculation time. The termination of such a calculation restores the
previous values.

» Press the ABORT button to terminate the calculation.

All previous values are restored.

4.5 Editors

The R&S SMBYV provides user-friendly editors for defining data lists as well as control
and marker signals. Lists containing frequency and level value pairs are used for the list
mode and the user-defined level correction.
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Internally generated data lists can be used for digital modulation and digital standards;
the same applies to internally defined control and marker signals.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to chapter 4.7, "File Management”, on page 91.

Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

Editing list mode data lists

1. To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the "Frequency/
Hz" column.

LIsTL

Power/dB
-145.00

Frequency/Hz
9 000.000

1

2 19000000/ -140.00

3 29 000.000 -135.00

4 39 000.000 -130.00

5 49000000 -125.00

3 59 000.000 -120.00

7 £9 000.000 -115.00

5 79 000.000 -110.00

9 89 000.000 -105.00

1 99 000.000 -100.00

1

=
Goto | Edit Save As... ‘ Save

If no list has been selected, a blank list of only one row is displayed.

2. Press the LEFT/RIGHT arrow keys to change between the colums.
Use the UP/DOWN arrow keys to mark a row.

3. Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz" and
"Power/dBm" table columns. A blank row is inserted at the end of the list.
An existing list can be edited in the insert or overwrite mode; use the INSERT key to
toggle between this two modes.
Terminate the entry by pressing a UNIT key.

4. To select a row, select the "GoTo" button and press the ENTER key.
Use the numeric keys to enter the row index in the entry field and press the
ENTER key to confirm the entry.
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The cursor moves to the selected row.

5. Toinsert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

6. Use the "Save"/"Save As..." function to save the edited list under its current name or
under a new name.
Enter the file name in the "File Select" dialog and select the directory (see chap-
ter 4.7.1, "File Select Dialog", on page 93).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.

Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the "File
Select" menu (see section chapter 4.7, "File Management", on page 91) or by changing
an existing list which will then be saved under a new name.

1. To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correction
Data" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

Working with Data Editor

The "Data Editor" is used to internally generate binary data lists for digital modulation and
digital standards.

A list of binary values with a maximum length of 2*31 bits can be entered in the "Data
Editor". This value corresponds to a file size of approx. 268 Mbyte. While it is being pro-
cessed, the file is continuously automatically buffered. When the dialog is exited, the file
is automatically saved with the new values, i.e. there is no extra "Save" button. Depending
on the size of the file, saving may take some time.

Editing an existing data list

1. To access a data editor and open an existing data list for editing, use the arrow keys
to select the associated button "Edit Data List... " in the individual menu.

The selected data list is displayed.

Offset 60, Len 62, GSM_dl i
0 0000’ 0000f 00007 0001 1111 1111, 0100 0000 0101 0010} 1010 0111

48 1111 1111/ 1000 [0
96

Start
’ GoTo | Sl | Copy | Paste | HEX Save |
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The cursor marks the start value of the list.

To increase readability, the bits are displayed in groups of four. The current cursor
position, the length of the list and the list file name are displayed above the list. The
offset starts with the value 0 which corresponds to the bit position on the left side of
the first row, i.e. the beginning of the list. On the left edge of the editor, the last three
offset positions are specified at the beginning of the row.

2. Use the numeric keys to enter the values 0 or 1.
An existing list can be edited in the insert or overwrite mode. Use the INSERT key to
toggle between these two modes.

3. To delete a value, use the arrow keys to mark the bit that follows the value to be
deleted.
Press the INSERT key to activate the insert mode. Values cannot be deleted in the
overwrite mode.
Press the BACKSPACE key.

The value before the marked bit is deleted.

4. To select a bit position, select the "GoTo" button and press the ENTER key.
Enter the bit position in the "GoTo Offset" entry field by means of the numeric keys
and confirm the entry.

The cursor marks the bit at the selected position.

5. To copy and paste any range of bits at any position in the list:

a) Use the the arrow keys to mark the start bit of the selection.

b) Select the "Start Select" button and use the the arrow keys to mark the selection.
c) Click the "Copy" button.

d) Navigate to the insert possition and select "Paste".

The selected and copied bits are pasted after the selected position.

6. To display and edit the values in hexadecimal form, select the "Hex" button.

Each four bits are displayed as a hexadecimal value: To increase readability, the
hexadecimal values in turn are displayed in pairs of two. The hex functions are auto-
matically assigned to the numeric keys at the front panel.

7. To save the data list, press the ESC key.

The list is saved automatically when the dialog is closed.

Creating a new data list

1. Tocreate an empty data list, in the individual menu select "List Management > Select
Data List to Edit... > Create Data List" and enter the file name of the new data list.

2. Toopen the data list for editing, select the associated button "Edit Data List..." in the
individual menu.
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4.5.3 Working with Control and Marker List Editor

The control and marker signals for digital modulation and digital standards can be very
conveniently graphically defined in a "Control and Marker List Editor". The available
marker signals — and, with custom digital modulation, the CW, Hop, Burst Gate and Lev
Att control signals — can be defined in this editor.

While it is being processed, the file is continuously automatically buffered. Depending on
the size of the file, saving may take some time.

N\ The various functions of the editor are explained in the individual menus. This section
/ focuses to the general use of the graphic editor.

Example:

The following figure shows the "Slot Marker Definition Editor" of the "GSM/EDGE" dialog
as an example.

[51ot Harker GSH iFrame 1 3 Slot 0)

TSC S
26 1

Configure Control Signals Select Ramp to edit
{Markeﬂ = :
Marker 2 I_- :

0 50 100 Position / Bit
Total List Length—
Length ]15?
Marker 1 Cursor -Zoom Save

Preset Type IAII down 'l Pasition I 2 - Zoom In | Save |
__ Presat_| EdtTable.. ||| oogiioninTal 2 || e Visitle 150

The upper area displays the signal for which the marker signals are to be defined. On the
left side, the available signals (marker and control signals) are listed and colour-coded.

Auxiliary functions are offered in the lower editor area, e.g. presetting for the ramps in
the marker signal, cursor positioning by entering the bit position and possible editing by
means of value entries in a table.

The actual graphic definition of the control signals occurs in the center area of the editor.
Each control signal is represented by means of a colored line along the bit axis. A cursor
can be shifted alongside this line and marks the position where a ramp is to be set. The
color of the cursor changes depending on the current function.

Use the ENTER key to switch over between the colors (and therefore functions):

e black: marks the bit position on the marker line

e yellow: sets a ramp

e green: activates the marked ramp for shifting.
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Accessing control and marker list

1.

To access the control list editor (e.g. "CList Dig Mod") and open an existing list for
editing, use the arrow keys to select "Custom Digital Mod > List Management > Edit
Control List".

To access the slot marker list editor (e.g. "Slot Marker") and open an existing list for
editing, use the arrow keys to select "GSM/EDGE > Burst Editor > Slot Marker Def-
inition".

Editing an existing control or marker list

1.

Activate control/marker signal line for editing.
Use the arrow keys to mark the editable graphic area and press the ENTER key.
Select the control/marker signal line to be edit and press the ENTER key.

The cursor is active for the selected line.

Define the cursor position.
Select the parameter "Cursor Position", specify the position by means of the numeric
keys and confirm the entry.

The cursor is positioned according to the entry. If the entered value exceeds the
selected length of the definition range, the length is adjusted automatically.

Configure the control and marker signals (see "Handling of Ramps" on page 88).

Define length of control list ("Custom Dig Mod" only).
Select the "Total List Length" entry field and press the ENTER key. Enter the length
by means of the numeric keys and confirm the entry.

The control list length is defined.

Zoom displayed range ("Custom Dig Mod" only) in long control lists.

To zoom the displayed area around the current "Cursor Position", select the param-
eter "Visible/Bits Visible", enter the number of symbols/bits to be displayed by means
of the numeric keys and confirm the entry.

Select the "Zoom In" button and press the ENTER key.

The selected number of symbols/bits around the current cursor position are dis-
played.
Ramps outside the displayed area are not lost by zooming.

Use the "Save"/"Save As..." function to save the edited control/marker list under its
current name or under a new name.

Enter the file name in the "Create File" dialog and select the directory (see chap-
ter 4.7.1, "File Select Dialog", on page 93).

Handling of Ramps

1.

Set a new ramp
Use the arrow keys or use the parameter "Cursor Position" to move the cursor to the
position where the ramp is to be inserted. Press the ENTER key.
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The ramp transition of the newly set ramp depends on the current status (high or low)
of the control signal. If the signal is low, a ramp with low-high transition is generated;
if the signal is high, a ramp with high-low transition is generated.

J

=

I
4

When ramps are set between existing ramps, the transition of the new ramp is also
defined by the status of the signal before the new ramp. For this reason, a ramp that
has already been set can be assigned low-low or high-high transition (as in the
example), i.e. it will have no effect on the control signal in this configuration. However,
the ramp remains saved, and its position is indicated by a dashed line.

| R
| |

T
I ]

If another change produces effective transition, this ramp will be regenerated.

i i,

=il |

]

2. Shift a ramp
An existing ramp can be shifted to any positions. The transitions are adjusted accord-
ingly.
Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.
Press the ENTER key. The cursor again changes colour. The ramp will now be shifted
by means of the cursor. Press the ENTER key. The ramp will be set at the current
position.

The ramp transition depends on the status (high or low) of the control/marker signal
before the ramp.

3. Delete aramp
Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.
Press the BACKSPACE key.

The ramp will be deleted. The ramp transitions of the other ramps are adapted to the
changed signal status (high or low).

4. Setthe ramps in a table
Select the "Edit Table..." button and define the positions and states of the ramps for
the selected marker.
Confirm the entries with "Accept".

5. Preset a marker signal
Select the "Preset" button to preset the marker signal.

The ramps of the selected marker are adjusted according to the selected "Preset
Type".
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Creating a new control list

A new control list can be created under a new name either by generating a blank file or
by changing an existing list which will then be saved under a new name.

1.

To create an empty control list, select "BB > Cust Dig Mod > List Management... >
Select Control List to Edit > Create Control List" and enter the file name of the new
control list.

To open the control list for editing, select the associated button "BB > Cust Dig Mod
> List Management... > Select Control List to Edit > Edit Control List..." and select an
existing control list.

4.6 How to Use the Help System

The R&S SMBYV is equipped with a context-sensitive help function. A help page is avail-
able for each parameter and can be called any time during instrument operation.

Compiled online help systems are also available for all functions of the R&S SMBV on
the CD-ROM supplied with the instrument. This help program can be called on any con-
troller with Internet Explorer version V4.0 and higher.

Calling context-sensitive and general help

» To display the general help dialog box, press the HELP (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

EE Help - State - Digital Modulation

i Operating the R&S Vector Signal Generator = Instrument Function > Baseband Signal -
i SetToDefy § Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
- SavelReca| § Interface > General Settings > State - Digital Modulation
+--a Data Sourc
+-(3 Standard, §
+ @ Modulation
+ ﬂ Modulation
L Filter Enables/disables digital modulation.
+ tfh Power Ram|
-3 List Managq | Switching on digital modulation tumns off all the other digital standards.
+-( Data List E
+--a Control and|
+-(3 Power Ran{ || The digital modulation is generated in realtime (no precalculated signal), and therefare all
+-(3 TriggeriMar || parameter changes (in the ON state) directly affect the output signal.
+] aArbilraryWﬁveion
+ Iﬂl External Baseband Si
=3 Remote Control Basics | [:SCURce<hw>] tBE:DM:STAT
+--a Remote Control Commang
+--q Maintenance
+--a Error Messages Top
+--a Hardware Interfaces
- List of Commands
o | 3

State - Digital Modulation

In case of two-path instruments, this affects the same path.

SCPI command:

GoTolndex | find | Back | Scroll Left | Scroll Right ZoomIn Zoom Out

Contents of the help dialog box

The help dialog box contains two main areas:

"Contents" - contains a table of help contents
"Topic" - contains a specific help topic
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The help system provides additionally an "Index" and a "Find" area, as well as "Zoom"
functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents

1. To move through the displayed contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.
The corresponding help topic is displayed.

Navigating in the help topics

1. To scroll through a page, use the UP/DOWN arrow keys.

2. To jump to the linked topic, press the link text.

3. Use the "Previous" or "Next" links to jump to the corresponding topic.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

Using the Index

1. Select the "Go to Index" button.

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
4. Use the UP/DOWN keys to navigate and select the suitable keyword.
5. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

» Press the HELP (F1) key.

4.7 File Management

The R&S SMBYV uses files to save all instrument data, i.e. system and user data.

The user data includes saved instrument settings, data for the different digital standards,
lists for the List mode and the user correction as well as the waveforms for the arbitrary
waveform generator.

The files are stored on the internal flash card of the instrument, on a USB-stick or on the
a hard disk (R&S SMBV-B92). Both, the /var directory on the internal flash card or the /
hdd directory on the hard disk (R&S SMBV-B92), can be used to save user-defined data.
Any directory structure can be created on /var and /hdd. Some default subdirectories
are predefined, but can be changed at any time.

Operating Manual 1407.6062.32 — 08 91



R&S®SMBV100A Manual Operation

File Management

The /opt directory is a protected system drive and therefore unaccessible system direc-
tory. The files on this directory contain data that must not be changed. Therefore, this
drive should not be accessed, since reconstruction of the system partition will lead to data
loss. To prevent inadvertent deletion or overwriting of system files, this drive is not speci-
fied in the file menus.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the /usb drive. In the case of a
connected network, all network drives that can be accessed are available. The files are
accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since access
to the files occurs in the individual menus where only the relevant type of file is available.
See chapter 4.7.2.1, "Extensions for User Files", on page 95 for an overview of the
supported file extensions.

The user data can be roughly divided into the following data types:

e Settings
Settings, e.g. the frame setting of the GSM/EDGE standard, can be loaded and cur-
rent setting saved to the specified file.

e Lists
Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

e Complex modulation and control data
User data of this type can be loaded. It can be generated either externally or internally.
For internal generation, a new list must be created which will then be edited in the
data and control list editor. These functions are offered in the "Data List Manage-
ment" dialog of the individual modulation menu.

e Waveforms
Waveforms are generated externally (e.g. by means of the R&S WinlQSIM2 program
that is supplied together with the optional Baseband Generator R&S SMBV-B10) and
can be loaded in the "Arbitrary Waveform Generation" dialog.

Softkeys are assigned to some of the functions and can be used for convinient operation.

For more information, refer to:

OO

e chapter 4.8, "Legend of Front-Panel Controls", on page 98 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

e {0 section "Instrument Functions" for a detailed description of key functions.

Accessing files with user data

1. Toaccess an editable user data file, select the "Save/Recall" or "File Manger" function
in the individual dialog.
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Recall Settings
Save Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function in
the individual dialog.

Select User Correction Data
Mew User Correction Data
File Manager...

To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.
To access the "File" menu, press the FILE (CTRL+S) key.

For more information, see chapter 5.2.8, "Storing and Loading Instrument Data - File
Key", on page 138.

4.71

File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper part,
"Recent Data Sets", the files last used are listed.

Save/Recall e Save/Recall L]
Select Operation Save Select Operation Recall v
Jvar/smbv/Lists/SavRcl arfsmbv/Lists/SavRcl
MCLLICLLIEELL LA LSS Save e

(5 RMboSynRefCalData B =90 Sarel Al

PIESSISEHINGS

Tdscdma i G Tdscdma .

& wimax - -6 WiMAX =
Filz Name Exclude Frequency[™ Exclude Level [~
presetsetlings | Recall Recall Recall File

Recall
Save Trrs e File Imm 1 Imm 2 Imm 3 Manager.

Imm 1 Imm 2 Imm 3 Manager.

|

The available drives and directories and the files of the selected directory are displayed.
The currently selected path is displayed above the window. Only the relevant files without
file extensions are displayed. If the area is opened several times, the path last selected
is displayed. When a file is saved or created, its name is user-selectable; the extension
is assigned automatically and cannot be entered. The file is saved to the selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this rea-
son, this directory cannot be chosen from the "File Select” menu.
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Example:

The following example shows the "File Select" menu of the GSM/EDGE digital standard
when "Recall Predefined Frames" is selected.

Recall Predefined Frame Recall Predefined Frame
Recall User Frame
Save User Frame
File Manager...

3 recent data sets
Edgel
EdgeAll

GsmEdge
MaormalBurstl
MormalBurstAll

| File |
R Manager...

Working with the File Select dialog
1. Access the "File Select" dialog (see "Accessing files with user data" on page 92).
2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" button.

5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individual
editor.

4.7.2 File Manager

The "File Manager" allows general file management such as copying, shifting, renaming
and deleting files as well as generating new directories.

Thus, also externally created files, for example waveforms created by using the
R&S®WinIQSIM2 program, can be saved to the R&S SMBYV by copying them from a
memory stick or a network to the internal hard disk.

|
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File Manager =] Ed

File Type |Instrument State (*.savrcltxt) j

i H-RiboSynRetLallata
EQ SavRel
i i presetsettings. savrclixt

K

o 05 winay

Create New

e Directory

Copy | Paste | Rename Delete

Use the "File Type" to select a file type form the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See chapter 4.7.2.1, "Exten-
sions for User Files", on page 95 for an overview of the supported file extensions. The
available drives and directories and the files of the selected directory are displayed. The
currently selected path is displayed above the windows. If the area is opened several
times, the path last selected is displayed. Unlike the "File Select" window, the "File Man-
ager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user
data" on page 92).

2. Navigating in the "File Manager" dialog.
Operation is similar to the operation of menus with several areas.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to which
the file is to be moved and select the "Paste" button. If the target directory already
contains a file with the same name, a confirmation query is displayed to confirm
overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.

4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the
"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

4.7.2.1 Extensions for User Files

The following table list all available file extensions for user files. The currently available
files on the instrument depends on the installed options.

Table 4-1: List of the automatically assigned file extensions in the instrument

Function/Digital List type Contents File suffix
Standard

Instrument State Settings Instrument settings *.savrcltxt
"User Correction" List User-defined level correction values *.uco

"List Mode" List User-defined frequency/level value pairs * . lsw
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Function/Digital List type Contents File suffix
Standard
"Frequency Settings User-defined frequency response correction file | *. frc
Response Correc-
tion"
"Arbitrary Waveform | Waveform ARB waveforms * L wv
Generator ARB multi segment waveforms
Waveform ARB multi carrier settings *.arb mult
carr
Configuration | Configuration file for creation of multisegment *.inf mswv
data ARB waveforms
Play List ARB Sequencing List * . wvs
"DM" Data List Digital modulation data *.dm_iqd
*.tdm
Control List Data to control digital modulation *.dm_iqc
Settings Digital modulation settings *.dm
User Standard | Digital modulation user standard *.dm_stu
User Mapping | Digital modulation user mapping * . vam
User Filter Digital modulation user filter * vaf
"NRP Settings" Settings NRP Settings *.nrp
EX-1Q-Box User Settings | EX-IQ-Box User Defined Settings * . igbox
"Fading" Fading Fading data * . fad
"GSM/EDGE" Settings GSM/EDGE settings *.gsm
Slot User-defined slot data *.gsm_slu
Frame User-defined frame data *.gsm_fu
Slot Higher symbol rate slot *.gsm_hslu
Frame Higher symbol rate frame *.gsm_hfu
"Bluetooth"” Bluetooth Set- | Complete setting of the Bluetooth menu *.bto
tings
"TETRA" TETRA Set- Complete setting of the TETRA menu *.tetra
tings
"3GPP FDD" Settings Complete setting of the 3GPP (FDD) menu *.3g
Settings Channel coding enhanced DPCH channels *
(downlink) 3g_ccod dl_s
Settings Channel coding enhanced DPDCH channels *.3g ccod ul
(uplink)
"CDMA2000" Settings Complete setting of the CDMA2000 menu * . cdma2k
"TD-SCDMA2000" | Settings Complete setting of the TD-SCDMA2000 menu | *.tdscdma
Settings Test Model for TD-SCDMA2000 * . tdtmd
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Function/Digital List type Contents File suffix
Standard
1xEV-DO Settings Complete setting of the 1xEV-DO menu * . evdo
"IEEE 802.11 Settings Complete setting of the IEEE 802.11 WLAN * . wlan
WLAN" menu
"IEEE 802.11 n Settings Complete setting of the IEEE 802.11n WLAN *.wlann
WLAN" menu
Settings Beamforming data * . bmf
"|IEEE 802.16 Settings Complete setting of the IEEE 802.16 WiIMAX * . wimax
WiMAX" menu
"EUTRA/LTE" Settings Complete setting of the EUTRA/LTE menu *.eutra
Settings TDD Settings *.lte tdd
Settings User-defined IQ-File * . iqw
"GPS" Settings Complete setting of the GPS/A-GPS menu *.gps
Settings GPS Almanac Settings * . txt
*.alm
*.al3
Settings GPS Waypoints File * . txt
Settings GPS Generated Almanac File *rs_al

*.rs_yuma

Settings GPS lonospheric File *.rs_ion
Settings GPS Navigation Data *.rs_nav
Settings GPS UTC File *.rs_utc
*.rs_acq
"FM-Stereo" Settings Complete setting of the FM-Stereo menu * . fmstereo
Settings FM-Stereo Group Type Settings * . fm gt
Settings FM-Stereo Group Hex Type Settings *.fm_ ghex
Waveform File | Waveform File * . wav
"Sirius" Settings Complete setting of the Sirirus menu *.sirius
"XM-Radio" Settings Complete setting of the XM-Radio menu * . xmradio
Settings XM-Radio TWTA Data *_twta
"DVB" Settings Complete setting of the DVB menu *.dvb
Settings DVB Transport Stream *.gts
*.ts
*.trp

|
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Function/Digital List type Contents File suffix
Standard
"DAB/T-DMB" Settings Complete setting of the DAB/T-DMB menu *.dab
Settings DAB ETI Files *.eti
*.xeti

4.8 Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 4-2: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key Key of PC keyboard Function

Turning the rotary knob | Tab key (towards the right) | Sets the cursor with the rotary knob.
Shift + Tab (towards the left)

Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has the

knob same function as the ENTER key.

Arrow keys Arrow keys Moves the cursor.

*1/dB(m) ALT + F12 Confirms entries in the base unit and values without
a unit.

Selects dBm for the RF level and dB for level offset
and level step width.

ELH# ELH Enters a period/decimal point. Enters a special char-
acter.

+/- | A<->a -/ (shift+) a—z Enters the sign.
Switches between upper-case and lower-case let-
ters.

0-9/a..z CTRL+0-9/a..zCTRL Enters the number/letter.

BACKSPACE Backspace Clears the last entry (number, sign or decimal point)

CLOSE CTRL+ G Closes an active menu.

DIAGRAM CTRL+ D Sets the cursor on the block diagram and hides all
menus.

ENTER Enter Terminates an entry.

ESC ESC Selects the next higher menu/selection level. When

the editing mode is exited with ESC, the previous
value is restored.

FILE CTRL+S Activates the menu for storing instrument settings.

FREQ CTRL+ F Activates the frequency entry.

|
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Front-panel key Key of PC keyboard Function

G/n / dBuV ALT + F9 Selects the unit Giga/Nano, dBuV for the RF level
and dBu for the LF level.

HCOPY CTRL+Y Opens the menu for configuring and starting a hard-
copy.

HELP F1 Opens/closes context-sensitive help.

HIDE CTRL+ H Minimizes the active menu. Pressing the respective

button in the Winbar opens the menu again.

INFO CTRL + 1 Opens/closes the info window

INSERT Ins Activates the insert mode.

k/m [/ uv ALT + F11 Selects the units Kilo/Milli and uV for RF levels.

LEVEL CTRL+L Activates the level entry.

LOCAL CTRL+Q Switches the instrument from remote control to man-
ual control.

M/u / uv ALT + F10 Selects the units Mega/Micro and uV for RF levels.

MENU CTRL+ M Calls the menu selection list.

MOD ON/OFF CTRL+O Switches modulation on/off. "MOD OFF" is indicated

in the status line.

TOGGLE CTRL+T Switches a block or parameter on/off.

Toggles between the different possibilities of setting
a selection parameter.

PRESET CTRL +P Restores a defined basic instrument setup.

REARR CTRL + A Adjusts the size of the active menu to use the whole
height of the dislay.

RECALCULATE CTRL+C Starts recalculation of the signal.

RF ON/OFF CTRL+R Switches the RF output signal on/off. "RF OFF" is
indicated in the status line.

SETUP CTRL+E Opens the setup menu for general instrument set-
tings.

Softkeys CTRL + F1-F6 Triggers the function assigned to the softkey.

WINBAR CTRL + W Toggles between the active menus.

4.8.1 Front Panel Key Emulation

The R&S SMBYV provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called by a right
mouse click. The front panel key functions are executed by a mouse click on the asso-
ciated button.

|
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5 Instrument Function

5.1 Overview of Instrument Functions

This chapter explains the functions of the R&S SMBV and the options available in the
setting menus. The associated SCPI command is specified for each parameter (where
applicable).

The description begins with the general instrument settings which do not directly affect
signal generation. The maijority of these settings can be accessed by means of front-
panel softkey menus and not by means of function block menus.

One exception is, for example, the signal graphics which are called up in the "Graph-
ics" block.

The signal generation functions are then described, beginning with the RF section func-
tions which affect the RF signal and the analog modulations and which are compiled in
the "RF/A Mod" block of the block diagram.

This is followed by an explanation of all functions which are in the signal flow prior to
being fed into the RF block and which do not affect the internal generation of a baseband
signal - 1/Q modulation, noise generation and impairment of the digital signal. These
functions are accessed by means of the function blocks"l/Q Mod "and "AWGN/IMP".

The remaining (and largest) part of the chapter describes the functions used for the inter-
nal generation of the signals in the baseband (these functions are provided in the "Base-
band" block).

The general instrument settings include various functions, such as:

e Setting a defined basic setup using the PRESET key
see chapter 5.2.2, "Default Instrument Settings - Preset Key", on page 104

e Switching from remote control to manual control using the LOCAL key
see chapter 5.2.4, "Switching to Manual Control - Local Key", on page 133
e Configuring the generator and its interfaces in the "Setup" menu - e.g. setting the
GPIB address, starting an adjustment, querying instrument data
see chapter 5.2.3, "General Configuration of Instrument - Setup Key", on page 105
e Generating a hardcopy of the display using the HCOPY key
see chapter 5.2.5, "Generating a Hard Copy of the Display", on page 133
e Calling up the online help using the HELP key
see chapter 5.2.7, "Help System - Help Key", on page 137
e Querying messages using the INFO key
see chapter 5.2.6, "Messages - Info Key", on page 136
e Loading and storing complete instrument settings in the "File" menu
see chapter 5.2.8, "Storing and Loading Instrument Data - File Key", on page 138
e Calling up the baseband signal graphics in the "Graphics" function block
see chapter 5.3, "Graphical Display - Graphics", on page 144
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The RF signal is configured and the analog modulations activated in the "RF/A Mod"
function block:
e CW mode

see chapter 5.4.1, "Overview of RF Signal", on page 154

e List mode
see chapter 5.4.15, "List Mode", on page 227

e Sweep mode
see chapter 5.4.14.1, "Overview", on page 208

e Analog modulations
see chapter 5.4.12.1, "Overview", on page 189

In the "I/Q-Mod" function block, 1/Q modulation is possible with external analog signals
and internally generated baseband signals.
e |/Q modulator

see chapter 5.5, "l/Q Modulation - 1/Q Mod Block", on page 235

Noise can be added to the baseband signal and the baseband signal can be impaired
before input into the 1/Q modulator. It is therefore possible to output a baseband signal
with impairments via the I/Q-OUT outputs ("AWGN/IMP" function block). Impairment is
also possible during 1/Q modulation ("I/Q Mod" function block).
e Impairing the signal

see chapter 5.6.1, "Impairments", on page 249
e Adding noise

see chapter 5.6.2, "AWGN - Noise Generator", on page 257

The baseband signal is available at the 1/0 outputs.

e Output of the baseband signal
see chapter 5.6.3, "Output of the Baseband Signal - I/Q Out", on page 264

e Digital 1/Q Output
see chapter 5.7, "Digital 1/Q Output Settings", on page 267

The R&S Signal Generator offers various possibilities for generating digital modulation
signals in compliance with the definitions of digital standards or with characteristics which
can to a large extent be freely defined. The range of software options for this is being
extended continuously.
e Baseband signals - Introduction

see chapter 5.8, "Baseband Signal - Baseband Block", on page 271

e External Baseband signals
see chapter 5.9, "External Baseband Signal - Baseband Input”, on page 384
e Digital modulation
see chapter 5.8.3, "Digital Modulation - Custom Digital Modulation", on page 282
e Arbitrary waveform generator ARB
see chapter 5.8.4, "Arbitrary Waveform Generator ARB", on page 323
e Multi Carrier CW signals
see chapter 5.8.5, "Multi Carrier Continuous Wave", on page 370

e Digital standard GSM/EDGE
see description "Digital Standard GSM/EDGE"
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e Digital standard 3GPP FDD (WCDMA)
see description "Digital Standard 3GPP FDD (WCDMA)

e Digital standard CDMA2000®
see description "Digital Standard CDMA2000®"

e Digital standard TD-SCDMA
see description "Digital Standard TD-SCDMA"

e Digital standard 1xEV-DO
see description "Digital Standard 1xEV-DO"

e Digital standard IEEE 802.11 (a/b/g) (WLAN)
see description "Digital Standard IEEE 802.11 (a/b/g) (WLAN)"

e Digital standard IEEE 802.11n (WLAN-N)
see description "Digital Standard IEEE 802.-11n (WLAN-N)"

e Digital standard IEEE 802.16 (WiMAX)
see description "Digital Standard IEEE 802.16 (WiMAX)"

e Digital Standard EUTRA/LTE
see description “Digital Standard EUTRA/LTE”

e Digital Standard XM Radio
see description “Digital Standard XM Radio”

e Digital Standard DVB-H
see description “Digital Standard DVB-H”

e Digital Standard DAB / T-DMB
see description “Digital Standard DVB / T-DMB”

5.2 General Instrument Settings

5.2.1 Overview of General Instrument Settings

This section describes the settings which do not directly affect signal generation. Most of
these settings can only be accessed by means of menus which are opened using keys
or key combinations on the external keyboard or keys on the front panel key emulation.

This does not apply to the graphical representation of output signals which is activated
in the "Graphics" function block, or settings which can additionally be called up in the
menus of the function blocks, e.g. input configuration which is possible in the "Setup"”
menu and in almost every menu of the "Baseband" function block.

See also chapter 4.8, "Legend of Front-Panel Controls", on page 98.

The general instrument settings therefore affect various functions, such as storing instru-
ment settings using the FILE key or setting the GPIB address in the menu of the
SETUP key. The order in which the descriptions are given corresponds to the layout of
the keys on the front panel of the R&S SMBYV (from top left to bottom right).

|
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5.2.2 Default Instrument Settings - Preset Key

The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument settings
provide a reproducible initial basis for all other settings.

However, functions that concern the integration of the instrument into a measurement
setup are not changed, e.g. GPIB address or reference oscillator source settings.

In addition, only those settings associated with the menu can be reset directly in the
individual menus, e.g. all digital modulation settings in the "Custom Digital Mod" menu.
These settings are identical to those which are called up using the PRESET key.

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched on.

User-defined instrument states can be stored and called up in the "File" menu.

@ Resetting the instrument to the factory state is possible with the Factory Preset function.

Preset
Presets all parameters and switching states.

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "RF frequency" =1 GHz

e "RF level" RF output switched off

e "Offsets" =0

e "Modulations State" = Off

e Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

e Internal level control "Level ALC" = AUTO

e User correction "Level Ucor" = OFF

e "LF output State" = Off

e "Sweep State" = Off

e "List mode State" = Off

Settings that are not affected by the PRESET key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

*IDN? Identification and emulation ("Setup” menu)

Password and settings protected by passwords ("Setup" menu)
Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)

SCPI command:
*RST on page 436
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System
Reference Oscillator...
Internal Adjustments...
Hardware Config...
Software/Options...

5.2.3.1

General Instrument Settings

General Configuration of Instrument - Setup Key

The SETUP key opens the "Setup" dialog.

The "Setup" dialog is divided into several sections.

e The "System" section is used to set general instrument parameters.

e The "Test" section is used to perform function tests.

e The "Environment" section is used to configure the controller interfaces.
e The "Remote" section is used to configure the remote control interfaces.

e The "Protection" is used to set the protection level for service functions and security
settings.

e The "Settings" section is used to save or recall instrument settings or to preset the
instrument to factory settings.

Most submenus of this key can be accessed only via the SETUP key or the menu tree
( MENU key), with the following exceptions:

e The "Reference Oscillator" dialog can also be called up in the "RF" block and is
therefore described in the section on this block (see chapter 5.4.4, "Reference Oscil-
lator", on page 159).

e The "Save/Recall" dialog can also be called up with the FILE key and is therefore
described in the section on this key (see chapter 5.2.8, "Storing and Loading Instru-
ment Data - File Key", on page 138.

e The "Global Trigger/Clock/ External Inputs" dialog is also available in all modulation
menus of the "Baseband" function block where it can be called up with the "Global
Trigger/Clock Settings" button in the corresponding "Trigger/Marker/Clock" dialog.
See also chapter 5.2.3.12, "Global Trigger/Clock/External Input Set-
tings", on page 121.

Internal Adjustments

The R&S Signal Generator is extremely accurate thanks to the integrated procedures for
adjustments.

All internal adjustments for which no external measuring equipment is needed can be
started in the "Internal Adjustments..." dialog. The adjustments with external measuring
equipment are described in the Service Manual (on CD ROM, supplied with the instru-
ment).

Adjustment is recommended if the temperature range in which the instrument is operated
changes, or prior to all applications which require maximum level and frequency accu-
racy.

During adjustment a bar indicates the status of progress. If an error occurs, adjustment
is terminated and an error message is output in the info line.
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Risk of invalid adjustment

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.

To access the "Internal Adjustments"” dialog, press the SETUP or MENU key under
"System".

The adjustments offered also depend on the installed options.

Internal Adjustments (x|

| Adjust Al |

Adjust Synthesis |
Adjust Level |

Adjust VQ Modulator
... Current Frequency |

... Full Range |

Adjust All

Starts all internal adjustments for which no external measuring equipment is needed. The
adjustments with external measuring equipment are described in the Service Manual
(supplied).

SCPI command:

:CALibration:ALL[:MEASure] on page 456

Adjust Synthesis
Performs all adjustments which affect the frequency.

SCPI command:
:CALibration<hw>:FREQuency[:MEASure] on page 457

Adjust Level
Performs all adjustments which affect the level. The acquired correction values improve
the settling time and the signal quality.

SCPI command:
:CALibration<hw>:LEVel [ :MEASure] on page 458

Adjust 1/Q Modulator Current Frequency

Starts the adjustment for the 1/Q modulator for the currently set frequency, I/Q swap, and
baseband gain. The I/Q modulator is adjusted with respect to carrier leakage, I/Q imbal-
ance and quadrature.

|
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Adjustment for only the set frequency is considerably faster than adjustment across the
entire frequency range. This is possible with "Full Range".

SCPI command:
:CALibration<hw>:IQModulator:LOCal on page 457

Adjust I/Q Modulator Full Range
Starts the adjustment for the I/Q modulator for the entire frequency range. The 1/Q mod-
ulator is adjusted with respect to carrier leakage, 1/Q imbalance and quadrature.

SCPI command:
:CALibration<hw>:IQModulator:FULL on page 457

5.2.3.2 Hardware Config

In the "Hardware Config" dialog, the installed assemblies together with their variants and
revision states can be displayed for servicing purposes.

To open the "Hardware Config" dialog, select "System" and press the SETUP or

MENU key.
Hardware Config
Counter |
Cperation Time [ h 187 522
Power COn Count 5187

Common Assembly

Assembly Part Mumber | Serial Number| Revision | Slot
SMBW100A | 1407 6004k02 | 100007
Basis Board | 1406.6600.02 |100020 04.00 Serial Bus Slot 0
COM-FPGA 02.11.00

Section "Counter” in the upper part of the menu shows the "Operation Time" (in hours)
and the number of power-on ("Power On Counter").

The second part of the menu is a table that lists the installed assemblies. It is divided into
the sections:

e "Common Assembly"

e "RF Assembly"

e "Baseband Assembly"

Operation Time / h
Displays the operation time in hours.

SCPI command:
:DIAGnostic:INFO:0TIMe on page 461

Power On Count
Displays the number of power-on.

SCPI command:
:DIAGnostic:INFO:POCount on page 461
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Assembly
The tables list the installed assemblies.

"Assembly" Assembly name
"Part Number" Part Number of assembly

"Serial Num- Serial Number of assembly

ber"

"Revision" Revision state of assembly

"Slot" Indicates whether the assembly is connected to the serial bus or PCI
bus.

SCPI command:
:DIAGnostic<hw>:BGINfo on page 460

5.2.3.3 Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software as
well as all installed hardware and software options.

ON\ Software options purchased at a later stage can be activated with a keycode. The acti-
/ vation code is supplied with the software option. How to install options is described in
Chapter 4 of the Service Manual (supplied with the instrument).

The installation of hardware options purchased at a later stage is also described in Chap-
ter 4 of the Service Manual (supplied with the instrument). Most hardware options need
to be installed at an authorized Rohde&Schwarz service shop.

To access the "Software/Options" dialog, select "System" and press the SETUP or
MENU key.

The menu is devided into the following sections:

e "Firmware"

e "Hardware Options"

e "Software Options"

e "WinlQSIM"

e "Loaded Modules"
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Software ¢ Options

Firmware =

Package Version
SMBWV100A FW | 02.05.142 beta (Release) (2008-06-18; 04:44:35)
R&S COMPASS |2.2.2.3 (Release)

Hardware Options

Option Designation

SMBW-B10 Baseband + ARB(32MS, 120 MHz RF BW)
SMBW-B55 ARB memory up to 256MS

SMBW-B30 Phase Coherence

SMBW-B32 Removable hard disc

SMBV-B106 9 kHz to 6 GHz

Software Options (Internal)

Option Designation Expiration Date | =

SMBW-KD Demo Option 2009-03-11; 16:00

SMBV-KZ22 Pulse Modulatar 2009-03-11; 16:00

SMBW-K23 Pulse Generator 2009-03-11; 16:00

SMBW-K40 Dig. Std. GSM/EDGE 2009-03-11; 16:00
Firmware

The Firmware section of the menu shows the firmware version and the version of the
software platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates as well as the Release Notes describing the improvements and modifications
are provided on the Internet at the download site of the Rohde & Schwarz Signal gener-
ator home page. This home page always offers the latest information on your signal gen-
erator, e.g. also on changes of the firmware update procedure.

SCPI command:
n.a.

Hardware Options / Software Options
The tables in the sections "Hardware", "Software" and "WinIQSIM2" list the installed
hardware and software options.

"Option" Short name of option
"Designation”  Name of Option

"Licenses" (optional)
Number of licenses.
SCPI command:
*OPT on page 435
*TIDN on page 434

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

SCPI command:
n.a.
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5.2.3.4 Manage License Keys

This dialog is the central dialog for managing licenses, like enabling newly purchased
and/or newly registered options or performing the required instrument related steps dur-
ing the process of unregistration and/or moving of licenses.

An option is ready to operate after it is enabled by means of a license key code supplied
with the option. The license key is delivered as a file or on paper. Unregistered licenses
must be registered for a particular instrument prior to the corresponding option can be
enabled for operation.

License Registration

If your purchased license is delivered unregistered, you must register it before you can
activate the option.

For detailed information about the license registration, refer to the installation instructions
provided with the option (Supplement A) and the documentation of the online tool "Man-
age Licenses" (https://extranet.rohde-schwarz.com/service).

update prior to enabling the software option may be required. The information on the valid

@ Only if the R&S Signal Generator is equipped with an older firmware version, a firmware
firmware versions for the purchased software option is provided together with the option.

The firmware update is described in the service manual, chapter 4 (on CD ROM, supplied
with the instrument).

Example: Moving a portable license
This example is intended to explain how to perform the required steps at the instrument.
Use an USB stick to transfer the license key files between the instrument and the browser.

We assume knowledge about the handling of the R&S License Manager online tool and
the description of the whole process.

1. Open your browser an go to https://extranet.rohde-schwarz.com/service.
Select "Manage Licenses > Move Portable License".

The first step requires the Device IDs of the source and target instruments.

2. To find out the Device IDs, proceed as follow:
a) On the source instrument, select "Setup > Manage License Keys > Device ID".
Manage License Keys ]
Device ID 1407 6004K02-100019-QJ

b) On the target instrument, select "Setup > Manage License Keys > Device ID".
c) Inthe browser, select "Manage Licenses > Move Portable License > Select Devi-
ces" and enter the Device IDs.

|
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3. On the source instrument, select "Setup > Manage License Keys > Installed License
Keys table", navigate to the portable license you want to move and click on the"Export
License to File" column, e.g. R&S SMBV-K40.

A standard file manager dialog opens. Enter a user specific file name and save the
exported license key, e.g. k40 portable key to move.xml.

Manage License Keys (] B4

Device 1D 1407 6004K02-100019-QJ

Enter License Key
Enter License Key

A drke ek ek gk Aok ke ek dek ek ek ek ek e e

Import License Key From File. .. Export Deactivation Response To File. .

———————— Export License Key —-—-—
license saved in file: fJusb/OCZ_RALLY2/k40 portable_key to_move xml

Installed License Keys

Show Inactive Licenses [ On Show Deactivated Licenses [~ On  Manage Waveform Packages... |
Export License Key To File Ciption g;s::e License Type _I

T=F T o Py i N VO T T L

250553920129911594643193851362... |SMBMV-KOD |1 Demo (8743 h left)
1311349976133004901336685762649. .. |SMBVK1E |1 Permanent
133605097212421365603543224296. .. |SMBVKAD 11 Eval (703 h left)
1
1

Wwioo|=~|cC

10 B16935683108546472532378594163. .. | SMBW-KA0 Portable

11 [058297333839630582283209843126... |SMBW-KE2 Eval (7 h left) -
R

4. In the browser, select "Manage Licenses > Move Portable License > Select License
(from file)" and select the exported license key.
Check the selection, create the deactivation key and save it to file.

5. On the source instrument, select "Setup > Manage License Keys > Import License
Keys from File" and select the transferred deactivation key.
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Manage License Keys =] B4

Device ID 1407 .6004K02-1000

Enter License Key
Enter License Key

Ak Aok Aok Ak dok ek ok ek ok ok ok Ak

Import License Key From File... Export Deactivation Response To File. ..

———————— Deactivate License Key -
319002309107738200602375045950: Key OK, Deactivation Response: 1237 D7 DF24467 EOCO
Restart of Firmware is required to activate the changes. Please Switch Off

Installed License Keys
Show Inactive Licenses [~ On Show Deactivated Licenses [~ On  Manage Waveform Packages. ..

License

Count License Type

Export License Key To File Ciption

162190812400289086821114062414... |SMBV-B1 1 Permanent
256241080019885671630377707062... [SMBV-B10 |1 Permanent
2637 15385426235537 164144016348, .. [SMBVBSS |1 Permanent
1
1

280490452042518705943607946625... |SMBWV-BS0 Permanent
153066661413861400200195555276... |SMBV-B32

Permanent

|| e | Ll | | =

6. On the source instrument, select "Manage License Keys > Export Deactivation
Response to File".
The instrument confirms the deactivation of the option. The deactivation key response
is exported under the selected name, e.g. K40 portable decat.txt.

Manage License Keys (] BN

Device ID 1407 .6004K02-100013-QJ

Enter License Key
Enter License Key

Ak dek deie ek ek e ek ek gk Aok ek ekt ek ek

Import License Key From File... Export Deactivation Response To File. ..

———————— Export Deactivation Response -
1237D7DF24467 EOOD
is written to file: fush/OCZ_RALLY2/k40_portable_deac.txt

Installed License Keys

Show Inactive Licenses [~ On Show Deactivated Licenses [~ On  Manage Waveform Packages. ..
. : . License | . =
Export License Key To File Option Count License Type

162150812400283086821114062414... |SMBV-B1 Permanent
25624108001588567 1630377707062... |SMBW-B10 Permanent

1

1
263715385426235537 164144016345, |SMBVBSS 1 Permanent

1

1

1

280490452042518705943607946625... |SMBW-B30 Permanent

153066661413861400200195555276. .. |SMBW-B32
170531 AEARIAR18305343A8AA63764  SMBALBING

Permanent

Darmanont

plon|esjwir]—

7. In the browser, go the step "Manage Licenses > Move Portable License > Install
Deactivation Key (from file)" and enter the deactivation response of the instrument.

The license is deactivated for the source instrument.
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8. In the "Manage Licenses > Move Portable License" go to step "Create License" to
generate a license key for this portable option and the selected target instrument.
Download the license key as a file and transfer it to the target instrument.

9. Inthetargetinstrument, select "Setup > Manage License Keys > Import License Keys
from File" and select the created license key file.

The portable option is installed on the target instrument.

Manage License Keys ] 4
Device ID 1407 .6004K02-100013-SN

Enter License Key
Enter License Key

Ak Aok dok dok dok dek Aok ok ok Wk ek ek Ak dk dk

Import License Key From File... Export Deactivation Response To File. ..

———————— Enter License Key —-—--—-
Restart of Firmware is required to activate the changes. Please Switch Off
license key of file /hdd/Licensekeyl SMBW-K18_1407 6004K02-100013. xml imported

Installed License Keys
Show Inactive Licenses [~ On Show Deactivated Licenses [~ On  Manage Waveform Packages. .. |
e License Type J
Count
7 |250553920129911594643193851362... | SMBV-KD 1 Demo (8743 h left)
8 |131134997Y6133004930133685782649. .. SMBV-K1EB 1 Permanent
9 |133605097212421365603543224296 . SMBV-KAD 1 Ewval (v03 h left)
10 B169356683108546472532378594163. . [SMBV-KAD 1 Paortable
1 1
| WS

Export License Key To File Option

(058297 333839630582283209843126. .. [SMBWV-KE2 Ewval (7 h left) -

Device ID
Displays the instrument specific identification number. The device ID is an unique string
with the following structure:

<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.

For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.

Use this function also to import the deactivation key file generated by the R&S License
Manager online tool (see example "Moving a portable license" on page 110).

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file management
dialog to save the file. This key is required during the unregistration process.

In case the unregistered option is a portable one, it can be afterwards registered at
another instrument (see example "Moving a portable license" on page 110).
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Status Information
Displays status information.

Show Inactive Licenses
Enables/disables the display of the inactive (expire) licenses in the License Table.

Show Deactivated Licenses
Enables/disables the display of the deactivated licenses in the License Table.

See example "Moving a portable license" on page 110 for information on how to activate
deactivated licenses.

Manage Waveform Packages
Opens the "Manages Waveform Packages" dialog.

& Manage Waveform Packages SMBY-K200 E| |E|Pg|

Fumber of Licenses/\Waveforms Total:d3 / Used:d2 [ Free:1 |
Select Waveform... | Mone
Waveform Registration Date Used License(s) =

ﬂdrive:Jpath!simulatedMuIliSegmentFilename_1?62.\w 2006-12-01 10:17:02 11
ﬂdrive:fpath!simulatedMuIliSegmentFilename_3545.\w 2009-07-31 10:07:26 |20
jdrive:a‘path.‘simulatedWa\refonnFilenameJ6964.'.w 2007-09-24 10:01:42 1
ﬂdrive:.fpath.isimulatedWavefcnnFilename_ii(l(l(]T.'.w 2011-06-08 08:31:38 1
ﬂdrive:.fpath.isimulatedMuIliSegmentFiIename_2838.wv 2011-02-19 07:40:26 7
ﬂdrive:Jpath!simulatedMuIliSegmentFilename_145??.\w 2011-04-23 08:27:31 2

The waveform packages licenses are provided for the registration of waveforms. This
kind of licences enables the instrument to play registered waveform file generated with
the software R&S WinlQSIM2 even if the instrument is not equipped with the corre-
sponding software option R&S Signal Generator-Kxy/-K2xy.

One waveform packages license per waveform is required. Once registered license can-
not be moved to another instrument.

Note: One waveform package licence per segment is required for the registration of a
multi segment waveform.

"Number of Displays the number of the available and used R&S Signal Generator-
Licenses/ K200 licenses.

Waveforms"

"Select Wave- Opens standard dialog to select the waveform to be registered.

form"

"License Gives an overview of the registered waveforms, the registration date
Table" and the number of used licenses.

License Table
Provides information about the currently installed options.

"Export Opens dialog to save the generated license key file. This file is required
License Key to during the unregistration process. In case the unregistered option is a
File" portable one, it can be afterwards registered at another instrument (see

example "Moving a portable license" on page 110).
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"Option" Displays the option short designation.
Tip: Open the "Setup > Software/Options" dialog to retrieve more infor-
mation about the installed options.

"License Displays the number of the licenses for the selected option key.
Count"

"License Type" Display the type of license.
A license type is a joint qualification for the duration of applicability and
the portability of a license. The following license types are provided:
evaluation, permanent, portable, quantified, timed with duration of 1, 3,
6 or 12 months. A license can also be in the states deactivated and
expired.
For time limited licenses, the left time of applicability is displayed too.

"Manage" Opens the "Waveform Packages License" dialog (see Manage Wave-
form Packages).

Gui Update
The "Start/Stop Gui Update" dialog provides the possibility to switch off update of the
displayed parameters in order to increase speed for certain settings.

The indicated values are not updated and may therefore differ from the intern, used val-
ues.

Gui Update

Gui Update is

Please, be aware:
If "Gui Update is OFF", the values of displayed parameters could differ from their internal, used values.
This mode is mainly provided to support unjittered signal output, fe. in fast sweep or list mode.

Changes in remote state changes the value of "Gui Update is" to ON.

On/Off GUI Update
Switchs on/off update of the displayed parameters.

Switching off the update of the displayed parameters increases the speed for certain
settings.

Note: It is especially recommended to switch off the GUI update for optimum sweep
performance with short dwell times and for fast settling times.

SCPI command:
:SYSTem:DISPlay:UPDate on page 712

NRP-Z Info/Update

In the "NRP-Z Info/Update..." dialog, the connected power sensors are indicated together
with their serial number, revision state and features. The software of a connected sensor
can be updated to a new version.

To access the "NRP-Z Info/Update..." dialog, select "System" and press the SETUP or
MENU key.

|
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NRP-Z Info / Update (]
Current Sensors

Sensor Type | Serial Number | Revision | Peak

Update

1- Mot Found jJ Run Update |

None  Select NRP File |

Current Sensors
Section "Current Sensors" lists the sensors that are connected to the generator and indi-
cates their serial number, the revision state and some features.

SCPI command:

SENSe<ch>[:POWer] : TYPE on page 492
SENSe<ch>[:POWer] : SVERsion on page 492
SENSe<ch>[:POWer] : SNUMber on page 491

Update

Section "Update" provides access to the file system in order to select a file for an R&S
NRP sensor update (Button "Select NRP File"), the selected file is indicated to the left of
the button. On the left side, the sensor to be updated is selected.

Button "Run Update" starts the update. If the update is interrupted for example by acci-
dently pulling off the sensor, selection "Rescue" is offered to restart the update process.
Prerequisite is that no other sensor is connected to the instrument.

The procedure is as follows:

e Do not reconnect the sensor but keep it ready to be connected
Select "Rescue" in the left sensor selection field

Activate "Run Update"

Confirm query in message box

Connect sensor within 4 seconds

The update starts, a bar informs about the progress.

SCPI command:
n.a.

Delete Temporary Files

To maintain sufficiant amount of free disc space on the internal flash memory, the R&S
Signal Generator provides a convenient way to delete the temporary files from the direc-
tory /var/smbv/unicod.

Delete Temporary Files lx]

Delete Temporary Files

Deletes all temporary files.

|
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Delete Temporary Files
Execute this function to delete the temporary files from the directory /var/smbv/unicod.

The content of this directory are temporary files such as the wavefiles (* . wv) of all ARB
standards. Deleting the temporary files maintains sufficiant amount of free disc space on
the internal flash memory.

Another way to achieve more free disc space on the internal flash memory is to execute
the "Factory Preset" function.

SCPI command:
:SYSTem:FILes:TEMPorary:DELete on page 712

Selftest

A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled. The protection dialog is called in
the "Setup" menu (see chapter 5.2.3.15, "Protection”, on page 127).

Testcase | Result | ;‘

The following tests are only available via remote control:
® :TEST<hw>:DIRect on page 719

5.2.3.9

Selftest

Performs a selftest on all installed hardware options.

A list of the performed tests cases and the result of each of them (passed or failed) is
displayed.

SCPI command:

:TEST<hw>:ALL:STARt on page 718

:TEST<hw>:ALL:RESult on page 719

Check Front Panel

The "Check Front Panel" dialog is used to check whether the front panel keys are func-
tioning correctly. The menu displays all the front panel keys arranged in the same way
as on the front panel. The respective function is executed by pressing the associated key.
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Check Front Panel: Please hit all keys. Press ESC to leave. = ES
Preset Freq Level File Diagram | Menu WinBar
Local RF Olo | Mod Ofo | Recalc. | ESC | Toggle | Rearr.
Setup

Hardcopy 7 8 9 G/n

Info 4 5 6 M/p Roll I. | Roll r.
Help 1 k/m

1] +/- *1 ‘WinBar Up I Rearr.

Insert Backsp. Enter Left Right

Hide Down I Close

Date and Time

The "Date/Time..." dialog provides access to the system time and date settings. Itis
opened using the SETUP or MENU key under "Environment". The time is used on the
internal controller.

Date / Time

|

Date [DD.MM.YYYY] 12.08.2011

Time [hh:mm:ss] I 16:23:43

To prevent accidental changes, "Date" and "Time" are protected functions. They can be
accessed with protection level 1, see chapter 5.2.3.15, "Protection”, on page 127.

5.2.3.11

Date
Indicates the date in the format day.month.year.

In order to prevent accidental changes, this parameter is protected. It can be accessed
with protection level 1, chapter 5.2.3.15, "Protection”, on page 127.

SCPI command:
:SYSTem:DATE on page 711

Time
Indicates the time in the format hour.minute.second

In order to prevent accidental changes, this parameter is protected. It can be accessed
with protection level 1, see chapter 5.2.3.15, "Protection”, on page 127.

SCPI command:
:SYSTem: TIME on page 717

Network Settings

The "Network Settings" dialog provides access to the network settings. To access this
dialog, press the SETUP or MENU key under "Environment". The R&S SMBV is equipped
with a network interface and can be connected to an Ethernet LAN (local area network).

|
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How to connect the signal generator to the network is described in chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 39.

Risk of network errors!

Connecting errors may affect the entire network.
We recommend to coordinate the connection of the instrument to the network with the
network administrator.

Do not connect or disconnect the network cable until the instrument is switched off
(standby). Only then the network connection can be reliably detected and impairments
to instrument operation can be avoided.

Network Settings ]

INetwork Status o) Connected I

Hostname |instrument

Workgroup | INSTRUMENT

Address Mode Auto (DHCP)
IP Address | 10.111.10.77
Subnet Mask | 25525500

Default Gateway I 10.111.0.1
Restart Network |

The dialog provides an access to the network settings, like settings about the general
network environment and specific identification of the computer in the network, as well
as an indication whether the instrument is connected to the network or not.

Network Status
Indicates whether the instrument is connected to the network or not.

SCPI command:
n.a.

Hostname

Enters the individual computer name of the R&S Signal Generator.

Note: The computer name can only be changed after protection level 1 is deactivated
(see chapter 5.2.3.15, "Protection”, on page 127).

A predefined name is indicated and can be used for network connections.

SCPI command:
:SYSTem:COMMunicate:NETWork [ :COMMon] : HOSTname on page 708

Workgroup
Enters the individual windows workgroup name of the R&S Signal Generator. This
parameter is necessary in case the instrument is integrated in a windows network.
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Note: The workgroup can only be changed after protection level 1 is deactivated (see
chapter 5.2.3.15, "Protection”, on page 127).

SCPI command:
:SYSTem:COMMunicate:NETWork [ :COMMon] : WORKgroup on page 708

Address Mode
Selects if the IP address is assigned automatically or manually.

"Auto (DHCP)" The IP address is assigned automatically.
The network used must support automatic assignment of IP address
via DHCP or APIPA (Zeroconf) in order to use this function.

"Static" The IP address is assigned manually.

SCPI command:
:SYSTem:COMMunicate :NETWork: IPADdress : MODE on page 708

IP Address
Displays the IP address. To enter the IP address manually, select "Static" Address Mode.

SCPI command:
:SYSTem:COMMunicate:NETWork: IPADdress on page 709

Subnet Mask
Displays the Subnet mask. To enter the Subnet mask manually, select "Static" Address
Mode.

This number is used together with the IP address to identify the network segment the
instrument is in.

SCPI command:
:SYSTem:COMMunicate :NETWork [: IPADdress] : SUBNet : MASK on page 709

Default Gateway
Displays the IP address of the default gateway. To enter the default gateway manually,
select "Static" Address Mode.

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

SCPI command:
:SYSTem:COMMunicate:NETWork [: IPADdress] : GATeway on page 709

Restart Network
Shuts down the network connection of the instrument and subsequently re-establishes
the connection.

This function can be used to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself is
not affected.

SCPI command:
n.a.
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5.2.3.12 Global Trigger/Clock/External Input Settings

The "Global Trigger/Clock/External Inputs" menu can be opened using the SETUP or
MENU key under the "Setup" menu as well as in all clock and trigger menus of the
"Baseband" function block.

This menu is used to determine the physical characteristics of the input connectors for
trigger, clock and control signals.

A common trigger threshold and input impedance is effective for all trigger and control
signal inputs. The settings influence the digital modulations, the generation of waveforms
or multicarrier signals, and all digital standards. These data sources are available for
digital modulation (Custom Digital Modulation).

The instrument trigger setting influences all sweeps and is effective in the List mode.

Global Trigyer/Clock/External Inputs =] 4

[Trveshold TiggerClock mput | 1.00]V ]|
Impedance Trigger Input Im
Impedance Clock Input IW
Baseband Trigger Input Slope IW;,
Instrument Trigger Input Slopelm
Clock Input Slope IW;,

Automatic Delay Compensation
State W On

Slave Position in Chain I 1

Cable Length /m | —

1| 0.50

Threshold Trigger/Clock Input

Sets the high/low threshold in volts for the trigger and clock signal inputs of the baseband
section.

The setting affects the TRIGGER input and the CLOCK IN/OUT connectors (BNC con-
nectors at the rear of the instrument).

SCPI command:
[ :SOURce] : INPut: TRIGger: LEVel on page 635

Impedance Trigger Input
Selects the input impedance for the external trigger inputs. 1 kOhm/GND should be

selected for high clock rates.
The setting affects the TRIGGER input connector (BNC connector at the rear of the
instrument).

SCPI command:
[ :SOURce] : INPut: TRIGger: IMPedance on page 635
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Impedance Clock Input
Selects the input impedance for the clock inputs. 1TkOhm/GND should be selected for
high clock rates.

The setting affects the CLOCK IN connector (BNC connector at the rear of the instru-
ment).

SCPI command:
[ :SOURce] : INPut :CLOCk: IMPedance on page 634

Baseband Trigger Input Slope
Selects the polarity of the active slope of an externally applied trigger signal.

This setting affects the INST TRIG input connector (BNC connector at the rear of the
instrument).

SCPI command:
[:SOURce] : INPut : TRIGger : BBANd : SLOPe on page 635

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

SCPI command:
[ :SOURce] : INPut : TRIGger : SLOPe on page 636

Clock Input Slope
Sets the polarity of the active slope of an externally applied symbol clock pulse.

This setting affects the CLOCK input (BNC connector).

SCPI command:
:CLOCk: INPut : SLOPe on page 459

Automatic Delay Compensation

While working in a master-slave mode, the instruments are connected as daisy chain
(see also chapter 5.8.2.4, "Synchronous Signal Generation", on page 277). The settings
for automatic delay compensation enable each of the slaves to calculate and compensate
the expected timing delay caused by the used cables. The calculation assumes an ordi-
nary BNC cables that have a dielectrics with a permittivity of €r = 2.7.
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Cable Length =1m Cable Length = 0.5m
= =
s L= — — S e —— — =
:| 2 I - | =
ol 8] Sy © o] g Sy ©
= 5 =
F4 R&S SMBEV = _|= R&S SMBV a & R&S SMBY
|Fe Ll 115 -
g Master E - Slave#i E »-|a Slave#2
RF RF RE
10 MHz Extemal Reference I |
'l' " .
omhine
T T T R
| Reference Fraguancy Source
‘ (e.g. R&S Spectrum Analyser] |
e_
"State" Enables the automatic compensation.

SCPI command:
[ :SOURce] : INPut:DELay:ADCState on page 636

"Slave Position Defines the position of the slave instrument in the daisy chain, where
in Chain" the slave directly connected to the master instrument is the one with
number 1, etc.

SCPI command:
[:SOURce] : INPut:DELay:SPOSition on page 636

"Cable Length" Sets the total length of the cable used to connect the CLK OUT and
CLK IN connectors. For the first slave in the chain, the value represents
the cable length between the master and the first slave; for the second
slave, the cable length to the first and to the second has to be defined,
etc.

SCPI command:
[:SOURce] : INPut:DELay: CLENgth<ch> on page 637

5.2.3.13 Display/Keyboard Settings

In the "Display/Keyboard Settings" menu the power-save mode and external keyboard
settings are made. It is opened using the SETUP or MENU key under "Environment".

Display/Keyhoard Settings (X
Display Settings
Screen Saver V¥ Active

Wait time |ﬁ| Min =]

Keyboard Settings
Layout English (US) =

Screen Saver Active
Activates/deactivates the screen-save mode of the display.
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If activated, the display including backlight is completely switched off after the elapse of
the "Wait Time" when no entries via front panel, external mouse or external keyboard are
made.

This mode is recommended for preserving the display especially if the instrument is
exclusively operated via remote control.

SCPI command:
:DISPlay:PSAVe[:STATe] on page 463

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no entries
are made.

SCPI command:
:DISPlay:PSAVe:HOLDof f on page 463

Layout (Keyboard)
Selects the keyboard layout for the selected keyboard language.

The assignment of some keys depends on the selected layout and language.

SCPI command:
:KBOard:LAYout on page 472
:KBOard:LANGuage on page 472

Remote Channel Settings
The "Remote Channel Settings" dialog provides access to the settings for remote control.
The dialog is opened using the SETUP or MENU key under "Remote".

Besides the standard GPIB-setting, the selection of one of the possible emulations and
a user defined definition of the * IDN and *OPT string is possible.
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Remote Channel Settings o] B4
ILanguage SCPI j =
*DN2/*OPT? Identification——F 2%k i 2]
AF2023 —
AF2024
Mode e
IDM String

Rohde&Schwarz, SMBW100A,1407 6004k02/100010 2.2.2.3-0

Ll

OPT String

SMBV-B1, SMBV-B51, SMBV-B55, SMBV-BI0,
SMBV-B106, SMBWV-KD, SMBV-K22, SMBV-K23,

GPIB channel address
RS232 using USB adapter
Baud rate 115200 =

Parity None =

el

Stop bits

Visa Resource Strings
HISLIP |TCPIP::10.111.10.T?::hislip[]::INSTR

WEI ITCF'IF'ZZ1 D111 A0 TFTIINSTR

GFIB IGPIEIZZZBZZINSTR

UsB IUSEI::UKUMD::UXUUSF—:ﬂ 00010:IMNSTR

SERIALIASRL‘] ZMSTR

Local | =i

Language

Selects the instrument whose remote command set is emulated by the R&S SMBV.
The R&S SMBYV can also be remote controlled via the command set of several other
generators, e.g. of an HP generator. You find the available command sets for the gen-
erator in the selection list. This feature allows to replace a generator by an R&S SMBV
in existing test setups. Refer to the corresponding Application Note at the download area
of the product site on the Internet. The Application Note is also provided on the user
documentation CD-ROM (included in delivery).

The selected instrument also defines the identification string that is retrieved with query
*IDN?. If required, use the parameter "Mode" and "IDN String" to change this string.

As any other parameter, the remote control command set can also be changed remotely
by means of the SCPI command SYST : LANG. However, this remote control command is
enabled only in the instrument's specific SCPI command set, i.e. it is possible to change
the command set remotely from the original one (SYST: LANG SCPI) to the command
set to be emulated but not vice versa.

Note: While working in a emulation mode, the R&S SMBYV specific command set is dis-
abled, i.e. the SCPI command sYsST : LANG will be discarded.

To return to the SCPI command set of the R&S SMBV, use the appropriate command of
the selected command set. If for example a HP generator is emulated, the HP command
EX returns to the instrument-specific GPIB command set.

SCPI command:
:SYSTem: LANGuage on page 715

|
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Identification Mode
Selects the way the instrument identification is performed.

"Automatic" The "IDN String" and the "OPT String" are set automatically for the
instrument select with the parameter "Language”.

"User Defined" Enables the selection of user definable "IDN String" and "OPT String"
for the instrument selected with the parameter "Language".

SCPI command:
:SYSTem: IDENtification on page 714

Set to default
Overwrites the user-defined *IDN and *OPT strings with default strings.

The default strings vary depending on the selected emulation mode (Language)

SCPI command:
n.a.

IDN String
Indicates the identification string of the instrument when queried with the common com-
mand *IDN?.

In addition to the preset values, a user defined identification string can be entered, e.g.
to provide individual identification for each generator, like 'MY_R&S SMBV' for instance.

SCPI command:
*IDN?

OPT String
Indicates the option string of the instrument as queried with common command *0OPT?>.

If a "User Defined" Identification Mode is selected, a user defined option string can be
created, additionally to the automatically created one.

SCPI command:
*OPT?

GPIB channel address
Sets the GPIB address of the instrument.

SCPI command:
:SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 707

RS232 using USB adapter
Requires a USB serial adapter (recommended extra, see data sheet)

Sets the parameters of the serial interface.

Either a RS232 interface or a Bluetooth connection can be used for remote control via
the serial interface. The settings are effective for both interfaces (see also chap-

ter 5.2.3.16, "Security", on page 128).

SCPI command:

:SYSTem:COMMunicate: SERial : BAUD on page 710
:SYSTem:COMMunicate:SERial:PARity on page 711
:SYSTem:COMMunicate:SERial:SBITs on page 711
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Visa Resource Strings
Indicates the visa resource strings, used for remote control of the instrument. A separate
string is provided for remote control via the different interfaces.

SCPI command:
:SYSTem:COMMunicate:HISLip:RESource on page 707
:SYSTem:COMMunicate:NETWork:RESource on page 709
:SYSTem:COMMunicate:SOCKet:RESource on page 711
:SYSTem:COMMunicate:GPIB:RESource on page 710
:SYSTem:COMMunicate:USB:RESource on page 710
:SYSTem:COMMunicate:SERial :RESource on page 710

Local (Remote Channel Settings)
Switches the instrument to operate in local control mode.

Switching from remote to local control mode can be also done with one of the following
actions:

e manually with the LOCAL key on the front panel

e with the interface command &GTL via the remote-control interface

e with the key combination CTRL + Q.

SCPI command:
&GTL

Protection

This "Protection” dialog provides access to the unlocking of different protection levels.
To open this dialog, use the SETUP or MENU key under "Protection".

After the instrument has been switched on, the protection levels 1 to 5 are automatically
activated. To deactivate the protection, the correct password has to be entered. With the
corresponding check boxes, you can activate the protection again.

Protection

Protection Level 1 W On IPasswordI I

Protection Level 2 W On Passwaord

Protection Level 3 W Cn Passwordl it
Protection Level 4 W Cn Passwaord I ———
Protection Level &5 W Cn  Password I -

The following functions are protected in the rerspective levels:

e Protection Level 1
protects against accidental changes to certain settings, such as clock and date, net-
work settings or instrument names,etc. This level is accessible to the user.

e Protection Level 2
provides access to the unlocking of protected service functions. It is accessible to
authorized personnel of R&S Service Departments only.

e Protection Level 3-5
are reserved for factory internal use.
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Protection Level/Password
Protection Level 1 can be activated to expand the functionality of the internal adjustment
and to access the selftests.

The password is 123456.

SCPI command:
:SYSTem: PROTect<ch>[:STATe] on page 716

5.2.3.16 Security

The "Security" dialog provides access to the passwords and mass storage security set-
tings. To open this menu, use the SETUP or MENU key under "Protection".

The menu is divided into the password sections and the security settings section. In the
password section, the passwords for securing a controlled access to the instrument are
defined and changed.

A change of passwords for the operating system and security password requires the entry
of the old and new password and the conformation of the new password. All settings are
only accepted after the "Change Password" button is pressed.

-

Change User Password——— =
valid for VNC FTP and SAMBA access
User Name |instrument

COld Password |

MNew Password |

Confirm Passwordl

Change Password |

Change Security Password
Old Password |

New Password |

Confirm Password |

Change Password |

Security Settings
USB Device Enable -

Lan Connections Enable »
Annotation Frequency Enable =
Annotation Amplitude Enable -

Display Enable -

HHREER

Keyboard Enable -

Security Password |

Accept |

Bluetooth
Bluetooth Pin

-

[«]
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User Name
Indicates the user name used for access to the Linux operating system and valid for VNC,
FTP and SAMBA access.

The user name and password are required for remote access to the instrument via VNC,
FTP or SAMBA.

SCPI command:
n.a.

Old Password (User Password)
Enters the currently used user password. The default password is "instrument".

Note: Itis highly recommended to change the default user password before connecting
the instrument to the network.

New Password (User Password)
Enters the new security password.

The security password may contain decimal characters only.

SCPI command:
n.a.

Confirm Password (User Password)
Enters the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

SCPI command:
n.a.

Change Password (User Password)
Changes the password accordingly.

SCPI command:
n.a.

Old Password (Security Password)
Enters the currently used security password. The default password is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.

The security password is required when changing the status of the USB and LAN inter-
face.

SCPI command:
n.a.

New Password (Security Password)
Enters the new security password.

The security password may contain decimal characters only.

SCPI command:
n.a.
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Confirm Password (Security Password)
Enters the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

SCPI command:
n.a.

Change Password (Security Password)
Changes the password accordingly.

SCPI command:
n.a.

USB Device
Enables/disables the USB interfaces.

The instrument does not recognize any device connected to the USB interface when the
interface is disabled.

The setting requires the entry of the security password and is only accepted after the
"Accept” button is pressed.

SCPI command:
n.a.

LAN Connection
Enables/disables the LAN interface.

It is not possible to access the instrument via LAN while the LAN connection is disabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
n.a.

Annotation Frequency
Enables/disables the display of the currently used frequency in the header of the instru-
ment.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
:DISPlay:ANNotation:FREQuency on page 462

Annotation Amplitude
Enables/disables the display of the currently selected level in the header of the instru-
ment.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
:DISPlay:ANNotation:AMPLitude on page 461

Display
Enables/disables the display.
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If this parameter is disabled, the instrument cannot be operated manually via the user
interface, i.e. display, front panel keys and external keyboard are disabled. Remote con-
trol of the insrument is enabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
:SYSTem:DLOCk on page 712

Keyboard
Enables/disables an external keyboard and mouse connected to the instrument, the front
pannel keys of the instrument, the rotary knob and the on-screen keyboard.

If this parameter is disabled, the instrument cannot be manually controlled but changes
in the settings are shown on the display. Remote access and remote control are enabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

To enable the keyboard, type the security password on the external keyboard or use the
SYST:KLOC OFF command over remote control.

SCPI command:
:SYSTem:KLOCk on page 715

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.
All settings are only accepted after the "Accept" button is pressed.

SCPI command:
n.a.

Accept - Security
Accepts a new entry or selection and changes the settings accordingly.

SCPI command:
n.a.

Bluetooth Pin
Requires a USB Bluetooth adapter (recommended extra, see data sheet).

Enters the Bluetooth pin of an external Bluetooth device. The pin is required to enable
remote control via an external Bluetooth device.

The interface parameters are identical to the RS232 interface parameters and can be set
in the "Remote Channel Settings" dialog (see "RS232 using USB

adapter" on page 126).

SCPI command:

n.a.
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5.2.3.17 Savel/Recall
The "Save/Recall" submenu can also be called up with the FILE key and is therefore

described in the section of this key (see chapter 5.2.8, "Storing and Loading Instrument
Data - File Key", on page 138).

5.2.3.18 Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to their
factory state. This function is activated by pressing the "Execute Factory Preset" button.

Factory Preset

Execute Factory Preset

Resets instrument to factory configuration.
Security settings and user data are not effected.

Factory Preset
Reset the instrument's settings to their factory state.

Note: Since Factory Preset resets the Remote Channel and network settings to the
default values, executing Factory Preset via remote control terminates the connection to
the instrument, if these settings had been configured to values different to the default
ones!

The factory preset function resets nearly all instrument settings. In addition to the regular
preset by means of the PRESET key, a "Factory Preset" resets also the following values:
e Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings including hostname ("Setup" menu)

Remote Channel settings including GPIB address ("Setup" menu)

Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings files,
created for example by means of the Save/Recall function.

SCPI command:
:SYSTem: FPReset on page 438

52.3.19 Help

The "Help" dialog offers comprehensive online help for the R&S Signal Generator. A
desired topic can be selected via the table of contents (select "Manual") or the index
(select "Index").

For context-sensitive information about a marked parameter, press the HELP key. For a
description of the "Help" menu, refer to the section covering to the HELP key (see chap-
ter 5.2.7, "Help System - Help Key", on page 137).
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5.2.5
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Switching to Manual Control - Local Key

In remote control mode a status message appears in the display header. The rest of the
display remains unchanged and shows the current instrument status, i.e. the status which
exists under the remote control settings. The instrument can be operated (e.g. menus
can be opened). However, it is not possible to enter or change values.

Frea 8 | 1.000 000 000 00 |orz - Pep 8| -30.00
| Az ALC-Auto | B: ALC-Auto

tdarksg S .
N & Custom Dig. Mod. A E||E|E|

usB Setto Default |

config...

} SavefRecall User._.. |
Trig In 1 on

Data Source
Data Source |PRBS J

The status message additionally indicates whether the LOCAL key is disabled or enabled.

See also chapter 6.2.1, "Switching to Remote Control", on page 400.

If the "REMOTE" status message is shown, the LOCAL key switches the instrument from
remote control to manual control. The current command must be fully processed before
the mode is switched, otherwise the instrument switches immediately back to remote
control.

If the "REM-LLO" status message is displayed, the instrument can be switched from
remote control to manual control by means of remote control only (e.g. with the Visual
Basic command CALL IBLOC (generator%));the LOCAL key is disabled. The key is

disabled by remote control with the command LLO.

When switching from remote to manual control, the display update suppression function,
if active ("SETUP > GUI Update" is Off), is automatically deactivated ("SETUP > GUI
Update" is On).

Generating a Hard Copy of the Display

The HCOPY key opens a window for configuring the hardcopy setting, like output file
format, path and file name.

Hardcopy

|Destination | File Ba| worpo B euos)
F - |
ormat BMP ZEI {
Automatic Naming ¥ = —
: = &

I fusb/smbv20080613000. bmp

Save |
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Hardcopy Dialog

Destination
Indicates that the hardcopy is stored in a file (see also "File Options" on page 135).

SCPI command:
:HCOPy:DEVice on page 466

Options

Opens the Hardcopy Options dialog for configuring the hardcopy parameters (see "File
Options" on page 135.

SCPI command:

n.a.

File
Some configuration parameters are already offered in the Hardcopy dialog. All configu-
ration parameters are available in "File Options" on page 135.

Automatic Naming
Activates, deactivates automatic generation of the file name. Automatic naming is con-
figured in the "Options..." submenu, see "File Options" on page 135.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO: STATe on page 471

File Info

Indicates the file name. The file name can be entered either manually via the file manager
(button "File...") or generated automatically (Automatic naming checkbox). Automatic
naming is configured in the "Options..." submenu.

SCPI command:
:HCOPy:FILE[ :NAME] on page 467
:HCOPy:FILE[:NAME] : AUTO: FILE on page 468

Hardcopy Options

This section describes the "Hardcopy Options" dialog.
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Hard Copy Options ] EJ
Image
Format| BMP =| Size[6407480 +|

Automatic Naming
Automatic Naming ¥ On

Path... | | fushisdat
Delete All Image Files In Path  Clear Path |

Prefix ¥ On lsgl
Year W On Month¥ On Day M On

Current Auto Number 000

Resulting File Name Ism...bmp

File Options
Dialog for setting the file parameters.

"Size" Defines the size of the bitmap in terms of pixels. The first value of the
size setting defines the width, the second value the height of the image.

SCPI command:
:HCOPy: IMAGe: SIZE on page 471

"Format" Selects the image format. Several bitmap formats are available.

SCPI command:
:HCOPy:DEVice:LANGuage on page 466

"Automatic Determines the rules to create the file names and sets the directory the
Naming" files are saved into.
As default the automatically generated file name is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>
Each component can be deactivated/activated separately to individu-
ally design the file name. The resulting file name is indicated.

"Path..." Opens the "Select Hard Copy Destination Path" dialog to select a path
for storing the hardcopy.

Note: For selecting the destination path a file name must be entered
as well. Otherwise the error message "The name of a list may not be
empty" is displayed and the selection will be canceled.

Directory, path and file name are displayed in the infoline right to the
"Path" button.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory on page 467
:HCOPy:FILE[:NAME] : AUTO on page 467

"Clear Path" Deletes all image files with extensions bmp, img, png, xpm and csv in
the directory set for automatic naming.
Before deleting the image files a warning message is displayed requir-
ing the confirmation.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory:CLEar on page 468
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"Prefix" Activates the usage of the prefix in the automatic file name. The prefix
is entered in the field to the right of checkbox.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix: STATe on page 470

"Enter prefix" Enters the prefix for the automatically generated file name. The use of
the prefix is activated in the checkbox to the left.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix on page 470

"Date - Year/  Defines the components of the automatically generated file name. The
Month / Day" selectable parameters are year, month and day. If activated the current
year, month or day used in the file name.

SCPI command:

:HCOPy:FILE[:NAME] : AUTO[:FILE] : YEAR: STATe on page 470
:HCOPy:FILE[:NAME] :AUTO[:FILE] :MONTh:STATe on page 469
:HCOPy:FILE[:NAME] : AUTO[:FILE] : DAY : STATe on page 469

"Current Auto  Indicates the number which is used in the automatically generated file
Number" name.

Note: On initially switching on the device the number will be reset to
the lowest possible value. Starting with number 0 the output directory
will be scanned for already existing files. As long as files with the same
name are existing the number will be increased by 1. The number will
be automatically set to a number so that the resulting file name will be
unique within the selected path. The current number will not be saved
in the save recall file but will be temporarily stored within the database.
On subsequent saves the number will be increased.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO[ : FILE] : NUMBer on page 469

"Resulting File Indicates the automatically generated file name.
Name"

SCPI command:
:HCOPy:FILE[:NAME] : AUTO: FILE on page 468

Save
Triggers the generation of a hardcopy.

SCPI command:
:HCOPy [ :EXECute] on page 466

5.2.6 Messages - Info Key

The INFO key opens a window containing a detailed description of every message dis-
played in the info bar, see chapter 4.2.3, "Info Window", on page 70 and chapter 9, "Error
Messages", on page 727.
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5.2.7 Help System - Help Key

The HELP key opens a browser window containing a context-sensitive description of the
highlighted parameter.

5 Help - State - Digital Modulation

"S] Digital Modulation - Custod § - Operating the R&S Vector Signal Generator > Instrument Function > Baseband Signal -
 Overview and Required Q | Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
+ (3 Modulation Types - Cul | Interface > General Settings > State - Digital Modulation
+- (3 Coding - Custom Digit
+-(3) Baseband Filter - Cust
i~ Conflicting Settings - Cug
=) Custom Digital Mod U
* 3] General Settings | | Enablas/disables digital modulation.

(8 State - Digital Mod

Set To Default - Di| | Switching on digital modulation turns off all the other digital standards.

State - Digital Medulation

i SavelRecall - Digit
+-[, Data Source
+ ﬁl Standard, Symbol | | The digital modulation is generated in realtime (no precalculated signal). and therefore all

In case of two-path instruments, this affects the same path.

- ﬂ Modulation parameter changes (in the ON state) directly affect the output signal.
+-[3 Modulation - CW §

+|31 e SCPI command:

L3, Power Ramp [:S50URce<hw>] :BB:DM: STATe

+ ﬁl List Management
+-( Data List Editor

+ ﬁ[ Control and Marke| Top
+-[ Power Ramp Cont
- ﬂ TriggeriMarkeriCl

4 il I »

GoTolndex | fna | Back | scrolitert | scroimiont | zoomm |  zoomout |

The context-sensitive page which is opened with the HELP key is part of a comprehensive
help system. It is possible to move from this context-sensitive page to any page of the
help system. The following navigation aids are available:

e |Internal links in the text
They open pages which are directly linked to the described function. In this way it is
possible, for example, to call up the description of the GPIB command for any par-
ticular function.

e Previous/Next links
The Previous/Next links allow scroll through the help pages. The sequence of the
described functions corresponds to their position in the menus.

e Back button
The Back button calls up the page last viewed.

e Contents in the navigation panel
The contents list is used to open the individual help pages. It has a hierarchical struc-
ture. The highlighted line indicates where the currently displayed page is within the
contents list.

e [ndex in the navigation panel
The index is used to call up all pages which contain the selected entry. The index has
an alphabetical structure and also contains all GPIB commands.

e Find
The find function allows you to look for freely selectable terms in all help pages. A list
of the pages containing the entered term is displayed as the search result. The search
can be limited to words in the page title to increase the number of hits.
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5.2.8 Storing and Loading Instrument Data - File Key

The R&S SMBYV allows complete instrument settings to be stored in files on the internal
flash memory, the USB stick or on the hard disk (requires option R&S SMBV-B92).

Defined and complex instrument settings can then be reproduced at any time by loading
this data. If required, these settings can be loaded to various signal generators.

The corresponding menu is available under "Save/Recall" in the "Setup"” menu or acces-
sible by means of the FILE key. The instrument settings are saved in files which can be
stored in data directories.

Additionally there are intermediate memories in which the current instrument setting can
be stored and then called up again by just pressing a key. This provides fast switching
between different instrument settings.

Only settings which differ from the preset values and configuration data for the operating
elements (e.g. window positions) are stored. As a result the files remain relatively small.
Furthermore, instrument settings can easily be transferred between different equipped
signal generators since the files contain only relevant information. When loaded, the ref-
erenced settings are implemented and all non-referenced parameters are set to the
associated preset values.

If list data is part of the instrument settings, e.g. a list of user correction data, a reference
to this list is stored, not the list itself. The list is reactivated when the associated settings
are loaded, but the list may have been modified or deleted in the meantime or may not

be available on a different instrument. If the list has been modified, the new entries will

be used. An error message appears if an attempt is made to access a non-existing list

or to activate settings which are not supported by the instrument.

@ o Network settings and remote settings are not saved and restored.
e Lists are stored and loaded in the appropriate menus. For example, the user correc-

tion data list is created and stored in the "User Correction" menu.

When loading an instrument setting, it is possible to select whether the current frequency
and level setting is to be retained or whether the stored settings are to be activated. It is
possible to delete stored instrument settings. A file can be copied by loading it with
"Recall" and then storing it under a new name.

Settings can be transferred easily between instruments with different equipment options
and/or firmware versions because only the settings which differ from the preset values
are affected. When settings are loaded, only those which are possible on the instrument
are implemented. Error messages indicate the settings which cannot be implemented.

The stored file is transferred from one instrument to another using the memory stick.

General file management functions such as copying and moving data are available in the
"File Manager" dialog.
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5.2.8.1 File Menu

The settings available in the File menu "Save/Recall" depend on the operation selected
under "Select Operation".

Select Operation Save ¥

For more information, see chapter 4.7.1, "File Select Dialog", on page 93.

Select Operation
Selects the file function.

"Save..." Calls the menu for storing the current instrument setting (see chap-
ter 5.2.8.2, "Storing Instrument Settings", on page 139).

"Recall..." Calls the menu for calling up a stored instrument setting (see chap-
ter 5.2.8.3, "Loading Instrument Settings", on page 141).

5.2.8.2 Storing Instrument Settings

If "Save" is selected under "Select Operation”, the File menu provides options for storing
the current instrument setting in a file.

Save/Recall ] 5
Select Operation ISave vl
Nar!s_mbv!ListsfSachl
3, RfboSynRefCalData =
-- Tdscdma —
-3 WiMAX -
File Name:
presetsettings I
Save Save Save Save File
Imm 1 Imm 2 Imm 3 Manager...
Recent files

Displays the files last used.

SCPI command:
n.a.

Directory
Selects the directory in which the file is to be stored.

The window opposite lists all settings files in this directory.
A new directory can be created in the "File Manager" dialog.

SCPI command:
:MMEMory:CDIRectory on page 478

File List
Displays the files which are in the selected directory.
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If a file is highlighted, it is overwritten when the file is stored.

SCPI command:
:MMEMory:CATalog on page 477

File Name
Enter the file name of the file without file extension. This file is then created.

SCPI command:
n.a.

Save
Stores the current instrument settings under the specified path.

SCPI command:
*SAV on page 436
:MMEMory: STORe: STATe on page 482

Fast Save
Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

However, in some test setups, e.g while analyzing the generated WiMAX signal with R&S
FSQ, it is required to disable the fast save option.

Note: This function is not affected by the Preset function.

SCPI command:

[ :SOURce<hw>] :BB:DM:SETTing:STORe: FAST on page 582

Refer to the descriptions of the firmware options for the correct syntx of the corresponding
SCPI command.

Save Immediate x
Stores the current instrument setting in one of the three intermediate memories.

These instrument settings are retained until a different instrument setting is stored in the
intermediate memory. When the instrument is switched off, the contents of the inter-
mediate memories are retained.

SCPI command:
*SAV on page 436

File Manager
Calls the "File Management" menu.

Directories can be created and files managed in this menu (see chapter 5.2.8.4, "File
Manager", on page 142).

SCPI command:
n.a.
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5.2.8.3 Loading Instrument Settings

If "Recall" is selected under "Select Operation”, the "File" menu provides options for
loading complete instrument settings. Here it is possible to select whether the current or
stored frequency and level settings are to be used.

Save/Recall = B
Select Operation IRecaII vl

fvar/smbv/Lists/SavRel
L G] SavRel ;I

“{ presetsettings

N a Tdscdma . ]
a0 wimax 2
Exclude Frequency ™ Exclude Levell™ l

Recall Recall Recall Recall File
Imm 1 Imm 2 Imm 3 Manager...

Recent data sets
Displays the files last used. The entire path is shown.

If the desired file is in the list, it can be selected.

SCPI command:
n.a.

Directory
Enter the directory in which the file with the instrument setting to be loaded is located.

The "Selected file" window lists all the files in this directory.

SCPI command:
:MMEMory:CDIRectory on page 478

File List
Selects the file with the desired instrument configuration.

SCPI command:
:MMEMory:CATalog on page 477

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.

SCPI command:
[ :SOURce<hw>] : FREQuency [:CW| : FIXed] : RCL on page 628

Exclude Level
The current level is retained when a stored instrument setting is loaded.

SCPI command:
[ :SOURce<hw>] :POWer [:LEVel] [ : IMMediate] : RCL on page 677

Recall
Load the selected configuration.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.
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If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

SCPI command:
:MMEMory: LOAD: STATe on page 481
*RCL on page 436

Recall Immediate x
Loads the selected configuration from one of the three intermediate memories.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

A message appears if no instrument configuration is stored in this memory.

SCPI command:
*RCTL on page 436

File Manager

The "File Manager" dialog provides all the functions required for file management. Direc-
tories can be created, and files copied, deleted and moved between the directories on
the drives (internal flash card, memory stick and hard disk (requires option R&S SMBV-
B92)).

File Manager ]
File Type IInstrument State (*.savrcltxt) j

Lata -

“{ presetsettings. savrcixt

- w3 Tdscdma -
LR winay =
Cut Copy Paste Rename Delete C[r}e_ate MNew
irectory

For more information, see chapter 4.7.2, "File Manager", on page 94.

File Type
Selects the file types to be indicated. If a file type with a specific file extension is selected
only files with this extension are indicated in the selected directory.

SCPI command:
n.a.
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Directory and File Name

Selects the directory in which the file to be deleted or copied is located. The window lists
all files in this directory. The file to be deleted or copied can be highlighted. The path is
indicated above the directory window.

SCPI command:
:MMEMory:CDIRectory on page 478

Cut
Cuts the selected file. It can be pasted into a different directory using the "Paste" button.

SCPI command:
:MMEMory:DELete on page 480

Copy

Copies the selected file. It can be pasted into a different or the same directory using the
"Paste" button. When pasting the file into the same directory file name Copy of <file
name> is given automatically. When pasting the file into a different directory, the original
file name is kept.

SCPI command:
:MMEMory : COPY on page 478

Paste
Pastes the file that has been copied or cut before.

SCPI command:
n.a.

Rename
Renames the selected file or directory. The new name can be entered in the "New File-
name" dialog.

SCPI command:
:MMEMory : MOVE on page 481

Delete
Deletes the selected file. Before the file is deleted, a message appears prompting the
user to confirm deletion of the file.

SCPI command:
:MMEMory : DELete on page 480

Create New Directory
Creates a new directory. The name of the new directory can be entered in the "New
Directory" dialog.

Note: When the subdirectory is entered, it is possible to enter an absolute path name
(e.g. /var/smbvUSER/MEAS) or the path relative to the current directory (e.g. . ./
MEAS).

The directory is created as a subdirectory in the selected level.

SCPI command:
:MMEMory :MDIRectory on page 481

|
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5.3 Graphical Display - Graphics

The R&S Signal Generator can be used to graphically display the generated baseband
signal. A selection of different signal displays assists the user in assessing and checking
the increasingly complex modulation signals.

Iv|

The Graphics function block is available for instruments with the option:

e R&S SMBV-B10/B50/B511 (Baseband + ARB)
o R&S SMBV-B62 (Noise Generator)

It is the baseband signal actually generated that is recorded and displayed, and not a
signal calculated on the basis of the set parameters.

This graphical display allows the user to quickly view and check the current signal char-
acteristics and also gives an overview of the changes in the signal over time. The signal
quality can be permanently monitored. The results of parameter changes on the signal,
such as a change in modulation mode, or the effects of certain configurations, e.g. the
activation of several base stations in the case of (W)CDMA signals, can be analyzed
directly in the display. Freezing the signal and then zooming permit a detailed evaluation
of any signal segment. The definition and display of one or more reference curves makes
it possible to compare various signals (i.e. by comparing the CCDF (Complementary
Cumulative Distribution Function) with different channelization codes, or the spectra if
different filter parameters are selected).

The displayed signal segment can be influenced by selecting the trigger that defines the
time for recording to start. With automatic triggering, the signal is tapped at the point in
the signal path that is best for the respective display. The displayed signal segment is
selected internally depending on the signal such that the signal characteristics of interest
(e.g. the useful signal) are displayed. This selection is appropriate for a representative
display of the complete signal.

In addition, a user-definable trigger is available with which the displayed signal segment
can be limited.

The time resolution can be set either automatically or manually, whereby for manual
setting the bandwidth for which the trace is to be displayed is selected. The transient
recorders used for signal recording have a variable recording depth which is specified
under the respective display.

In addition to the large graphics window, the display can also be shown in a small window
("smart graphics"). This window is fitted into the block diagram as a block, and can be
used for basic checking purposes (e.g. whether the signal is still being generated).
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5.3.1 Graphics Settings Menu

The "Graphics Settings" menu for selecting the graphical display of the output signal is
opened either in the "Graphics" function block or in the menu with the same name which
is opened using the MENU key.

The signal display can be selected and activated in the menu.

With two-path instruments, the settings for the two paths can be entered separately. The
signals can be displayed simultaneously in two separate windows.

Graphics Settings
Path A
State
Smart Graphics
Mode =
Trigger Source | Software j
Sample Rate Mode |Aut0 |
Sample rate | 1.1 |5'E J

State
Activates the selected graphical display.

After activation, the diagram selected with "Mode" is displayed in the block diagram.

At the bottom of each graphics window there are several buttons for freezing and zooming
the display and for activating a reference curve.

For more information, see chapter 5.3.2, "Bar of Graphics Window", on page 147.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:STATe on page 585

Smart Graphics
Activates the "smart graphics".

The graphic is displayed in a small window which is roughly the size of a block. These
windows are displayed permanently in the block diagram until they are deactivated, and
allow basic checking of the signal. They do not contain any buttons.

|
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SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:SMARt : STATe on page 584

Mode
Selects the graphical signal display. The display is not shown until it has been activated
with "Status On".

The individual signal displays are described in the chapter 5.3.3, "Signal Dis-
plays", on page 150.

SCPI command:
[ : SOURce<hw>] :BB:GRAPhics :MODE on page 584

Trigger Source
Defines the trigger for the starting time of the graphic recording.

"Software" Recording of signals is started automatically in specified intervals.
This asynchronous method is appropriate when a representative dis-
play of the complete signal is desired, as recording starts in a random
time reference to the signal.

"Marker 1" The starting point for recording signals is determined by marker 1 in the
menu of the active standard.
This synchronous method is appropriate when specific signal segments
are to be shown in greater detail. With periodic signals, a static image
is obtained by selecting a period length of marker 1 that is equal to the
signal period.
The displayed signal segment can be shifted as needed by entering a
marker delay in the Trigger/Marker menu of the active standard.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:TRIGger : SOURce on page 586

Scrambling Code
(only if Code Domain (3GPP FDD DL) is selected)

Sets the scrambling code if the "Code Domain" display is selected. Since it is possible to
select a different scrambling code in the menu for each of the 4 base stations and it is
also possible to display an external signal, the scrambling code for which the display is
to be generated must be explicitly specified here.

SCPI command:
n.a.

Sample Rate Mode

Sets how the time resolution of the signal is determined. Maximum resolution corre-
sponds to a display covering the entire signal bandwidth. The higher the resolution is, the
shorter the length of the displayed signal segment will be for the specified recording
depth.
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"Auto" The resolution is set to an optimum value on the basis of the signal and
display type.

"Full Band- The resolution is set such that the display covers the entire signal band-

width" width.

"User" Under "Graphics Sample Rate", the user can determine the resolution

by setting the signal bandwidth for which the display is to be generated.

SCPI command:
[ : SOURce<hw>] :BB:GRAPhics:SRATe :MODE on page 584

Graphics Sample Rate
With "Auto" and "Full Bandwidth":

Displays the signal bandwidth for which the display is to be generated.
With "User™:

Selects the signal bandwidth for which the display is to be generated. The setting range
moves between the minimum and maximum bandwidth which is possible for the selected
display. The selection is made graphically by moving the pointer.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:SRATe:USER on page 585

Bar of Graphics Window

At the bottom of each graphics window there are buttons for freezing and zooming the
display and for defining and activating a reference curve.

Run Zoom | Time

Show Copy
out

ref to ref

Run
Freezes the current display.

Clicking the button again reactivates the normal, permanently updated display.

Freezing the display allows it to be analyzed more easily. Zooming the display at the
same time permits detailed evaluation of any signal segment.

SCPI command:
n.a.

Zoom In (only possible with mouse)

The mouse can be used to freely select any section to be zoomed. This section is selected
by pressing the left-hand mouse key and dragging a rectangular marquee. In this way a
display can be zoomed in several steps. The zoom is cancelled by clicking the "Zoom
Out" button.
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SCPI command:
n.a.

Zoom out
Cancels the zoom.

SCPI command:
n.a.

Time
(1/Q mode only)
Switches to seconds for time representation on the X axis of the I/Q diagram.

SCPI command:
n.a.

Show ref
Displays the reference curve(s). All defined reference curves are displayed simultane-
ously (see the description of the "Copy to ref" button).

The reference curves are displayed together with the current signal. They allow visual
comparison of two or more signals with different settings, e.g. with different filters.

Power ! dB

-5M -4M -3M -2M -1M 1] T 2M <] 1] amM
(f-fc) I Hz

Clicking the button again hides the reference curves.
The reference curves must be defined beforehand using the "Copy to Ref" button.

SCPI command:
n.a.
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Defines the current curve as the reference curve.

A window opens in which the curve can be given a comment and a color.

First of all the desired color is highlighted in the top window. If this color has already been
assigned to a reference curve, this curve is overwritten. The command is entered in the
bottom "Comment" section. This comment then appears next to the highlighted color.

Up to 5 reference curves can be defined and displayed simultaneously in different colors
together with the current signal.

Reference Curves

Comment

<empty>
<empty>

<empty>

<empty>
<empty>

Edit the comment:

empty

Delete |

Assign |

Each reference curve is available until it is deleted.

"Display area"

"Comment"

"Delete"

"Assign"

SCPI command:
n.a.

The comments entered for the defined reference curve are shown in
the display area next the assigned color. A maximum of five colors (and
reference curves) are available. If no reference curve is assigned to a
particular color, the comment <empty> is displayed.

Enters a comment for the current curve which is to be defined as the
reference curve. This comment then appears next to the highlighted
color in the display area.

Deletes the curve highlighted in the display area.
Curves which are no longer required can be deleted to reduce the num-
ber of reference curves displayed simultaneously.

Defines the current curve as the reference curve.
The new reference curve is shown together with the entered comment
next to the selected color in the display area.
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5.3.3 Signal Displays

All signal displays which are used for analyzing a baseband signal can be selected. A
number of signal displays are only available if the corresponding signal is generated, e.g.
Code Domain only available for (W)CDMA signals.

5.3.3.1 1/Q Diagram

The 1/Q diagram displays the inphase component (i[t]) and quadrature component (q[t])
of the 1/Q signal over time.

The diagram is displayed in a window with two separate coordinate systems. The coor-
dinate systems have identical X and Y axes. The time (in number of symbols, chips or

samples depending on the signal) is plotted on the X axes, and the amplitude scaled to
the peak envelope power (PEP) is plotted on the Y axes (minimum scaled amplitude =

-1; maximum scaled amplitude = +1). The recording depth is 1 kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.
1
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Show Copy
ref to ref

5.3.3.2 Vector Diagram

The Q component is displayed over the | component in the vector diagram. Each point

is determined by a vector. The amplitudes of the signal components scaled to the peak
envelope power (PEP) are plotted on the X and Y axis (minimum scaled amplitude = -1;
maximum scaled amplitude = +1).

This display shows the curves between the various states of modulation mapping. The
recording depth is 1 kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.
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quadrature q(t)
-

all
S0 -0FS 05 025 0 0250 e 7S
inphase i(t)

Ruim Zoom out Show ref Copy to ref

5.3.3.3 Constellation Diagram

In the constellation diagram, the Q component is also displayed over the | component.
However, only the values at the constellation points (signal value at the ideal scanning
instant of the symbol) are displayed, i.e. for each symbol only 1 value in the form of a
circle is shown for the | and Q component.

The amplitudes of the signal components scaled to the peak envelope power (PEP) are
plotted on the X and Y axis (minimum scaled amplitude = -1; maximum scaled amplitude
= +1). The recording depth is 2kSamples.

This signal is picked off at the output of the baseband main module ("Impairment" function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

This display shows the various states of modulation mapping which occur in the signal.
The example shows the constellation diagram of a QPSK modulation signal.

quadrature q(t)

4 075 0.5 025 0 025 05 075 1
inphase ift)

Run Zoom out | Show rel ‘ Cop¥ to rel
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5.3.3.4 Eye Diagram
The eye diagram displays synchronized and superimposed sections of either the inphase
or quadrature components of the signal.

The display width (eye length) is set at 2 symbols; several hundred curve segments are
superimposed. The time (in the range -/+ 1 symbol) is plotted on the X axis, and the
amplitude scaled to the peak envelope power (PEP) is plotted on the Y axis (minimum
scaled amplitude = -1; maximum scaled amplitude = +1). The beginning of recording is
synchronous to the symbol and chip clock pulse. The recording depth is 2kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

‘ m
» ‘o

: s"é ‘é's's'«

W

-1 -08 -0E6 -04 -0 O 02 04 0B 0B 1
t! Tsymbol

quadmuro qm

I Run I Foorm out

Show ref

Copy lo refl

5.3.3.5 CCDF Display
The Complementary Cumulative Distribution Function shows the probability with which
the output signal will exceed the average power.

The level over the average power is plotted from 0 to 20 dB on the X axis; the average
power (RMS) corresponds to the origin. The probability of exceeding the average power
is plotted between 0.0001% and 100% on the Y axis. The recording depth is 8kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.
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5.3.3.6 Power Spectrum

With the spectrum display, the signal spectrum is calculated from the 1/Q signal by means
of Fast Fourier Transform (FFT).

The power density over frequency is displayed. The power density is plotted on the Y
axis, and the frequency is plotted symmetrically on the X axis (-sampling rate/2 to +sam-
pling rate/2). FFT Points indicates the number of 1/Q value pairs which are used for cal-
culating a (part-)FFT. AVG indicates the number of subspectra used for averaging. The
recording depth is 8kSamples.

This signal is picked off at the output of the baseband main module ("Impairment" function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

The spectrum display of the output signal is particularly suitable for checking multi carrier
signals.

Power | dB

I Run I Zoom aul Bhow ref Copy o ref
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5.4 RF Signal and Analog Modulations - RF Block

5.4.1 Overview of RF Signal

Settings for the RF output signal and analog modulation are made under "RF Signal" and
"Analog Modulations". These settings can be accessed in the block diagram by way of
the "RF/A MOD" function block, or by means of the menu with the same name which is
opened using the MENU key.

The function block is available for the basic unit (R&S SMBV + frequency option R&S
SMBV-B10x) without additional equipment options.

5.4.1.1 RF Output

To activate and deactivate the RF output signal, use one of the following alternatives:

e by means of the RF ON/OFF key (the current entry focus is irrelevant)

® by changing the state of the "RF/A Mod" functional block (see "State
RF" on page 154)

® by enabling/disabling the RF in the "Configure" menu of the "RF/A Mod" block (see
"RF Output State" on page 155).

The current state of the RF output (activated and deactivated) is indicated in the block
diagram by means of the different block color and the status of the "On" checkbox.

The disconnected connection to the output is additionally shown when the output is
deactivated.

Active analog modulation is also indicated in the block.

RF
config... I RF RF
_/._@_,
[T on 2

To query the impedance of the RF outputs, use the command : OUTPut<hw>:
TMPedance on page 484.

State RF
Activated/deactivates the RF output by changing the state of the "RF" functional block.
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Alternatively, the RF ON/OFF key can be used.

SCPI command:
:0UTPut<hw>[:STATe] on page 484

RF Output State
Activated/deactivates the RF output by enabling/disabling the RF in the "Configure" dia-
log of the "RF" block.

Frequency...

SCPI command:
:OUTPut<hw>[:STATe] on page 484

5.4.1.2 REF Signal Modes and Characteristics

The CW, Sweep and List modes are available for generating the RF signal.
e CW

The RF signal is generated with the set frequency and level. This is the default mode.
e Sweep

The RF signal is generated as a sweep with the set parameters.
It is not possible to activate frequency, level and LF sweep simultaneously.

e List Mode
The RF signal is generated on the basis of a list of predefined frequency and level
values. The duration of the individual steps can be predefined.

Instruments connected downstream can be taken into consideration when setting the
frequency and level by entering a frequency and/or level offset.

Automatic level control ("ALC") ensures maximum level accuracy, even with 1/Q modu-
lation.

User-specific lists which contain level correction values for any frequency range ("User
Correction") can be created to, for example, compensate the cable attenuation in a test
assembly setup.

The R&S Signal Generator generates the RF signal in unmodulated or analog form. The
signal generator is equipped therefore with the following sources for analog modulations:
e aninternal LF generator

e an internal pulse generator

e the external modulation inputs MOD EXT and PULSE EXT.

An external trigger signal for the analog modulations, the sweeps and the LIST mode can
be provided at the INST TRIG input.

The input REF IN is used to input an external instrument reference, and the output REF
OUT serves as the output of the reference frequency (internal or external).
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RF Frequency

The value of the RF frequency is displayed in the header of the instrument's display
("Freq"). This field provides the direct input of the RF frequency. Alternatively, you can
enter the RF frequency in the "Frequency/Phase" dialog.

Frequency
| 1.000 000 000 00 |6H: |

Be aware that the displayed RF frequency in the header, and the RF output frequency,
entered in the "Frequency/Phase" dialog can be different, as explained in the following
section.

RF Frequency vs. RF Output Frequency

The signal generator offers the possibility, to take additional frequency modifications of
a downstream instrument into consideration, such as an offset set by a mixer, or a multiple
of the frequency by a frequency multiplier. The R&S SMBYV indicates the resulting fre-
quency, including offset and multiplication factor in the header of the screen. l.e. the
indicated frequency corresponds to the frequency at the output of the downstream instru-
ment. However, the frequency at the RF output of your signal generator always corre-
sponds to the frequency set in the "Frequency/Phase" dialog.

In this dialog, you can also enter the values of the downstream instrument.
A set frequency offset is indicated by the "FREQ OFFSET" status message.

The correlation between the RF frequency, the RF output frequency and the frequency
offset is as follows:

"Freq" (in header) = "RF output frequency" (Frequency in dialog) * "Multiplier" factor
(Multiplier in dialog) + "Freq offset" (Offset in dialog)

Frequency offset / multiple by
EES[EEEN the downstream instument
("Offset" / "Multiplier" in the

Qoo |
aiao -} .
frequency dialog)

Frequency at the output of
the downstream instrument
("Freq" in the header

area of the screen)

B
aeEl- F@
Soe e
=060 Mixer / Multiplier ———»

RF output frequency
("Frequency" in the frequency dialog)

Setting the RF Frequency

To change the RF frequency, press the FREQ key and enter the desired frequency.
Changes to the RF frequency have an immediate effect (without confirmation with the
ENTER key) on the output signal.

RF Freq
Enters the RF frequency, considering the frequency offset.

|
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Note: The SCPI command sets the level of the "Freq" display, i.e. an entered frequency
offset and multiplier factor are taken into consideration in the frequency value.

SCPI command:
[ :SOURce<hw>] : FREQuency [ :CW| : FIXed] on page 628

RF Frequency Dialog

In the combined "Frequency/Phase" dialog, you can enter the frequency, the frequency
offset and multiplication factor of a downstream instrument, set the step width for the
frequency entry using the rotary knob, and set the phase for the RF output signal.

To open the "RF Frequency/Phase/LO Coupling" dialog, select "RF/A Mod > Configure
> Frequency" or use the MENU key under "RF/A Mod".

The "RF Frequency / Phase" dialog is divided into the several sections.

Frequency and offset of the RF output signal are set in the "Frequency Settings" section
in the upper part of the dialog. In addition, the multiplier factor of an externally connected
multiplier is specified.

Frequency lmm

Offset ononfjHz =
Multiplier 1.000

The step width which is used when setting the frequency using the rotary knob (with
"Variation Active On") is set in the "User Variation" section.
User Variation
Variation Active I~
Variation Step | 1,000 000 000 [ MHz |

The phase of the output signal can be changed in the "Phase Settings" section. The
"Phase Settings" menu is described in chapter 5.4.3, "Phase”, on page 158.

The lower parts concern the settings of the local oscillator (LO) and are described in
chapter 5.4.5, "Local Oscillator - LO Coupling", on page 161.

Frequency Settings

The frequency, offset and multiplier factor are set in the top section of the menu.

Frequency - RF Signal

Sets the RF frequency of the RF output connector. The frequency entered and displayed
here corresponds to the frequency at the RF output, i.e. any offset entry is not taken into
consideration.

Note: The SCPI command SOUR: FREQ sets the frequency of the "FREQ" display, i.e.
the frequency containing offset.

SCPI command:
n.a.
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Offset - RF Signal
Sets the frequency offset relative to the RF frequency. The frequency offset of a down-
stream instrument (e.g. a mixer) is entered.

The entry does not change the value of the RF frequency at the RF output. It only changes
the RF frequency displayed in the display header. The value of the RF frequency in the
header corresponds to the frequency at the output of the downstream instrument.

SCPI command:
[ : SOURce<hw>] : FREQuency: OFFSet on page 631

Multiplier - RF Signal
Sets the multiplication factor for the RF frequency.

In the frequency field of the status bar, the instrument adjusts its frequency display
according to the set multiplication factor. This frequency value shows the frequency at
the output of the downstream multiplier. The entry does not change the RF frequency at
the RF output of the R&S SMBV.

SCPI command:
[ :SOURce<hw>] : FREQuency:MULTiplier on page 630

User Variation

If the frequency is set using the rotary knob, the step width is defined in the "User Var-
iation" section.

Variation Active - RF Signal
Activates the user-defined step width used when varying the frequency value with the
rotary knob.

"ON" The frequency value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The frequency value set with the rotary knob is varied in steps of one
unit at the cursor position (standard operating mode).

SCPI command:
[ :SOURce<hw>] : FREQuency: STEP : MODE on page 633

Variation Step - RF Signal

Sets the user-defined step width. This step width is used when entering the RF frequency
using the rotary knob. Frequency variation with this step width must also be activated
with "Variation Active".

SCPI command:
[ :SOURce<hw>] : FREQuency:STEP [ : INCRement] on page 633

Phase

The phase of the RF output signal can be changed in the "Phase Settings" section of the
"RF Frequency/Phase" dialog.

|
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Phase Settings

To open the "Frequency/Phase/LO Coupling" dialog, select "RF/A Mod" > "Configure" >
"Frequency/Phase" or use the MENU key under RF/A Mod.

Phase Settings

544

IDeIta Phase | 0.0 | deg jl

Reset Delta Phase Display |

Delta Phase - RF Signal

Sets the phase of the RF signal. The current phase of the signal is used as the reference.
This function allows, for example, the phase of the output signal to be synchronized with
the phase of a signal from a second signal generator.

SCPI command:
[ : SOURce<hw>] : PHASe on page 670

Reset Delta Phase Display - RF Signal
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

SCPI command:
[ : SOURce<hw>] : PHASe : REFerence on page 670

Reference Oscillator

In the internal reference mode the internal reference signal is available at the REF
OUT connector. The frequency of the internal reference signal is permanently set to 10
MHz.

The settings of the reference oscillator are not influenced by an instrument preset

) ("PRESET" key).

5441

RF

RF OM
Frequency...
Fhase

Reference Oscillator Dialog
To open the "Reference Oscillator" dialog, select "RF/A Mod > Configure > Reference
Oscillator" or use the MENU key under "RF/A Mod".

The menu is used to select the source and to adjust the reference frequency. In case an
external source is selected, the reference frequency is displayed.

Source I External - |

Deactivate RF Output (if external reference is missing) |

External Reference Frequency 10 MHz
Adjustment:
[Adjustment Active &
Adjustment DAC Value 512
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Source - Reference Oscillator
Selects the source of the reference frequency.

"Internal” The internal reference signal of 10 MHz is used, comprising either the
calibrated or a user-defined adjustment value.

"External” An external reference signal is used. The frequency of the external ref-
erence signal must be selected under "External Reference Fre-
quency".

An external reference signal is required for each slave instrument con-
figured to work in a synchronous mode (see chapter 5.8.2.4, "Synchro-
nous Signal Generation", on page 277).

SCPI command:
[ :SOURce] :ROSCillator:SOURce on page 692

Deactivate RF Output - Reference Oscillator
Determines if the RF output is switched off in case of a missing external reference signal
for selection external source.

If enabled, this setting ensures that no improper RF signal due to the missing external
reference signal is output and used for measurements.

In addition to the error message "Ext Ref missing", the information "RF output deactiva-
ted" is indicated.

This setting is not influenced by a reset.

SCPI command:
[:SOURce] :ROSCillator:EXTernal :RFOFf[:STATe] on page 691

External Reference Frequency

Selects the frequency of the external reference signal. You can select an external refer-
ence signal having a frequency of 5 MHz or 10 MHz; however, for 5 MHz the version of
the RF board must be at least 1406.7220 or higher, see chapter 5.2.3.2, "Hardware Con-
fig", on page 107.

SCPI command:

[ :SOURce] :ROSCillator:EXTernal : FREQuency on page 690

Synchronization Bandwidth - RF Signal
(Source External only)

Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using very good reference sources of high spectral purity.

"Narrow" Synchronization bandwidth is 1 Hz.
"Wide" Synchronization bandwidth is 750 Hz.

SCPI command:
[:SOURce] :ROSCillator:EXTernal : SBANdwidth on page 691

Adjustment Active - Reference Oscillator
Selects adjustment mode.

|
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"OFF" The calibrated adjustment value of the internal reference frequency is
used. This value is determined at one of the R&S service shops during
calibration.

"ON" A user-defined adjustment value is used. The value is entered under

"Adjustment DAC Value".

This allows the frequency to be impaired freely, for example to simulate
a frequency error.

The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibrated
state after switching the "Adjustment State" to Off.

SCPI command:
[:SOURce] :ROSCillator[:INTernal] :ADJust[:STATe] on page 692

Adjustment DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active On" is selected.

SCPI command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 691

5.4.5 Local Oscillator - LO Coupling

The LO Coupling function allows a distribution of the local oscillator signal in way that
multiple RF signals can be driven by the same LO signal. This is mandatory for minimizing
the phase drift between these RF signals.

The LO Coupling function is available only for instruments equipped with the option R&S
SMBV-B90 (Phase Coherence).

The local oscillator signal is available at the LO OUT connector (rear of instrument).

In the external local oscillator mode, an external signal must be input at the LO IN con-
nector.

5.4.5.1 Phase Coherence

Phase coherence of two RF signals means that there is a defined and stable phase rela-
tionship between two (or more) RF carriers, i.e. there is a fixed delta phase A® between
the carriers. Strictly speaking, phase coherence is only defined for CW carriers with the
same frequency (or for CW carriers at frequencies that are multiples of each other).

[

I

\/f\ RF 1

T N
] .
o

/N

o RF 2

T >t
- N4
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If two signal generators are coupled via their 10 MHz reference, they are generating
exactly the same frequency but only from the long term perspective. Having a closer look
into the instantaneous differential phase (“delta phase”) of these two RF signals, this is
quite instable due to:

e phase noise of the two synthesizers

e ‘“weak” coupling at 10 MHz and a long synthesis chain up to the RF domain

e temperature differences which cause a change of the effective electrical length of
some synthesizer components

Most critical for a stable delta phase is the thermal RF phase drift between multiple RF
synthesizers. This drift can be minimized down to 0.1° by use of a common synthesizer,
i.e. a common local oscillator (LO) signal, for all RF carriers. Only if this LO signal (which
is internally used for upconverting the baseband signal to the RF) is the same for all
carriers, a stable phase between the RF signals can be achieved.

Typical Applications

The LO Coupling function can be used to generate a MxN MIMO signal.
e Generation of 2xN MIMO signal with two R&S Signal Generators, working in External

mode.
LOINy_ k|_,) LOOUT LO M d'/: _/LOOUT
3 Signal Generator 1 1 RE&S Signal Generator 2
Synih A = 10 Mod A Synth A 10 Mod A
E0UR: FREQ: LOSC i MODE INT S0UR: FREQ: LOSC:MODE EXT
SOUR: FREQ :: LOSC :OUTP: 5TAT QN

LO Coupling Menu

To open the "LO Coupling" menu, select "RF/A Mod > Configure > LO Coupling" or use
the MENU key under "RF/A Mod".

The menu is available only for instruments equipped with the option R&S SMBV-B90.
This option enables phase coherent RF outputs of two or more RF paths.

The local oscillator coupling is set in the lower area of the group menu "Frequency/
Phase". The menu is used to select the mode of the LO coupling and the state of the local
oscillator output.

For more information about the upper areas, see:

e chapter 5.4.2.3, "RF Frequency Dialog", on page 157
e chapter 5.4.3.1, "Phase Settings", on page 159
e chapter 5.4.4.1, "Reference Oscillator Dialog", on page 159
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Local Oscillator (LO) Coupling
IMode | External jl
Out State | Cn j

Mode - LO Coupling
Selects the mode of the local oscillator coupling.

"Internal"” This mode corresponds to a normal operation.
The internal local oscillator is used.
"External” An external signal is used.
LO N
&)

Note: Selection of LO Coupling "External" mode, disables all parame-
ters in the "Frequency/Phase/Ref Osc" menu.

SCPI command:
[ :SOURce<hw>] : FREQuency:L0OSCillator:MODE on page 627

Out State - LO Coupling
Switches on/off the LO output.

"On" The internal local oscillator signal is also available on the LO OUT con-
nector (in order to couple two instruments).
"Off" The LO OUT signal is switched off.

SCPI command:
[ :SOURce<hw>] : FREQuency:LOSCillator:0UTPut:STATe on page 628

5.4.6 NRP-Z Power Viewer

The R&S signal generator supports R&S NRP-Z power sensors to measure the power
of the output signal in the RF path or any freely selectable source. The generator performs
up to four power measurements, with the sensors either directly connected, or via the
R&S NRP-Z5 USB Sensor Hub.

|
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sensors and provides simultaneous internal and external triggering of all connected sen-
sors.

@ The R&S NRP-Z5 USB Sensor Hub (high-speed USB 2.0) can host up to 4 R&S NRP-Z

You can directly connect the R&S NRP-Z Sensors to the standard NRP sensor connec-
tors of the hub. The hub is connected to the R&S instrument either with the R&S NRP-
Z2 extension cable, or via USB using with the adapter cable R&S NRP-Z4.

See also the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP-Z Sensors" for information on the sensor hub and the available
accessories.

To connect an R&S NRP-Z sensor directly, the R&S SMBYV provides the SENSOR con-
nector. A sensor connected there is always assigned as "Sensor 1". Alternatively, you
can connect a sensor at a USB interface, using one of the USB adapters R&S NRP-Z3
or R&S NRP-Z4.

The instrument automatically detects a connected R&S NRP-Z power sensor and indi-
cates it in the "NRP-Z Power Viewer" dialog. In addition, you find device specific infor-
mation on the connected sensor in the chapter 5.2.3.6, "NRP-Z Info/

Update", on page 115. For information on the scope of your power sensor refer to the
manual of your R&S NRP-Zxx power sensor.

A sensor continuously measures the average signal power of the selected source. The
signal generator shows the result in either the "NRP-Z Power Viewer" dialog, or directly
in the block diagram. You can activate the permanent display in the block diagram in the
"NRP-Z Power Viewer" dialog. This dialog provides access to all parameters concerning
sensor settings, like average or peak display, reference source, filter and level offset, see
NRP-Z Power Viewer Settings.

The signal generator also supports the use of R&S NRP-Z power sensors for the acqui-
sition of level correction data. The acquired level correction data is used to create and
activate lists in which level correction values predefined by the user are freely assigned
to RF frequencies. Correction is performed by the user-defined table values being added
to the output level for the respective RF frequency (see chapter 5.4.10, "User Correc-
tion", on page 181).

5.4.6.1 NRP-Z Power Viewer Settings

werrmsvene. 10 open the "NRP-Z Power Viewer" menu, select "RF/A Mod" > "Configure" > "NRP-Z
Power Viewer" or use the MENU key under "RF/A Mod".

The dialog shows the settings and measurement values of the sensor selected in the field
next to the connector symbol. For indicating the parameters of another sensor, switch to
the respective sensor in the selection list.

The instrument detects connected sensors automatically and lists all in the selection field.

"Sensor 1" is firmly assigned to the sensor on the circled SENSOR socket. If no sensor
is connected to this socket, channel 1 remains not assigned. Sensors 2...4 are assigned
to the sensors at the USB connectors, according to their sequence of connection.

|
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When you connect your power sensor(s) via the R&S NRP-Z5 USB sensor hub, each
channel of the hub is firmly assigned to the associated sensor channel in the generator.

i

EH NRP-Z Power Viewer

=] J3 - NRP-ZB1 S/N 900004 -

Level (Peak) | -22.43 |dBm -]

wawg) | -60.06 | |

Display Permanent ¥ Priority IA\;‘g. 'I
Zero |

Source [RF -
Level Offset  |Of =] | 000fsB8 ~|
Filter [aute || 65 536
Use SParameter I~ on

Sensor - Power Viewer
Selects the R&S NRP-Z power sensor for indication.

In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected to SENSOR, suffix 2 the one at the first USB
interface, and suffix 3 and 4 are assigned to the sensors at the following USB interfaces.
The suffix is identical to the index which is assigned automatically to each sensor upon
connection.

Note: The software version of the connected power sensor can be retrieved by means
of the remote control command : SENS: POW: TYPE?.

Use the "Setup >" chapter 5.2.3.6, "NRP-Z Info/Update", on page 115 dialog to update
the sensor software.

SCPI command:
SENSe<ch>[:POWer] :STATus [ :DEVice] on page 492

Type - Power Sensors
Indicates the type and the serial number of the connected R&S NRP-Z power sensor.
The sensor type is automatically detected.

SCPI command:
SENSe<ch>[:POWer] : TYPE on page 492
SENSe<ch>[:POWer] : SNUMber on page 491

State - Power Sensors
Activates/deactivates level measurement by the power sensor.

The local state is set with the TNTT command. Switching the local state off enhances the
measurement performance.
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In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.
The state is not influenced by these commands, measurements results can be retrieved
with local State on or off.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected to SENSOR, suffix 2 the one at the first USB
interface, and suffix 3 and 4 are assigned to the sensors at the following USB interfaces.
The suffix is identical to the index which is assigned automatically to each sensor upon
connection.

To query the availability of a sensor at a given connector, use the command
SENSe<ch>[:POWer] : STATus [ : DEVice] on page 492.

SCPI command:
:INITiate<ch>[:POWer] :CONTinuous on page 486

Level (Peak) - Power Sensors
With certain power sensors only, e.g. R&S NRP-Z81.

Indicates the measured peak level value with the selected unit.

SCPI command:
:READ<ch>[:POWer] on page 486

Level (Avg.) - Power Sensors
Indicates the measured level value with the selected unit.

SCPI command:
:READ<ch>[:POWer] on page 486

Unit - Power Sensors
Selects the unit used for result display.

The power sensor provides the measured value in Watt.

In which unit the measured value is indicated is selected here and might be Watt, dBm
or dBuV.

SCPI command:
SENSe<ch>:UNIT[:POWer] on page 493

Permanent Display State - Power Sensors

Activates the permanent indication of the power measurement result in the upper right
corner of the block diagram. The instrument shows the type of sensor, the corresponding
connector, the measurement source and - if set - the offset.

25| NRP-Z11 Offs -83.10dBm RF
33| NRP-Z81 -59.39dBrm User,

|
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It is possible to switch the permanent display active for several sensors. The instrument
indicates the values of a maximum of two sensors simultaneously, in ascending order of
connected channels. If you activate the display of a third sensor, the instrument fades
out the values of the last highest channel number automatically.

SCPI command:
SENSe<ch>[:POWer] :DISPlay:PERManent : STATe on page 487

Display Priority - Power Sensors
Selects whether the average or the peak power measurement result is indicated when
permanent display is active.

SCPI command:
SENSe<ch>[:POWer] :DISPlay:PERManent:PRIority on page 487

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal power.
For this purpose, the RF power source must be switched off or disconnected from the
sensor (see tips below). R&S power sensors automatically detect the presence of any
significant input power. This aborts zeroing and generates an error message. Zeroing
can take a few seconds, depending on the sensor model; refer to the documentation of
your external power sensor for more information.

Tips for zeroing

Zeroing should be performed:

e During warm-up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When very low-power signals are to be measured, e.g. less than 10 dB above the

lower measurement limit.

e Switch off the RF power source for zeroing; do not disconnect it from the power sen-
sor. In this way you will maintain the thermal equilibrium, and zeroing will also com-
pensate for the noise superimposed on the measured signal (e.g. from a broadband
amplifier).

SCPI command:
SENSe<ch>[:POWer] : ZERO on page 492

Source - Power Sensors
Selects the source for measurement.

"RF" Measurement source is the RF signal of the generator. The RF fre-
quency is used as the measurement frequency of the sensor and the
corresponding correction factor is used.

In this mode the RF frequency of the generator is send to the sensor
automatically if changed.
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"User" Measurements source is any freely selectable source. The frequency
is entered manually under frequency (e.g. for measurement of amplifier
gain with 2 sensors).

SCPI command:
SENSe<ch>[:POWer] : SOURce on page 491

Frequency - Power Sensors
Source User only

Enters the frequency for measurement source "User".

SCPI command:
SENSe<ch>[:POWer] : FREQuency on page 490

Level Offset - Power Sensors

Activates and defines a level offset which is added to the measured value. This allows
e.g. an attenuator in the signal path to be taken into account. The offset is always entered
in dB, irrespective of the selected unit for result display.

SCPI command:
SENSe<ch>[:POWer] : OFFSet : STATe on page 491
SENSe<ch>[:POWer] : OFFSet on page 490

Auto Once
Searches for the optimum filter length for the current measurement conditions and indi-
cates value in the "Filter Length" field above.

SCPI command:
SENSe<ch>[:POWer] : FILTer : SONCe on page 489

Filter Length - Power Sensors
Selects the filter length used for measurement. The filter length is the multiplier for the
measurement time and thus directly influences it.

The averaging filter is used to reduce fluctuations in the measured result to the extent
desired. Such fluctuations can be caused by inherent noise of the measuring instrument,
modulation of the measurement signal or beats from the superposition of adjacent car-
riers. A more stable display has to be traded off against longer measurements. The mea-
surement result is obtained from a two-stage averaging process.

Note: Longer measurements does not mean that it takes longer to display a new result,
but rather that it takes longer for the result to settle when the power changes.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time windows.
The number N is the filter length, the factor of 2 arises because the output signals from
the microwave detector to suppress low-frequency noise are chopped at the same rate
as the time windows, which means that an independent measured value can only be
obtained from two consecutive values. As the filter length is the multiplier for the time
window it directly influences the measurement time.

The filter length can be selected automatically or can be manually set to a fixed value.
As a preliminary, you should always check if the auto mode is giving satisfactory results
because you will always have to adjust an optimal, manual filter-length setting if the power
is not constant.
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Selection "Fixed Noise" is offered for reaching defined measurement accuracy.

"Auto" The filter length is automatically selected and adapted to the currently
measured value. With very high signals the filter length and therefore
the measurement time can be short. With very low signal levels the filter
length and therefore the measurement time is increased in order to
reduce noise. The used filter length is indicated in the field to the right.

"User" The filter length is set manually.
The filter length is entered in the entry window to the right. As the filter
length works as a multiplier for the time window, this results in a con-
stant measurement time. Values 1 and 2*n are settable.

Note: The time window varies depending on the used sensor. For most
sensors it is fixed to 20 ms. For the R&S NRP-Z81 sensor it is 10 us.
Therefore, the user filter length for the R&S NRP-Z81 has be about
1000 times larger than the filter length for other sensors in order to
achieve the same filtering result.

The "Auto Once" button can be used to search for the optimum filter
length for the current measurement conditions. The found filter length
is indicated in the field to the right.

"Fixed Noise"  The averaging factor is selected so that the sensor's intrinsic noise (2
standard deviations) does not exceed the specified noise content.
The desired noise content is entered in the entry field to the right.
To avoid very long settling times when the power is low, the averaging
factor can be limited with the "Timeout" parameter.

SCPI command:

SENSe<ch>[:POWer] :FILTer: TYPE on page 490

]
SENSe<ch>[:POWer] :FILTer : LENGth:AUTO on page 488
SENSe<ch>[:POWer] :FILTer:LENGth[:USER] on page 488
SENSe<ch>[:POWer] :FILTer:NSRatio on page 488
SENSe<ch>[:POWer] :FILTer:NSRatio:MTIMe on page 489

Use SParameter - Power Sensors < Filter Length - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor. For
sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

SCPI command:
SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 487

NRP-Z Level Control

With the NRP-Z Level Control function, you can achieve a very stable and accurate RF
power supplied to your DUT. With the aid of a downstream control circuit, a closed loop
power control, you can detect frequency response characteristics of the used compo-
nents, such as losses due to cables, modules or components like power amplifiers, and
compensate these effects accordingly.
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Example: How to set up a closed loop power control

R&S SMBV100A Signal
Generator «s

-~ Amplifier DUT Antenna
RF level N [xdB | inputlevel
1 Coupler
R&S NRP-Zxx
Power Sensor
- target level
L power conu-of—qll/) S Parameter (optional)

Fig. 5-1: Example of a test setup with NRP-Z Level Control

As shown in the example, the sensor measures a proportional power in defined time
intervals, derivated from a coupler. It considers optionally given S-parameters and sends
the results back to the generator. The signal generator compares the measured level with
the set value and adjusts its output level accordingly.

This allows you to control the external signal level continuously and reliably reach a con-
stant input level at the DUT in real time.

Please keep in mind that modulated signals may differ from CW signals regarding mean
power and peak power. This affects the operation of "NRP-Z Level Control".

Beyond that, it is strongly recommended that you disable the "List" mode, since it also
falsifies the power control loop.

5.4.71 NRP-Z Level Control Settings

RF

-l To open the "NRP-Z Level Control" dialog, select "RF > Configure > NRP-Z Level Con-

RF OR

Frequency... trol" or use the MENU key under "RF".
Phase.
LO Coupling.. —
Reference Oscillatar.. ;Iglll
NRP-Z Power Viewer..
“NREZ Fawer Contral, [R50 ] 20000 -l
Level / EMF
Autormatic Level Contral... FIEE
Measured Level -54.53 dBm

Zern |
Target Level mm
RfLevelLimit [ 30.00[dBm <]
Catch Range +- lﬁlﬂ
Delay Time I—Dm

Use Peak Power [~ On
Use SParameter [~ On

Sensor
Selects the R&S NRP-Z power sensor for power control.
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Note: In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results.

The software version of the connected power sensor can be retrieved by means of the
remote control command : SENS: POW: TYPE?.

Use the "Setup >" chapter 5.2.3.6, "NRP-Z Info/Update”, on page 115 dialog to update
the sensor software.

SCPI command:
[ : SOURce<hw>] : POWer : SPC: SELect on page 682

State
Activates power control using the selected sensor.

The control loop periodically adjusts the generator output. After switching off, the running
loop is completed.

SCPI command:
[ : SOURce<hw>] : POWer : SPC: STATe on page 682

Measured Level
Indicates the current reading of the sensor.

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal power.
For this purpose, the RF power source must be switched off or disconnected from the
sensor (see tips below). R&S power sensors automatically detect the presence of any
significant input power. This aborts zeroing and generates an error message. Zeroing
can take a few seconds, depending on the sensor model; refer to the documentation of
your external power sensor for more information.

Tips for zeroing

Zeroing should be performed:

e During warm-up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When very low-power signals are to be measured, e.g. less than 10 dB above the

lower measurement limit.

e Switch off the RF power source for zeroing; do not disconnect it from the power sen-
sor. In this way you will maintain the thermal equilibrium, and zeroing will also com-
pensate for the noise superimposed on the measured signal (e.g. from a broadband
amplifier).

SCPI command:
SENSe<ch>[: POWer] : ZERO on page 492
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Target Level

Specifies the nominal level expected at the input of the sensor. The signal generator
adjusts the output power accordingly, in order to meet the target value at the sensor input,
and thus the power required at the DUT.

SCPI command:
[ : SOURce<hw>] : POWer: SPC: TARGet on page 682

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter an
RF level above this value, the instrument limits the output power to this specified value,
and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The value is not affected by an instrument preset (PRESET key), *RST and the
"Save/Recall" function. It is influenced only by the Factory Preset and the factory value
is equal to maximum level.

SCPI command:

[ :SOURce<hw>] : POWer :LIMit [ :AMPLitude] on page 678

Catch Range +/-
Sets the capture range of the control system.

Within the range:
Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the range
are not considered.

SCPI command:
[ : SOURce<hw>] : POWer : SPC: CRANge on page 681

Delay Time
Defines a waiting period between the level adjustment of the generator and the next
measurement of the power sensor.

With this parameter, you can take into account any dead times in the controlled system.

SCPI command:
[ :SOURce<hw>] : POWer: SPC:DELay on page 681

Use Peak Power
Activates control by means of the peak power values, provided the power sensor supports
this function. Otherwise, the dialog does not show this parameter.

SCPI command:
[ : SOURce<hw>] : POWer : SPC: PEAK on page 682

Use SParameter - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor. For
sensors with attenuator this checkbox is automatically checked.
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Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

SCPI command:
SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 487

RF Level/EMF

Overview of RF Level

\ Message "Level overrange/underrange”
! If this message appears in the status line, the following parameter is in the overrange

(see data sheet):
o the setlevel ("Level")
e the displayed peak envelope power ("PEP") for Digital Modulation or Digital Standard

The correct level setting and signal quality cannot be guaranteed if the set level is in the
overrange/underrange.

The value of the RF level is displayed in the level field in the header of the instrument's
display and the easiest way to set the RF level is to set it directly in this field.

PEP Level

1-30.00 dm [-30.00 | Bm ]

The center line ("Level") and, to the left of this, the peak envelope power ("PEP") of the
modulated RF output signal is displayed in the case of digital modulation or digital stand-
ard.

Be aware, that there is a difference between the RF level displayed in the header and
the RF output level set in the "Level/EMF" dialog of the "RF" block.

RF level vs. RF output level

The level entered and displayed in the "Level" field takes the offset of any downstream
attenuators/amplifiers into consideration by way of calculation. This means that with a
level offset the level displayed in the header does not correspond to the level at the RF
output, but rather to the level at the output of the downstream instrument.

This allows the desired level at the output of downstream instruments to be entered. The
R&S Signal Generator changes the RF output level according to the set offset.

However, the level entered and displayed in the "Level" menu of the "RF" function block
always corresponds to the RF output level. Any level offset is not taken into consideration.

The level offset is entered in the "Level" menu. Here it is also possible to set the level
without taking the offset into consideration, and to make other settings, such as level
offset, attenuator mode, power-on state.

|
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The correlation is as follows:

"Level" (in header) = "RF output level" (Level in menu) + "Level offset" (Offset in menu)

l e fr T Level offset by the instrument

g Sl (,Offsetl” in the Level menu)

| EE:: e Level at the output |

'.\'f ETTE Aftenuationgain  |—m of the instrument
.~ W W {.Lev* in the header araa

RF output level of the screen)
{ Amplitude® in the Level manu)

The RF output is protected against overloading by an external signal applied to the RF
output (see "Reverse Power Protection” on page 178).

Setting the RF level

To change the RF level, press the LEVEL key and enter the desired level. Changes to
the RF level have an immediate effect (without confirmation with the Enter key) on the
output signal.

RF Level
Enters the RF level, considering the level offset (see "RF level vs. RF output
level" on page 173).

Note: Some SW options have specific requirements about the calculation of the level of
the output signal, e.g. the displayed value corresponds to the level at the start simulation
time, there are correction coefficients to be applied, etc. In cases like this, the displayed
value in the header of the instrument does not always correspond to the level at the RF
output!

When working with a SW option, always refer to the corresponding documentation for
related specific information.

dBm, dBuV, mV and uV can be used as the level units. The 4 unit keys are labeled with
these units.

Note: The SCPI command sets the level of the "Level" display, i.e. an entered level offset
is taken into consideration in the level value.

SCPI command:
[ :SOURce<hw>] :POWer [:LEVel] [ : IMMediate] [ :AMPLitude] on page 676

5.4.8.2 RF Level Dialog

Farrence Declletor. To open the "RF Level/EMF" dialog, select "RF/A Mod > Configure > Level/EMF" or use
the MENU key under "RF/A Mod".

User Carrzction... The combined "RF Level / EMF" dialog is divided into the several sections.
The top sections of this dialog provide access to the level settings.

The offset-free level, level offset and level limit are set in the top section of the menu. The
attenuator mode is set in the "Attenuator Settings" section.

The step width which is used when setting the level using the rotary knob (with "Variation
Active On") is set in the "User Variation" section.

|
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=lolx|
Leve| Setting:
Mode INurma\ j
amplitude |
Limit lmlm
Offsat I |
Aftenuator Settings
Mode Fined ¥
Fixed Range (PEP) In.
[=am.. [ cem

RF OFF Mode Full Attenuation

UserVariation
variation Active r

ariation Step 1.00(de =

Fower-On § EMF Seftinas

Paower-On State Previous Setting =

Display Level as Voltage of EMF r

Ext Level Adjustment

Adjustment Data Factory -

The power-on behavior of the instrument and the level display in the display header are
set in the "Power-On / EMF Settings" section (see chapter 5.4.8.3, "Power-On/EMF Set-
tings", on page 178).

The lower sections provide access to the "Automatic Level Control" settings and to func-
tion User Correction settings. For more information about this functions, see chap-

ter 5.4.9, "Automatic Level Control - ALC", on page 178 and chapter 5.4.10, "User Cor-
rection”, on page 181.

Level Settings

The offset-free level, attenuation mode, level offset and level limit are set in the top section
of the menu.

RF Mode
Selects performance preferences of the RF output signal regarding wideband noise and
distortion.

"Normal" The generator provides an RF output signal with high signal to noise
ratio as well as low distortion, according to the data sheet.

"LOW Noise" This setting forces the generator to optimize the signal to noise ratio.

"LOW Distor-  The generator reduces distortion (harmonics) of the RF signal.
tion"

SCPI command:
[ : SOURce<hw>] : POWer : LMODe on page 678

Amplitude
Sets the RF level of the RF output connector.

The level entered and displayed here corresponds to the level at the RF output, i.e. any
offset entry is not taken into consideration.

Note: The SCPl command [ : SOURce<hw>] : POWer [:LEVel] [:IMMediate] [:
AMPLitude] sets the level of the "Level" display, i.e. the level containing offset.

SCPI command:
[ :SOURce<hw>] : POWer : POWer on page 680
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Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter an
RF level above this value, the instrument limits the output power to this specified value,
and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The value is not affected by an instrument preset (PRESET key), *RST and the
"Save/Recall" function. It is influenced only by the Factory Preset and the factory value
is equal to maximum level.

SCPI command:
[ :SOURce<hw>] : POWer:LIMit [:AMPLitude] on page 678

Offset (Level)
Sets the level offset relative to the RF level.

The level offset of a downstream instrument (e.g. an attenuator or amplifier) is entered.

The entry does not change the value of the RF level at the RF output. It only changes the
RF level displayed in the display header. The value of the RF level in the header corre-
sponds to the level at the output of the downstream instrument.

SCPI command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] : OFFSet on page 677

Attenuator Settings

The attenuator mode is set in the Attenuator Settings section.

Attenuator Mode
Sets the attenuator mode at the RF output.

"Auto" Standard mode.
The electronically switching attenuator switches with a 5 dB step width
at fixed switching points.

"Fixed" The level settings are made without switching the attenuator.
When this operating mode is switched on, the attenuator and the relays
are fixed in their current positions to provide level settings without inter-
ruption. The resulting variation range is defined and displayed under
"Attenuator Fixed Range".

Note: The function is effective when automatic level control is activated
("ALC State = On").

If the normal variation range is overranged or underranged, level errors
increase considerably and the warning "Level under/overrange"
appears in the info line. The spectral purity of the output signal decrea-
ses with high attenuation.

SCPI command:
:OUTPut<hw>:AMODe on page 483
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Fixed Range (PEP) In
Displays the level range in which the level is set without interruption for the "Attenuator
Mode fixed" setting.

SCPI command:
:OUTPut<hw>:AFIXed:RANGe:UPPer on page 483
:0UTPut<hw>:AFIXed:RANGe: LOWer on page 483

RF OFF Mode
Selects the attenuator mode, when the RF signal is switched off.

The setting of the RF OFF mode is not affected by an instrument preset (PRESET key),
*RST and the "Save/Recall" function. This parameter is influenced only by the Factory
Preset.

"Unchanged" Freezes the setting of the attenuator when RF is switched off. The
attenuator is only activated when RF is switched on.
This setting recommended if a constant VSWR (Voltage Standing Wave
Ratio) is required.

"Full Attenua-  Sets attenuation to maximum when the RF signal is switched off. This
tion" setting is recommended for applications that require a high level of
noise suppression.

SCPI command:

[ :SOURce<hw>] : POWer:ATTenuation:RFOFf :MODE on page 676

User Variation

If the level is set using the rotary knob, the step width is defined in the "User Variation"

section.

Variation Active
Activates the user-defined step width used when varying the level value with the rotary

knob.

"ON" The level value set with the rotary knob is varied using the user-defined
step width which is entered under "Variation Step".

"OFF" The level value set with the rotary knob is varied in steps of one unit at

the cursor position (standard operating mode).

SCPI command:
[ :SOURce<hw>] : POWer : STEP: MODE on page 683

Variation Step
Sets the user-defined step width for entering the RF level using the rotary knob. Level
variation with this step width must also be activated with "Variation Active".

SCPI command:
[ :SOURce<hw>] : POWer:STEP[: INCRement] on page 683
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Reverse Power Protection

The reverse power protection is tripped when the power of the external signal becomes
too high. A relay opens and interrupts the internal connection to the RF output. This
condition is indicated in the display header by the "OVERLOAD" status message.

Overload
If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.

The RF input is activated when the overload protection is reset.

SCPI command:
:OUTPut<hw>:PROTection:TRIPped on page 484
:OUTPut<hw>:PROTection:CLEar on page 484
:OUTPut<hw>[:STATe] on page 484

Power-On/EMF Settings
The power-on behavior of the R&S SMBYV and the level display in the display header are
set in the "Power-On / EMF Settings" section of the "RF Level/EMF/ALC/UCOR" dialog.

To open the "RF Level/lEMF" dialog, select "RF/A Mod > Configure > Level/EMF" or use
the MENU key under "RF/A Mod".

Power-On / EMF Settings

Power-On State IPrevious Setting v|

Display Level as Voltage of EMF -

Power-On State - RF Signal
Selects the state which the RF output is to assume after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.

"Previous Set- When the instrument is switched on, the output assumes the same state
ting" as it had when the instrument was switched off.

SCPI command:
:OUTPut<hw>[:STATe] : PON on page 485

Display Level as Voltage of EMF - RF Level
Activates display of the signal level as voltage of the EMF (no-load voltage). If this setting
is deactivated, the level is displayed as a voltage over a 50 Ohm load (preset state).

SCPI command:
n.a.

Automatic Level Control - ALC

Your signal generator is equipped with an automatic level control unit to obtain best RF
level accuracy.

|
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Automatic Level Control (ALC) is an adaptive control system to stabilize the RF output
level. It continuously monitors the current level and adjusts it to keep a steady state over
temperature and time.

N\ ALC is active in almost all applications by default. However, some operating modes
/) exclude ALC, as the control loop would detect incorrect values and result in level devia-
tions. These are:

e Pulse modulation
e |/Q modulation
Also note that ALC may detect incorrect values in multi-transmitter test setups. If mul-

tiple generators are coupled, reverse power may affect the ALC readings. Based on
incorrect values, ALC would have an impact on the signal to intermodulation ratio.

ALC States

The following description basically explaines the ALC states and their principle of oper-
ation. In particular ALC OFF (Sample & Hold) gives an overview on the function in terms
of the equipment of the generator.

The R&S SMBYV offers the ALC states:

e AUTO
automatically adjusts the output level to the operating conditions.
e On
e enables ALC permanently, regardless of the currently selected mode.
o Off
deactivates ALC.

To maintain a defined output level in Off mode, you can choose either Sample &
Hold (S&H) status or Table.

IIS&HII

activates ALC briefly when frequency or level settings change.

"Table"
uses predefined values from a table to adjust the level at changes.

The following section explains the functionality of "Sample & Hold", to provide an overview
and to indicate what is to be considered. "On" and "Auto" require no additionial explan-
ation. Furthermore, find the ALC state settings described in detail in State - ALC.

ALC OFF (Sample & Hold)

In "S&H" mode, the signal generator switches for a short period of time into CW mode
and activates ALC. ALC adjusts the level to the set value and the generator holds the
value (freeze). Then, the generator switches ALC off again and back to the operating

mode.

RF output behaviour during Sample & Hold depends on the configuration of your instru-
ment. Instruments equipped with...:

e an electronic step attenuator
The level is decreased by 30 dB.

e a mechanical step attenuator

Operating Manual 1407.6062.32 — 08 179



R&S®SMBV100A Instrument Function

RF Signal and Analog Modulations - RF Block

The level control status is permanently displayed as a status message in the info line.

| ALC-Auto Infa

5.4.9.1 Automatic Level Control Settings

To open the "Automatic Level Control" dialog, select "RF/A Mod" > "Configure" > "Auto-
matic Level Control" or use the MENU key under "RF/A Mod".

The combined dialog "ALC / UCOR" is divided into the several sections and provides
access to the "Automatic Level Control" settings and to function "User Correction”, see
chapter 5.4.10, "User Correction”, on page 181).

The top sections of the dialog provide access to the level and attenuator settings (see
chapter 5.4.8.3, "Power-On/EMF Settings", on page 178 and chapter 5.4.8.2, "RF Level
Dialog", on page 174).

Automatic Level Control
State | Off R

Search Once |

Adjust ALC Table |

State - ALC
Activates/deactivates internal level control.

"Auto" The instrument selects the most appropriate ALC mode automatically.
ALC is on in most operating conditions. Default state.

"On" Activates ALC, regardless of the operating conditions.

If "Attenuator Mode Fixed" is selected in addition, the instrument adjusts
the level of every level and frequency setting.

"Off (Sample & Deactivates internal level control.

Hold)" Sample & hold closes the level control loop at every frequency and level
change for a short period of time. The level control voltage is sampled
and then clamped.

"Off (Sample & Deactivates internal level control.
Hold High Works like Sample & Hold, but provides improved level accuracy, by
Accuracy)" increasing the frequency and level setting time up to 20 ms.
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"Off (Table)" Deactivates internal level control.
For each change in the level or frequency, the instrument adjusts the
level using an attenuation setting in a predefined table (ALC table).
The table values are measured in advance and saved with function
"Adjust ALC Table - ALC" on page 181. The table is stored in the
memory of the instrument. Level attenuation between two table values
is done by means of linear interpolation.
This functionality enables faster level adjustments, since the output
signal is not interrupted by the measurement, and also not disturbed.

SCPI command:
[ :SOURce<hw>] : POWer : ALC: OMODe on page 674

SCPI command:
[ : SOURce<hw>] : POWer :ALC[: STATe] on page 675

Search Once - ALC
Forces the generator to execute level adjustment once, although the "Sample & Hold"
mode is active.

SCPI command:
[ :SOURce<hw>] : POWer:ALC: SONCe on page 675

Adjust ALC Table - ALC
Saves ALC readings in an ALC table.

The R&S SMBYV performs ALC adjustments according to these predefined values whith
the functionState - ALC > "Off (Table)".

SCPI command:
:CALibration<hw>:LEVel :ALCTable[:MEASure] on page 458

User Correction

The "User Correction" function is used to create and activate lists in which level correction
values predefined by the user are freely assigned to RF frequencies. Correction is per-
formed by the user-defined table values being added to the output level for the respective
RF frequency.

With frequencies which are not contained in the list, the level correction is determined by
interpolation of the closest correction values.

The lists are created in the "List Editor". Each listis stored in its own file with the predefined
file extension *. uco. The name of the User Correction file can be freely selected. The
files are loaded from the "Lists..." file manager. Externally created tables with pairs of
frequency and level values can be converted into User Correction files using the import
function. The external files must have the file extension *. txt or * . csv. These file
formats are provided e.g. by the Microsoft Excel program. The separators for table col-
umns and for decimal floating-point numerals can be set. In addition, internally created
User Correction data can be exported into ASCII files using the export function.

The amplitude can also be linearized automatically by means of an R&S NRP power
sensor connected to one of the generator output signals. With the aid of the "Fill with

|
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Sensor" function, a table with correction values for external test assemblies can be auto-
matically determined, e.g. for compensating the frequency response of cables. The User
Correction list with the correction values acquired by the sensor is generated in the "Edit
User Correction List" menu. The correction values can be acquired any time irrespective
of the modulation settings of the generator.

If user correction is activated, the "UCOR" display (User Correction) is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

If activated, user correction is effective in all operating modes.

User Correction Menu

To open the "User Correction" menu, select "RF/A Mod > Configure User Correction" or
use the MENU key under "RF/A Mod".

The combined menu "ALC/UCOR" is divided into the several sections.

The top sections provide access to the level and attenuator settings, see chapter 5.4.8.2,
"RF Level Dialog", on page 174, and to the automatic level control settings, see chap-
ter 5.4.9, "Automatic Level Control - ALC", on page 178.

User Correction Settings

The "User Correction" settings are set in the most lower section of the combined dialog;
this section is used to activate/deactivate user correction, and to create, select and acti-
vate the lists.

User Correction Settings

User Correction [ oo0us
User Cor, Data... | ucor
Edit User Cor. Data... |

ImportExpart == |

State - User Correction
Activates/deactivates user correction.

The "UCOR" status message appears in the frequency and level display.

SCPI command:
[ :SOURce<hw>] :CORRection|[:STATe] on page 623

User Correction Value - User Correction
Indicates the current value for level correction.

SCPI command:
[ : SOURce<hw>] : CORRection:VALue on page 623

User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".
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Select User Correction Data
MNew User Correction Data
File Manager...

SCPI command:
[:SOURce] : CORRection:CSET:DELete on page 618
[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 622

Edit User Cor. Data - User Correction
Calls the editor for editing the selected user correction list.

A list consists of any number of frequency/level value pairs. The currently selected list is
displayed.

Each listis saved as a separate file with extension * . uco. The file name and the directory
to which the file is saved are user-selectable.

Note: Save list only after filling both columns (frequency and level), otherwise the entries

are lost.
Edit Uset Cortection Data wcor_listl
Frequency/Hz Power/dB
B £ 300 000.00 542
Fi £ 300 000.00 4.73
8 ¥ 300 000.00 415 J
9 8 300 000.00 372
10 9 300 000.00 3.28 Ll
Goto || Edit | Save |

"Frequency / Enters the frequency to which the level correction value applies.

Hz" Note: The "Fill..." function allows to automatically enter any number of
frequencies with freely selectable range and increment.
Using the "Fill With Sensor" function of the "Edit" sub menu requires
only the entry of the frequency values. The level values are automati-
cally acquired by the connected power sensor.

"Power/dB" Enters the level correction value to which the specified frequency
applies. The values can be entered manually or automatically with the
"Fill With Sensor" function (available in the "Edit" sub menu).

"Goto" Selects row for editing.

Goto First
Goto Last
Goto Row...

If Goto row is selected, a window opens for entering the requested row.

ok | cancer |

|
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"Edit"

"Insert Row"

"Insert Range

"Fill...."

"Fill With Sen-
sor"

"Delete Row"

"Delete
Range..."

"Save as"

llSavell

SCPI command:
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Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Fill With Sensor...
Delete Row
Delete Range...

Insert a new row before the marked row.

Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

|Rows to Insert | |

OK | Cancel |

Opens a sub menu for defining a set of list values to be automatically
entered in the ucor list (see chapter 5.4.10.2, "Filling the Correction List
automatically”, on page 186).

Calls the menu to activate the filling of the user correction list with level
values acquired by the selected power sensor (see chapter 5.4.10.3,
"Filling the Correction List with Power Sensor Measurement

Data", on page 187).

Deletes the marked row.

Allows to delete any number of rows starting with the marked row. The
number of rows to be deleted can be defined in an entry window.

IIRuws to Delete I | I

OK | Cancel |

Open the file menu to save the list under a new name.

Note: Save list only after filling both columns (frequency and level),
otherwise the entries are lost.

Each list is saved to the R&S Signal Generator hard disk as a separate
file with the file prefix * .uco. The file name and the directory to which
the file is saved are user-selectable.

The list is saved under its current name.

[ : SOURce<hw>] : CORRection:CSET[:SELect] on page 622
[ :SOURce<hw>] :CORRection:CSET:DATA: FREQuency on page 617
[ : SOURce<hw>] : CORRection:CSET:DATA: POWer on page 617

Import/Export

User correction list can be imported from externally created files or exported into text or
CSV-files. The import/export settings are available after clicking the "Import/Export" but-

ton.

|
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Import/Export >>>
Expands the menu with the area for import and export of user correction files.

Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or CSV-files and used for user correction.

Conversely, you can also export internally created user correction lists as text or CSV-
files.

=== Hide Imporb'Exportl

Import / Export UCOR Files
lMode IImp-:lrt vli

ASCI File Settings

=== Hide Imporb'Exportl

——Import/Export UCOR Files
lMode IExp-:lrt vli

ASCIH File Settings

Extension IT}ZT 'l Extension
IP-Jint vl
IC-Jmma vl

IP-Jint vl
IC-Jmma vl

Decimal Point Decimal Foint

Column Separator Column Separator

Select ASCIl Source | Select ASCII Destinatiolj

Mone Mone
Select Destination | Select Source |

Mone Mone

Mode - User Correction
Selects if user correction lists should be imported or exported. The settings offered
depend on the selected mode.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange :MODE on page 621

Extension - User Correction
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.

SCPI command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:EXTension on page 619

Decimal Point - User Correction
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:DECimal
on page 621

Column Separator- User Correction
Selects the separator between the frequency and level column of the ASCII table the user
correction list is exported to or imported from.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:COLumn
on page 620

|
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Select ASCII Source / Destination - User Correction
Calls the "File Manager" for selecting the ASCII file to be imported into a user correction
list (source) or the ASCII file the user correction list is exported (destination) in.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe: SELect on page 620

Destination / Source - User Correction
Calls the "File Manager" for selecting the user correction list to be exported (source) into
an ASCII file or the destination for the ASCII file to be imported (destination) in.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:SELect on page 622

Import / Export - User Correction
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:EXECute on page 621

Filling the Correction List automatically

The "Fill Table" menu enables you to automatically set the level correction values.

Fill User Correction Data

From |—1
Range |—3
Select column to fill IW
Start Value | 0.00 |[Hz =]
End Value | 0.000 000000000 [Hz =]
Increment Value | 0.000 000 000 000 |Hz =]

l Fill !

The start line and the number of rows to be filled are defined under "From" and "Range.

The column to be filled is selected under "Select column to fill". Depending on the selec-
tion here, the default for start, end, and increment value are set. As the settings are
interdependent, a change of one parameter may result in the automatic change of one
or more of the other parameters. The filling of the column with the selected value settings
is started with button "Fill".

N\ The correction list entries are only computed when the "Fill" button is pressed.
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From
Sets the start value of the index range.

SCPI command:
n.a.

Range
Sets the range for filling the table.

SCPI command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined below.

SCPI command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

SCPI command:
n.a.

End value
Displays the end value for the frequency or the level entries.

SCPI command:
n.a.

Increment value
Sets the increment for the frequency or the level entries.

SCPI command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

SCPI command:
n.a.

Filling the Correction List with Power Sensor Measurement Data

The level correction values for the user correction list can be acquired by means of R&S
NRP power sensors. The R&S NRP sensors are connected to either the SENSOR con-
nector or to one of the USB interfaces. Configuration of the connection is performed in
the "Power Sensor" menu (see chapter 5.4.6, "NRP-Z Power Viewer", on page 163). The
filling of the ucor list with measurement data is performed in the ucor list editor (see "Edit
User Cor. Data - User Correction" on page 183).

In the editor, the frequencies for which the correction values are to be acquired are
entered in the frequency column (either manually or by means of the "Fill..." menu).
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Do not save the list at this point, because the frequency entries are lost as long as there
/ are no entries for the level column also. In the following these entries are automatically
acquired by the connected power sensor.

All level correction values for the given frequency values are measured using the Power
Sensor and automatically filled in the selected list after the "Execute" button is pressed.
The list is automatically stored and recalled again after filling.

Fill User Correction Data with Sensor Settings

The "Fill with Sensor" button of the "Edit User Correction Data" menu opens the associ-

ated menu.
Sensor I Mo Sensors Found J
List ToFill  [ciucor_smby

I Execute I

— Used SMBV Settings For Measurement ——

Modulation Off (CW)

Amplitude I -30.00 I dBm |
Use SParameter I Off

Attenuator Mode Auto

Fixed Range (PEP) In:

[5980.0 ... [6000.0 dBm

The menu indicates the relevant generator settings.

Fill User Correction Data with Sensor
All settings are read-only, except the "Sensor". In case more than one sensor is connec-
ted to the instrument, the sensor can be selected in the "Sensor" field of menu.

The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.

SCPI command:
[ :SOURce<hw>] : CORRection:CSET:DATA[ : SENSor<ch>] [ : POWer] : SONCe
on page 618

5.4.11 Reverse Power Protection

The reverse power protection is tripped when the power of the external signal becomes
too high. A relay opens and interrupts the internal connection to the RF output. This
condition is indicated in the display header by the "OVERLOAD" status message.

Overload
If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.
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The RF input is activated when the overload protection is reset.

SCPI command:
:0UTPut<hw>:PROTection:TRIPped on page 484
:OUTPut<hw>:PROTection:CLEar on page 484
:OUTPut<hw>[:STATe] on page 484

Analog Modulations

Overview

The R&S SMBYV provides the analog modulations amplitude modulation (AM), frequency
modulation (FM), phase modulation (PhiM) and pulse modulation (PM). In addition, the

RF signal can be modulated with internal modulations waveforms, e.g. sine waves and

rectangular signals.

Amplitude, frequency and phase modulation are available for the basic unit (R&S SMBV
+ frequency option R&S SMBV-B10x) without additional equipment options. A standard
LF generator is provided for internal modulation.

Pulse modulation and a pulse generator are provided by options R&S SMBV-K22, Pulse
Modulator and R&S SMBV-K23, Pulse Generator, respectively.

Settings for the modulation are made in separate modulation menus. These menus can
be accessed in the block diagram by way of the "RF/A Mod" function block, or by means
of the menu with the same name which is opened using the MENU key.

Enabling/Disabling Analog Modulations using the MOD On/Off Key
The MOD ON/OFF key switches the modulations on and off.

MOD ON/OFF
Press the MOD ON/OFF key to enable/disable analog modulations.

Pressing the key again restores the status that was active before the last switch-off. "MOD
OFF" is displayed in the info line of the header next to the "Level" field.

SCPI command:
[ :SOURce<hw>] :MODulation[:ALL] :STATe on page 669

Modulation Sources

The following modulations use internal and external modulation sources:
e Amplitude modulation

e Pulse modulation

e Frequency modulation

e Phase modulation

|
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Internal Modulation Sources

An LF generator and a pulse generator are available as internal modulation sources for
a fully equipped instrument. The LF generator supplies sinusoidal or rectangular signals.

The optional pulse generator provides single and double pulse modulation with selectable
pulse widths and periods.

The noise generator supplies white noise with selectable bandwidth and level distribution.

See also chapter 5.4.13.1, "Overview of LF Generator", on page 201.

External Modulation Sources

The modulation inputs MOD EXT and PULSE EXT at the rear of the instrument are pro-
vided as the external modulation source for amplitude, pulse, frequency and phase mod-
ulation.

The external modulation signal at the input must have a voltage of Ug =1V (Ugrr = 0.707
V)in order to achieve the displayed modulation depth and range. The input voltage should
not exceed 1.1 Vs, otherwise modulation distortions might occur. With external pulse
modulation, the switching point is max. 2.4 V and the voltage at the input should not
exceed 5 V. The maximum modulation frequency is 10 MHz for frequency and phase
modulation.

Simultaneous Operation of Several Modulations or Other Operating Modes

The table shows the modulations and operating modes which can be activated simulta-
neously (+) or which deactivate each other (-).

AM FM PhiM Pulse I[e]
Amplitude modulation (AM) / + + (+)* -
Frequency modulation (FM) + / - + +
Phase modulation (PhiM) + - / + +
Pulse modulation (+)* + + / +
Vector modulation (1/Q) - + + + /

* (+) = compatible with reduced AM modulation performance

5.4.12.2 Amplitude Modulation (AM)

An internal or external source can be selected for amplitude modulation. The LF GEN
modulation generator is available as the internal source. The 1/Q modulator is used for
amplitude modulation. Two-tone AM is possible by simultaneously switching on the
external and internal source.

The MOD EXT and PULSE EXT input connectors for external feed of analog modulation
signals are at the rear of the instrument. The coupling mode of the input (AC or DC) can
be selected.
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It is not possible to use AM simultaneously with:
e |/Q modulation,
e arbitrary waveform generation,

digital modulation and

digital standards.

The AM modulation depth is limited by the maximum peak envelope power (PEP).

Amplitude Modulation Settings

To open the "Amplitude Modulation" dialog, select "RF/A Mod > Configure > Amplitude
Modulation" or use the MENU key under "RF/A Mod".

In the upper section of the dialog, the modulation source is selected and the modulation
switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the dialog or in the "LF Output" dialog (internal source only).

These settings affect all modulations which use the same modulation source.

State

AM Source Int+Ext =

AM Depth I 30.0 1% -

AM Source = INTemal

NE

LFGen Freq | to0000fkHz  +|
LFGen Shape m
AM Source = EXTernal————
AM Sensitivity [ 300 % per Volt
Mod Ext Coupling AC =
Ext Impedance m

State
Activates/deactivates AM modulation.

Activation of AM deactivates:

e |/Q modulation,

e arbitrary waveform generation,
e digital modulation and

e digital standards.

SCPI command:
[ :SOURce<hw>] :AM: STATe on page 495

AM Source
Selects the source for the AM signal.

"Internal” Selects the internal LF generator as the source for AM modulation.

|
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"External” Selects the external source.

The external signal is input via the EXT MOD connector.
"Intern + Selects the internal and external source at the same time. This setting
Extern" enables two-tone AM modulation.

SCPI command:
[ : SOURce<hw>] : AM: SOURce on page 495

AM Depth
Sets the modulation depth in percent.

Note: With two-tone modulation, observe that the set modulation depth is valid for both
signals and the sum modulation depth is determined by doubling the set modulation
depth. This results in overmodulation if the maximal value for modulation depth is excee-
ded (see data sheet).

SCPI command:
[ :SOURce<hw>] :AM[:DEPTh] on page 494

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 648

LF Gen Shape
Selects the waveform shape of the LF signal.

SCPI command:
[ :SOURce] : LFOutput<ch>:SHAPe on page 655

AM Sensitivity
(Source External only)

Displays the input sensitivity of the EXT MOD input in %/V.

The modulation depth entered under "AM Depth" is reached with 1 volt modulation of the
input.

SCPI command:
[ :SOURce<hw>] : AM: SENSitivity on page 495

AM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

SCPI command:
[ :SOURce<hw>] :AM:EXTernal : COUP1ing on page 494
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External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 634

Frequency Modulation (FM)

An internal and/or external source can be selected for frequency modulation. The LF GEN
modulation generator is available as the internal source. Two-tone FM is possible by
simultaneously switching on the external and internal source.

The MOD EXT and PULSE EXT input connectors for external feed of analog modulation
signals are at the rear of the instrument. The coupling mode of the input (AC or DC) can
be selected.

Selection between three modulation modes is possible:

e "Normal" mode with full setting range for modulation bandwidth and FM deviation.

e "Low Noise" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth

e "High Deviation" mode with full setting range for FM deviation and a reduced setting
range for modulation bandwidth (see data sheet).

N\ Itis not possible to use frequency modulation simultaneously with phase modulation.

Analog Mod —
Amplitude Maod_..
Frequency Mod._.
Phase Mod...
Pulse Mod...

Frequency Modulation Settings

To open the "Frequency Modulation" menu, select "RF/A Mod > Configure > Frequency
Modulation" or use the MENU key under "RF/A Mod".

In the upper section of the menu, the modulation source is selected and the modulation
is switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the menu (internal source only).

These settings affect all modulations which use the same modulation sources.

|
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Frequency Modulation

State

FM Source IInt+Ex1 'I
FM Mode INDrmaI vl
FM Deviation I 1.000 UIkHz vI

FM Source = INTernal
LFGenFreq |  1.00000 |kHz ~|

LFGen Shape ISine 'I

FM Source = EXTemnal

Adjust FM Oﬁ’setl
FM Sensitivity I 500.00 Hz/MNVolt

Mod Ext Coupling  |AC -

Ext Impedance IHigh 'I

State
Activates/deactivates FM modulation.

Activation of FM deactivates phase modulation.

SCPI command:
[ :SOURce<hw>] : FM: STATe on page 626

FM Source
Selects the source for the FM signal.
"Internal" Selects the internal LF generator as the source for FM modulation.
"External” Selects the external source.

The external signal is input via the EXT MOD connector.
"Internal + Selects the internal and external source at the same time.
External" This setting enables two-tone FM modulation.

SCPI command:
[ :SOURce<hw>] : FM: SOURce on page 625

FM Mode

Selects the mode for the frequency modulation.

"Normal" The maximum range for modulation bandwidth and FM deviation is
available.

"Low Noise" Frequency modulation with phase noise and spurious characteristics

close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced (see data sheet).

"High Devia- Frequency modulation with full setting range for FM deviation. The
tion" range for modulation bandwidth is reduced (see data sheet).

SCPI command:
[ : SOURce<hw>] : FM: MODE on page 624
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FM Deviation
Sets the modulation deviation in Hz.

The deviation is given as the absolute deviation in relation to the set center frequency,
e.g. a deviation 5 MHz at a center frequency of 1 GHz leads to a frequency modulation
between 995 MHz and 1005 MHz.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

The deviation of the internal source must not exceed the deviation of the external source
in case of modulation source "Int+Ext".

SCPI command:
[ :SOURce<hw>] :FM[:DEViation] on page 624

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 648

LF Gen Shape
Selects the waveform shape of the LF signal.

SCPI command:
[ :SOURce] : LFOutput<ch>:SHAPe on page 655

FM Sensitivity
(Source External only)

Displays the input sensitivity of the EXT MOD input in Hz/V.

The modulation depth entered under "FM Depth" is reached with 1 Volt (= U,) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occur.

SCPI command:
[ : SOURce<hw>] : FM: SENSitivity on page 625

Adjust FM Offset
Starts the adjustment for the FM/PhiM modulator. The option is adjusted with respect to
DC-offset.

SCPI command:
:CALibration<hw>:FMOFfset[:MEASure] on page 457

FM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.
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Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

"AC" The d.c. voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

SCPI command:
[ :SOURce<hw>] :FM:EXTernal : COUP1ing on page 624

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 634

Phase Modulation (PhiM)

N\ It is not possible to use phase modulation simultaneously with frequency modulation.

Analog Mod —
Amplitude Mod. ..
Frequency Mod. ..

Phase Mod___

Pulse Mod...

An internal and/or external source can be selected for phase modulation. The LF GEN
modulation generator is available as the internal source.

The MOD EXT and PULSE EXT input connectors for external feed of analog modulation
signals are at the rear of the instrument. The coupling mode of the input (AC or DC) and
the impedance can be selected.

Selection between the following modulation modes is possible:

e "Normal" mode with full setting range for modulation bandwidth and PhiM deviation.

e "Low Phase" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth and deviation (see data sheet)

e "High Deviation" mode with full setting range for PhiM deviation and a reduced setting
range for modulation bandwidth. Phase noise is reduced in the lower modulation
frequency range compared to the default mode.

Phase Modulation Menu

To open the "Phase Modulation" menu, select "RF/A Mod > Configure > Phase Modula-
tion" or use the MENU key under "RF/A Mod".

|
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(=] E4
State
PhiM Source IInt+Ex1 v|
PhilM Mode INDrmaI =
PhiM Deviation | 1.000 00 Irad ~|
PhiM Source = INTernal
LFGenFreq | 100000[kHz  ~|

LFGen Shape ISine v|

PhiM Source = EXTernal

PhiM Sensitivity I 0.500 000 rad per Valt
Mad Ext Coupling IAC vl

Ext Impedance IHigh v|

In the upper section of the menu, the modulation source is selected and the modulation
switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the menu (internal source only).

These settings affect all modulations which use the same modulation sources.

State
Activates/deactivates PhiM modulation.

Activation of PhiM deactivates frequency modulation.

SCPI command:
[ :SOURce<hw>] : PM:STATe on page 673

PhiM Source
Selects the source for the PhiM signal.
"Internal” Selects the internal LF generator as the source for PhiM modulation.
"External” Selects the external source.
The external signal is input via the EXT MOD connector.
"Internal + Selects the internal and external source at the same time.
External"

SCPI command:
[ : SOURce<hw>] : PM: SOURce on page 673

PhiM Mode
Selects the mode for the phase modulation.
"Normal" The full range for modulation bandwidth and PM deviation is available.
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"High Devia- The maximum range for PhiM deviation is available. Phase noise is
tion" improved for low frequencies compared to the default mode. The range
for modulation frequency is limited (see data sheet).

This mode is recommended for low modulation frequencies and/or high
PhiM deviation.

"Low Phase" Phase modulation with phase noise and spurious characteristics close
to CW mode. The range for modulation bandwidth and PM deviation is
reduced (see data sheet).

SCPI command:
[ : SOURce<hw>] : PM: MODE on page 672

PhiM Deviation
Sets the modulation depth in RAD or degrees.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

SCPI command:
[ :SOURce<hw>] :PM[:DEViation] on page 671

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

SCPI command:
[:SOURce] : LFOutput : FREQuency on page 648

LF Gen Shape
Selects the waveform shape of the LF signal.

SCPI command:
[ :SOURce] : LFOutput<ch>:SHAPe on page 655

PhiM Sensitivity
(Source External only)

Displays the input sensitivity of the EXT MOD input in RAD/V.

The modulation depth entered under "PhiM Depth" is reached with 1 volt (=U,.4) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occeur.

SCPI command:
[ :SOURce<hw>] :PM:SENSitivity on page 673

Mod External Coupling
Selects the coupling mode (AC OR DC) for external feed.
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Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

"AC" The DC voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

SCPI command:
[ :SOURce<hw>] :PM:EXTernal :COUPling on page 671

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 634

Pulse Modulation (PM)

External and internal Pulse modulation requires options R&S SMBV-K22, Pulse Modu-
lator and R&S SMBV-K23, Pulse Generator.

An internal or external source can be selected for pulse modulation. In case of external
source, the external signal is input via the PULSE EXT connector at the rear of the instru-
ment. In case of internal source, this connector can be used as external trigger or gate

signal input for internal pulse modulation. The polarity and input impedance of the con-

nector can be selected.

The pulse signal is output at the PULSE VIDEO connector at the rear of the instrument.

)\ Automatic Level Control is deactivated with pulse modulation!

_L/ When pulse modulation is activated, the ALC state of the R&S SMBYV is automatically

changed to "ALC OFF" ("Sample & Hold"). In this state, the ALC loop is opened and the
output level is not regulated but the level modulator is set directly. In order to set the
correct output level, a sample & hold measurement is executed after each frequency or
level setting.

The level is decreased by 30 dB during "Sample&Hold" measurement.

Analog Mod -
Amplitude Mod...
Frequency Mod. ..

Pulse Modulation Settings

To open the "Pulse Modulation" menu, select "RF/A Mod > Configure > Pulse Modula-
tion" or use the MENU key under "RF/A Mod".

In the upper section of the menu, the modulation source is selected and the modulation
switched on. The configuration of the selected external and/or internal modulation source
is performed in the lower section of the menu.

The menu varies according to the selected modulation source.
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4

=] 4
State
Source | Pulse Generator j

Pulse Generator
Pulse Mode |Doub|e =l
Pulse Period | 1.000 000 | ms |
Pulse Width | 0.500000 [ms =]
Double Pulse Width | 0.200000 [ms =]
|

Double Pulse Delay 0700000 [ms x|

Input/Trigger Settings

Trigger Mode I Ext Triggered 'l
Ext Trigger Input Slope |Positive vl
External Impedance IED Chm 'l

In case of modulation source pulse generator, the settings for the pulse characteristics
and the trigger are offered in the "Pulse Generator" section of the "Pulse Modulation"
dialog. Option R&S SMBV-K23 offers extended features, e.g. generation of double pulse
or selection of trigger mode. For description of the pulse generator dialog, see chap-
ter 5.4.13.3, "Pulse Generator", on page 203.

The output of the video/sync signal at the PULSE VIDEO output is automatically switched
on when activating pulse modulation. It can be switched off in the "Pulse Generator"
menu.

State
Activates/deactivates pulse modulation.

Activation of pulse modulation deactivates ALC and power ramping.

When the internal modulation source (pulse generator) is selected, the pulse generator
is switched on automatically and the video/sync signal is output at the PULSE VIDEO
output at the rear of the instrument. Signal output can be switched off in the "Pulse Gen-
erator" dialog (see chapter 5.4.13.3, "Pulse Generator", on page 203).

SCPI command:
[ : SOURce<hw>] : PULM: STATe on page 688

Source
Selects the source for the pulse modulation signal.

"Pulse Genera- Selects the Pulse Generator as modulation source.

tor" The settings for the pulse characteristics and the trigger are offered in
the "Pulse Generator" section of the "Pulse Modulation" menu.
"External” Selects the external source.

The external modulation signal is input via the EXT MOD connector.

SCPI command:
[ : SOURce<hw>] : PULM: SOURce on page 688

Polarity

(External Source only)

Operating Manual 1407.6062.32 — 08 200



R&S®SMBV100A

Instrument Function

5.4.13

5.4.131

5.4.13.2

Modulation Generator
LF Generator/ Cutput.

RF Signal and Analog Modulations - RF Block

Selects the polarity of the modulation signal.
"Normal" The RF signal is On while the level is high at the modulation input.
"Inverted" The RF level is ON while the level is LOW at the modulation input.

SCPI command:
[ :SOURce<hw>] : PULM: POLarity on page 687

LF Generator and LF Output - Mod Gen

Overview of LF Generator

An LF generator providing sinusoidal and square signals in the frequency range 0.1 Hz
to 1 MHz is available for the basic unit without additional equipment options.

The internal LF generator is available as the internal source for the analog modulations
AM, FM / PM and Pulse, and also as the signal source for the LF output at the rear of the
instrument.

The frequency setting for the LF generator can be made both in the modulation dialogs
and in the "LF Generator / Output” dialog. The settings are effective for all modulations
using the internal modulation source.

A change to the frequency of the LF generator automatically has an effect on modulation
if the LF generator is selected as the modulation source (i.e. "Internal" is selected as
"Source").

The LF Sweep mode is activated in the "LF Frequency Sweep" dialog (see chap-
ter 5.4.14.4, "LF Frequency Sweep", on page 221). "RF frequency" and "RF Level"
sweeps are activated in the respective dialogs of the RF block.

The option Pulse Generator (R&S SMBV-K23) enables the generation of single and dou-
ble pulse signals.

The generator is activated and configured in the "Pulse Generator" dialog of the "Mod
RF/A Mod" block or in the "Pulse Modulation" dialog ("Pulse Generator" is selected as
Source).

LF Output

To open the combined "LF Frequency Sweep / LF Output" dialog, select "RF/A Mod" >
"Configure" > "LF Generator / Output" or use the MENU key under "RF/A Mod".

To open the "LF Generator / Output" dialog, select "RF A/ MOD" > "Configure" > "LF
Generator / Output" or use the MENU key under "Mod Gen".

The "LF Output" dialog provides access to the configuration of the internal modulation
generators. In addition, the LF output is configured in this menu. The available settings
depend on the source selected and on the installed options.

In the upper section of the menu, the LF output is switched on. The configuration of the
internal source is performed in the lower section of the "LF Output" menu or in the indi-

Operating Manual 1407.6062.32 — 08 201



R&S®SMBV100A Instrument Function
I EEEEEEEEE———
RF Signal and Analog Modulations - RF Block

vidual modulation menus (e.g. "Amplitude Modulation" menu). These settings affect all
modulations which use the same modulation sources and the LF output.

=IES
State
Display LFGen Level as Voltage of EMF r
Out Violage [ 1000 [mv x|
Source J LFGen 2+MNoise ;l
Out Voltage 2 | s00 [mv =]
LFGen 2 Shape ] Sine ;I
LFGen 2 Freq | 1.00000 [ kHz x|
DC Offset | ofmv =]

NoIse

Distribution ! Gauss ll
Bandwidth Limitation [~ on
Moise Level [ 5.2 |dBVjHz |

LF Output Dialog

State - LF Output
Activates/deactivates the LF output. This setting has no effect on the modulations.

The modulation signal is output at the LF OUTPUT connector of the instrument.

SCPI command:
[:SOURce] : LFOutput [:STATe] on page 651

Output Voltage - LF Output
Sets the output voltage of the LF output. The entered value determines the peak voltage.

SCPI command:
[ :SOURce] : LFOutput : VOLTage on page 655

LF Gen Frequency

Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 648

LF Gen Shape
Selects the waveform shape of the LF signal.

SCPI command:
[ :SOURce] : LFOutput<ch>:SHAPe on page 655

LF Source Impedance
Selects the output impedance of the LF generator. Selection LOW and 600 Ohm are

available.

|
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For instruments with older version of the RF board, the LF output impedance is forced to
LOW and cannot be changed.

SCPI command:
[ :SOURce] : LFOutput: SIMPedance on page 655

Pulse Generator

The "Pulse Generator" dialog is used to activate and configure a pulse modulation signal.

To open the "Pulse Generator" dialog, select "RF/A Mod" > "Configure" > "Pulse Gener-
ator" or use the MENU key under "RF/A Mod". Alternatively, you can configure the pulse
generator in the "Pulse Modulation" dialog of the "RF/A Mod" block.

Lioix

FideoISync SignalState ﬁ

Fulse Generatar

Fulse Mode lm
Fulse Period IWIE,
Pulse Width [ zoofes <]
_|Pulse Delay I—DMIE,
ConnectorTrigger Settings
Trigger Mode IW
Ext Trigger Input Slope lm
External Impedance lm

Use SIGHNALVALID as Pulse Syne ¥ on

Pulse Generator Settings

The dialog provides the settings for the pulse characteristics and trigger mode.

Video Sync Signal State - Pulse Generator

Switches on/off the output of the video/sync signal at the PULSE VIDEO connector. The
signal output and the pulse generator are automatically switched on with activation of
pulse modulation if pulse generator is selected as modulation source. The signal output
can be switched off subsequently.

SCPI command:
[ :SOURce<hw>] : PGEN: STATe on page 669

Pulse Mode - Pulse Generator
Sets the mode of the pulse generator.

"Single" A single pulse is generated in one pulse period.

"Double" Two pulses are generated in one pulse period. Additional settings for
the double pulse are available in the menu.

SCPI command:
[ :SOURce<hw>] : PULM: MODE on page 686

|
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Pulse Period - Pulse Generator
Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

SCPI command:
[ :SOURce<hw>] : PULM: PER1io0d on page 687

Pulse Width - Pulse Generator
Sets the width of the generated pulse. The width determines the pulse length. The pulse
width must be at least 20 ns less than the set pulse period.

SCPI command:
[ : SOURce<hw>] : PULM:WIDTh on page 690

Pulse Delay - Pulse Generator
(External trigger only)

Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts. The pulse delay is not effective for double pulse
generation.

SCPI command:
[ :SOURce<hw>] : PULM: DELay on page 685

Double Pulse Width - Pulse Generator
(Double Pulse only)

Sets the width of the second pulse.

SCPI command:
[ :SOURce<hw>] : PULM: DOUBle:WIDTh on page 686

Double Pulse Delay - Pulse Generator
(Double Pulse only)

Sets the delay from the start of the first pulse to the start of the second pulse.

SCPI command:
[ :SOURce<hw>] : PULM: DOUBle: DELay on page 685

Trigger Mode - Pulse Generator
Selects the trigger mode for pulse modulation.

"Auto" The pulse generator signal is generated continuously.

|
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The pulse generator signal is triggered by an external trigger event. The
trigger signal is supplied via the PULSE EXT connector.

Example: Generation of pulse signals using trigger modes Ext
Triggered (Single Pulse)

The measurement were made using a 6-dB-attenuator.

Parameter Value
Trigger Mode Ext Triggered
Double Pulse State Off
External Trigger Input Slope Positive
Pulse Delay 100 ns
Pulse Width 100 ns
Pulse Period -
Tek Run | i = ] Getriggert
T T A 0,00V
@ -2.04V
g 1:
- -
T A i
@M .00 v GAJCh2[ 1.00V & H[100ns] A Chi 4 620mV)
Ch3[ 1.00v Q| 4 Jul 2006
>+ [436.000ns 07:10:44

Channel = Indicates the external trigger signal which is input at the PULSE EXT con-

1 nector. The positive slope is active.
Channel = Indicates the sync signal. The sync signal starts after a trigger delay of typi-
2 cally 50 ns (see specifications). The sync signal is output at the PULSE

SYNC connector.
Channel = Indicates the pulse signal. The pulse signal starts after the set pulse delay of
3 100 ns. It is output at the PULSE VIDEO connector.

Example: Generation of pulse signals using trigger modes Ext
Triggered (Double Pulse)

The measurement were made using a 6-dB-attenuator.

Parameter Value
Trigger Mode Ext Triggered
Double Pulse State On

External Trigger Input Slope Negative
Pulse Width 100 ns
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Parameter Value
Double Pulse Width 100 ns
Double Pulse Delay 200 ns

Pulse Period, Pulse Delay -

ek Stop | E'] = 1
T T T T T T T T T Ta: o0.00v
; : @ —-2.04V

1.00 v 2%Ch2[ 1.00V 2 H 100ns| A Ch1 L 580mVv

Cch3[ 1.00vVQ | 4Jul 2006
i+~ 436.000ns 07:39:07

Chan- = Indicates the external trigger signal which is input at the PULSE EXT connec-

nel 1 tor. The negative slope is active. A second trigger signal during double pulse
generation is without effect.

Chan- = Indicates the sync signal. The sync signal starts after a trigger delay of typically

nel 2 50 ns (see specifications). The sync signal is output at the PULSE SYNC con-
nector.

Chan- = Indicates the double pulse signal. The first pulse starts without a delay. The

nel 3 second pulse starts after the set double pulse delay (time between start of first

pulse to start of second pulse). The double pulse is output at the PULSE
VIDEO connector.
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"Ext Gated" The pulse generator signal is gated by an external gate signal.
The signal is supplied via the PULSE EXT connector.

Example: Generation of pulse signals using trigger modes Ext
gated (Single Pulse)

The measurement were made using a 6-dB-attenuator.

Parameter Value
Trigger Mode Ext Gated
Double Pulse State Off
External Trigger Input Slope Positive
Pulse Delay 100 ns
Pulse Width 100 ns
Pulse Period 300 ns
Tek Run | [ii hd ] Getriggert
'u':":":' A o o AL 0,00V
! ! ! T@ —-2.04 ¥
| P ‘
- - Gaocas
73 - S - " " T
ioioin

@ 100 v onjch2[ 1.00 v & [H[100ns| A| Ch1 4 SS0mv|

ch3[ 1.00Ve | 4jul 2006
i+~ [436.000ns | 07:36:54
Chan- = Indicates the external gate signal which is input at the PULSE EXT connector.
nel 1 The signal is active when it is high (positive).
Chan- = Indicates the sync signal. The sync signal starts after a trigger delay of typically
nel 2 50 ns (see specifications). It is repeated after the set pulse period of 300 ns

as long as the gate signal is active. The sync signal is output at the (PULSE)
SYNC connector.
Chan- = Indicates the pulse signal. The first pulse starts after the pulse delay of 100
nel 3 ns. The second pulse starts after the set pulse period. They are output at the
(PULSE) VIDEO connector.
SCPI command:
[ :SOURce<hw>] : PULM: TRIGger : MODE on page 689

External Trigger Input Slope - Pulse Generator
(External Trigger only)

Sets the polarity of the active slope of an applied trigger signal.

"Positive" The pulse generator is triggered on the positive slope of the external
trigger signal.

|
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"Negative" The pulse generator is triggered on the negative slope of the external
trigger signal.

SCPI command:
[ :SOURce<hw>] : PULM: TRIGger :EXTernal : SLOPe on page 689

Gate Input Polarity - Pulse Generator
(Trigger Mode External Gated only)

Selects the polarity of the Gate signal.

The signal is supplied via the PULSE EXT connector.

"Normal" The pulse signal is generated while the gate signal is high.
"Inverse" The pulse signal is generated while the gate signal is low.

SCPI command:
[ :SOURce<hw>] : PULM: TRIGger:EXTernal : GATE : POLarity on page 688

Pulse External Input Impedance
Selects the inputimpedance (10 kOhm or 50 Ohm) for the external trigger and gate signal
input (PULSE EXT).

SCPI command:
[ :SOURce<hw>] : PULM: TRIGger :EXTernal : IMPedance on page 689

Use SIGNAL VALID as Pulse Sync
Configures the signal at the SIGNAL VALID connector (rear panel):

"selected" Indicates the validity of the RF signal at the output:
e high: while the signal settles.
e Jow: when it is stable (valid).

"cleared" Generates a single pulse at the beginning of a pulse sequence, e.g. to
synchronize pulse modulation.

SCPI command:
[ :SOURce<hw>] : PULM:OUTPut : SYNC[: STATe] on page 686

Sweep Mode

Overview

The R&S Signal Generator offers three different sweep types (frequency sweep, level
sweep and LF sweep) to be activated alternatively. Each type has 6 modes which differ
with respect to the sweep cycle mode (continuous, individual and step-by-step) and trig-
gering mode (automatic, internal and external).

)\ Sweeps and List mode can not be activated simultaneously, they deactivate each other.

Operating Manual 1407.6062.32 — 08 208



R&S®SMBV100A Instrument Function

RF Signal and Analog Modulations - RF Block

Setting a sweep

A sweep is set in five basic steps which are shown below taking a frequency sweep as
an example.

1. Set the sweep range ("Start Freq" and "Stop Freq" or "Center Freq" and "Span").
2. Select linear or logarithmic sweep spacing ("Spacing").

3. Set the step width ("Step Lin/Log") and dwell time ("Dwell Time").

4. Activate the sweep ("Mode" to Auto, Single, Step or Extern Single, Extern Step).
5. Trigger the sweep, except for Auto mode ("Execute Single Sweep", Current Fre-
quency or External Trigger Signal).

N\ It is recommended to switch off the GUI update for optimum sweep performance espe-
/ cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 115).

5.4.14.2 RF Frequency Sweep

The dialog is used to activate and configure a sweep for the RF frequency.

To open the "Frequency Sweep" menu, select "RF/A Mod > Configure > RF Frequency
Sweep" or use the menu tree of the MENU key under "RF Signal".

Lol S
LF Frequency Sweep...

In the top section of the menu, the RF sweep mode is activated and the sweep mode is
selected.

The buttons are used to reset the RF sweep (all sweep modes) or to execute the RF
sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

The sweep range of the RF sweep can be entered in two ways, either by entering the
"Start" and "Stop" value or by entering the "Center" and "Span".

The two sets of parameters influence each other in the following way:

e "Start Freq" = "Center Freq" - "Span"/2

e "Stop Freq" = "Center Freq" + "Span"/2

e "Center Freq" = ("Start Freq" + STOP FREQ)/2

e "Span" ="Stop Freq" - "Start Freq"
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Mode |Extem Single |
Reset Sweep |
Start Freq 100.000 000 000 | MHz x|

Stop Freg 500.000 000 000 | MHz x|

|
|
Center Freq | 300.000 000 000 [ MHz =]
!
|

Span 400.000 000 000 | MHz  »|
Current Freq 100.000 000 000 | MHz -]
Spacing Im
Shape Im
Step Lin | 1.000000000 [MHz =]
Dwell Time [100[ms =]

Ext Trigger Input Slope I Positive 'I

RF Frequency Sweep Settings

State - Frequency Sweep

Activates/deactivates RF sweep mode.

Note: Activating the RF-Sweep mode automatically disables other sweep modes, and

the list mode.

SCPI command:

[ : SOURce<hw>] : FREQuency : MODE on page 630

Mode - Frequency Sweep

Selects the sweep instrument operating mode and the sweep mode.

"Auto" Sets an automatic repeated sweep cycle. If a different sweep mode was

activated prior to the "Auto" mode, the cycle continues from the current
sweep setting.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR AUTO
SOUR:FREQ:MODE SWE
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"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button.
If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The "Single" sweep always starts at the start
frequency when triggered.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR SING
SOUR:FREQ:MODE SWE
SOUR: SWE: FREQ: EXEC

"Step” Sets a step-by-step sweep cycle.
When mode "Step" is activated, the frequency is set to the sweep "Start
Freq".
To step through the sweep frequencies manually, open the "Current
Freq" field for input and use the UP / DOWN navigation keys or the
rotary knob.
You can determine the step width below in the entry field "Step Lin" or
"Step Log", see Step Lin/Log - Frequency Sweep.
If a sweep range border frequency ("Start Freq" or "Stop Freq") is
reached, step commands in direction out of the sweep range are
ignored.
The "Reset Sweep" button resets the sweep to the start frequency.

Note: To step through the sweep frequencies in remote control mode,
use the FREQ : MAN command with the UP or DOWN parameter.

Example:

SOUR:FREQ:CENT 300MHz

SOUR:FREQ:SPAN 400MHz
SOUR: SWE: FREQ:SPAC LIN
SOUR:SWE:FREQ:STEP:LIN 100MHz

SOUR: FREQ:MODE MAN

set sweep mode "Step".

SOUR:FREQ:MODE SW

activate sweep mode, the frequency is set to "Start Freq".
SOUR:FREQ:MAN UP

set the frequency to the next higher sweep frequency.
SOUR: FREQ:MAN DOWN

set the frequency to the next lower sweep frequency.
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"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
If a different sweep mode was activated prior to the "Extern Single"
mode, the current sweep is stopped. The "Extern Single" sweep always
starts at the start frequency when triggered.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 25).
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)

"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width is set below at entry field "Step Lin" or "Step
Log".

If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts

at the start frequency when triggered.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR: SWE: FREQ:MODE STEP
SOUR: SWE: FREQ: SPAC LIN

SOUR: SWE: FREQ: STEP:LIN 1MHz
TRIG:FSW:SOUR EXT

SOUR: FREQ:MODE SWE (External trigger)
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"Extern Start/  Sets an automaticly repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/
Stop" mode, the current sweep is stopped and the "Extern Start/Stop"
sweep starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start frequency.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input.
The external trigger signal is input at the rear of the instrument (BNC
connector INST TRIG).

Example:

SOUR: SWE : FREQ :MODE AUTO
TRIG:FSW:SOUR EAUT
SOUR:FREQ:MODE SWE (External trigger)

SCPI command:

[ :SOURce<hw>] : SWEep [ : FREQuency] : MODE on page 694
:TRIGger<hw>:FSWeep: SOURce on page 721

[ :SOURce<hw>] : FREQuency : MODE on page 630

Execute Single Sweep - Frequency Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : EXECute on page 694

Reset Sweep - Frequency Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

SCPI command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 701

Start Freq - Frequency Sweep
Sets the start frequency.

SCPI command:
[ : SOURce<hw>] : FREQuency: STARt on page 632

Stop Freq - Frequency Sweep
Sets the stop frequency.

SCPI command:
[ : SOURce<hw>] : FREQuency: STOP on page 632

|
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Center Freq - Frequency Sweep
Sets the center frequency.

SCPI command:
[ :SOURce<hw>] : FREQuency : CENTer on page 627

Span - Frequency Sweep
Sets the span.

SCPI command:
[ : SOURce<hw>] : FREQuency : SPAN on page 631

Current Freq - Frequency Sweep
Displays the current frequency.

If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

SCPI command:
[ :SOURce<hw>] : FREQuency :MANual on page 629

Spacing - Frequency Sweep
Selects linear or logarithmic sweep spacing.

"Linear" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The step width is entered below.

"Logarithmic" With the logarithmic sweep, the step width is a constant fraction of the
current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered below in %.

SCPI command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : SPACing on page 696

Shape - RF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape).

i
sawlooth shape
slop L e  — — —

frequency - P
-~ -~ o
.’"" .".-' .'"-'
o~ -~ -
.’"’" .'l'" ."'".
Al L~ e

ey

oD trigngle shape
B Lsan oy ",
siart o -
Hsqancy = — — — — —— — — — e = ————
T -
"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep

starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.
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"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape

of the sweep resembles a triangle. Each subsequent sweep starts at
the start frequency.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : SHAPe on page 696

Step Lin/Log - Frequency Sweep

Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is

selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The linear step width is entered
in Hz.

SCPI command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : STEP [ : LINear] on page 697

"Step Log" With the logarithmic sweep, the step width is a constant fraction of the
current frequency. The logarithmic step width is entered in %.
Successive frequencies are calculated as follows:
e start_f <stop_f
f2=1*(1+ step_log/100)
If f2 > stop_f: f2 is set to stop_f.
o start_f > stop_f
f2=11/(1+ step_log/ 100)
If f2 < stop_f: f2 is set to stop_f.
When the shape "Triangle" is set, the frequency values on the slope

from stop_f back to start_f are the same as on the slope from start_f
to stop_f.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : STEP: LOGarithmic on page 698

Dwell Time - Frequency Sweep

Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
3

.

| Setting, Dwell time
| time | (effective)
i gy g

Signal Level

r

_ . Time
Dwell Time" o

{set by the user)

Ll
™
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:
It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 115).

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : DWEL1 on page 693

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

SCPI command:
[ :SOURce] : INPut: TRIGger: SLOPe on page 636

RF Level Sweep

To open the "Level Sweep" menu, select "RF/A Mod > Configure > Level Sweep" or use
the MENU key under "RF/A Mod".

RF Level Sweep Settings
The "RF Level Sweep" dialog is used to activate and configure a sweep for the RF level.

In the top section, the Level Sweep is activated and the sweep mode is selected. The
buttons are used to reset the level sweep (all sweep modes) or to execute the level sweep
("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

Mode ISingIe 'l
Execute Single Sweepl
Reset Sweep |

Use Digital Attenuation [~ On

Start Level I -SD.DDIdEIm 'l
Stop Level I -1D.DD|dElm 'l
Current Level I -SD.DDIdEIm 'l

Shape ISawtooth 'l
Step I 1.00 IdEI vl
Cweell Time I 1D.D|ms 'l

State - Level Sweep
Activates Level Sweep mode.
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Note: Activating the RF level sweep mode automatically disables other sweep modes,
and the list mode.

SCPI command:
[ : SOURce<hw>] : POWer : MODE on page 680

Mode - Level Sweep
Selects the level sweep instrument operating mode and the sweep mode.

"Auto" Sets an automatically repeated sweep cycle. If a different sweep mode
was activated prior to the "Auto" mode, the cycle continues from the
current sweep setting.

The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR AUTO
SOUR: POW:MODE SWE

"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button.
If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The single sweep always starts at the start
level.
The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE : POW : MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : POW: EXEC
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"Step” Sets a step-by-step sweep cycle.
If this mode is activated, the cursor moves to the value displayed for
"Current Level". Each sweep step is triggered by a variation of the value
in the "Current Level" entry window. The step width is set below at entry
field "Step".
If this mode is activated, the cursor moves to the value displayed for
"Current Level". If a different sweep mode was activated prior to the
"Step" mode, the current sweep is stopped. The step sweep starts at
the current level value.
The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE : POW: MODE MAN
SOUR:SWE:POW: STEP 0.5
SOUR: POW:MODE SWE
SOUR:POW:MAN -16

The value entered with command SOUR: SWE : POW: STEP sets the step
width.

The value entered with command SOUR : POW : MAN has no effect, the
command only triggers the next sweep step. However, the value has to
be in the currently set sweep range (start to stop). In remote control only
a step-by-step sweep from start to stop frequency is possible.

"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
If a different sweep mode was activated prior to the "Extern Single"
mode, the current sweep is stopped. The "Extern Single" sweep always
starts at the start level.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 25).
The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)
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"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width of the rotary knob.
If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts
at the start level.

The "Reset Sweep" button resets the sweep to the start level.

Example:

SOUR: SWE : POW:MODE STEP
SOUR: SWE: POW: STEP 0.5
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)

"Extern Start/  Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/
Stop" mode, the current sweep is stopped and the "Extern Start/Stop"
sweep starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start level.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 25).

Example:
SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR EAUT
SOUR: POW:MODE SWE (External trigger)
SCPI command:
[ :SOURce<hw>] : SWEep: POWer : MODE on page 699
: TRIGger<hw>:PSWeep: SOURce on page 723.
[ : SOURce<hw>] : POWer : MODE on page 680

Reset Sweep - Level Sweep
Resets the sweep. The start level is set and the next sweep starts from there.

SCPI command:
[ : SOURce<hw>] : SWEep:RESet [ :ALL] on page 701

Execute Single Sweep - Level Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

|
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Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : EXEC

SCPI command:
[ :SOURce<hw>] : SWEep: POWer : EXECute on page 699

Use Digital Attenuation
Activates the use of digital attenuation during RF power sweep.

SCPI command:
[ :SOURce<hw>] : SWEep:POWer : DATTenuator: STATe on page 698

Start Level - Level Sweep
Sets the start level.

SCPI command:
[ :SOURce<hw>] : POWer : STARL on page 683

Stop Level - Level Sweep
Sets the stop level.

SCPI command:
[ :SOURce<hw>] : POWer: STOP on page 684

Current Level - Level Sweep
Displays the current level.

If "Step" is set, the level for the next level step of the sweep is entered here.

SCPI command:
[ :SOURce<hw>] : POWer:MANual on page 679

Shape - RF Level Sweep
Selects the cycle mode for a sweep sequence (shape).

"Sawtooth" One sweep runs from the start level to the stop level. The subsequent
sweep starts at the start level again, i.e. the shape of sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop level and back, i.e. the shape of the
sweep resembles a triangle. Each subsequent sweep starts at the start
level again.

SCPI command:
[ :SOURce<hw>] : SWEep: POWer : SHAPe on page 700

Step - Level Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.
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With the level sweep, the logarithmic step width is a constant fraction of the current level.
This fraction is added to the current level. The logarithmic step width is entered in dB.

SCPI command:
[ :SOURce<hw>] : SWEep:POWer: STEP [ : LOGarithmic] on page 701

Dwell Time - Level Sweep

Enters the dwell time and determines the duration of the individual sweep steps.
L

.

| Setting, Dwell time
| time | (effective)
i* N g

Signal Level

T
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-

Dwell Time"
(set by the user)

The "Dwell Time" set by the user is used as the step time of the sweep. The effective net

dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:

It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 115).

SCPI command:
[ : SOURce<hw>] : SWEep: POWer : DWEL1 on page 698

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.

"Negative" The falling edge of the trigger signal is active.
SCPI command:
[ :SOURce] : INPut: TRIGger : SLOPe on page 636

5.4.14.4 LF Frequency Sweep

|—Modulation Generatar —|

.| The "LF Frequency Sweep" dialog is used to activate and configure a sweep for the LF

LF Freguency Sweep..

........................................................................... frequency_

To open the "LF Frequency Sweep" menu, select "RF/A Mod" > "Configure" > "LF Fre-
quency Sweep" or use the MENU key under "RF/A Mod".
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In the top section, the LF Sweep mode is activated and the sweep mode is selected. The
buttons are used to reset the LF sweep (all sweep modes) or to execute the LF sweep
("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom of the section.

LF Frequency Sweep

Mode |Extern Single |

Reset Sweep |

Start Freg | 1.0000 [kHz =]
Stop Freg | 500000 [kHz =]
Current Freq | 1.000 0 | kHz j
Spacing Im
Shape Im
Step Lin | 10000 ([kHz Z]
Dwell Time [100[ms =]

Ext Trigger Input Slope I Positive 'I

State - LF Sweep
Activates LF Sweep mode.

Note: Activating the LF frequency sweep automatically deactivates the list mode, RF
level sweep and RF frequency sweep.

SCPI command:
[ :SOURce] : LFOutput : FREQuency : MODE on page 649

Mode - LF Sweep
Selects the Sweep instrument operating mode and Sweep mode.

"Auto" Sets are automatic repeated sweep cycle. If a different sweep mode
was activated prior to the "Auto" mode, the cycle continues from the
current sweep setting.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR AUTO
SOUR:LFO:FREQ:MODE SWE
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Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button.

If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The "Single" sweep always starts at the start
frequency.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO

TRIGO:SWE:SOUR SING

SOUR:LFO:FREQ:MODE SWE

SOUR:LFO:SWE: FREQ:EXEC

Sets a step-by-step sweep cycle. Each sweep step is triggered by a
variation of the value in the "Current Freq" entry window.

If this mode is activated, the cursor moves to the value displayed for
"Current Freq". If a different sweep mode was activated prior to the
"Step" mode, the current sweep is stopped. The "Step" sweep starts at

the current LF frequency.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE:FREQ:MODE MAN
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE:FREQ:SPAC LIN
SOUR:LFO:SWE:FREQ:STEP:LIN 1E34
SOUR:LFO:FREQ:MAN 12 kHz

The value entered with command
SOUR:LFO:SWE:FREQ:STEP: LIN | LOG sets the step width.

The value entered with command SOUR : LFO : FREQ : MAN has no effect,
the command only sets the next sweep step. In remote control only a
step-by-step sweep from start to stop frequency is possible

Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.

If a different sweep mode was activated prior to the "Extern Single"
mode, the current sweep is stopped. The "Extern Single" sweep always
starts at the start frequency.

The external trigger signal is input at the BNC connector INST TRIG.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)
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"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width set for the rotary
knob.

If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts
at the LF start frequency.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)

"Extern Start/  Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/
Stop" mode, the current sweep is stopped and the "Extern Start/Stop"
sweep starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start frequency.
The external trigger signal is input at the BNC connector INST TRIG.

Example:
SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EAUT
SOUR:LFO:FREQ:MODE SWE (External trigger)
SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : MODE on page 652
:TRIGger<hw>[:SWEep] : SOURce on page 724
[ :SOURce] : LFOutput: FREQuency : MODE on page 649

Execute Single Sweep - LF Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] :EXECute on page 651

Reset Sweep - LF Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

SCPI command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 701

|
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Start Freq - LF Sweep
Sets the start frequency.

SCPI command:
[ :SOURce] : LFOutput: FREQuency: STARt on page 650

Stop Freq - LF Sweep
Sets the stop frequency.

SCPI command:
[ :SOURce] : LFOutput: FREQuency : STOP on page 651

Current Freq - LF Sweep
Displays the current frequency.

If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

SCPI command:
[ :SOURce] : LFOutput: FREQuency :MANual on page 649

Spacing - LF Sweep

Selects linear or logarithmic sweep spacing.

SCPI command:

[:SOURce] : LFOutput:SWEep [ : FREQuency] : SPACing on page 653

Shape - LF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape)

j
sawtooth shape
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"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep
starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape

of the sweep resembles a triangle. Each subsequent sweep starts at
the start frequency.

SCPI command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : SHAPe on page 653

Step Lin/Log - LF Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.
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"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is

selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The linear step width is entered in
Hz.

SCPI command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : STEP [ : LINear] on page 654
"Step Log" With the logarithmic sweep, the step width is a constant fraction of the

current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered in %.

SCPI command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : STEP: LOGarithmic on page 654

Dwell Time - LF Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
3

.

| Sefting, Dwell time
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:
It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 115).

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : DWEL1 on page 651

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

SCPI command:
[ :SOURce] : INPut: TRIGger: SLOPe on page 636
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List Mode

Similar to a sweep, a series of previously defined frequency and level points is processed
in List mode. In contrast to a sweep, however, a list with freely selectable value pairs
(frequency and level) can be created. The value range for frequency and level covers the
entire configurable value range of the instrument.

N\ List mode and sweeps can not be activated simultaneously, they deactivate each other.

5.4.15.1

|———ListMode —
[ List Mode...

The lists can be created in the "List Editor". Each list is stored in its own file with the
predefined file extension * . 1sw. The name of the list file can be freely selected. The files
are loaded from the "Lists..." file manager. Externally created tables with pairs of fre-
quency and level values can be converted into List files using the import function. The
external files must have the file extension * . txt or * . csv. These file formats are pro-
vided e.g. by the Microsoft®?Excel program. The separators for table columns and for
decimal floating-point numerals can be set. In addition, internally created List data can
be exported into ASCII files using the export function.

The necessary hardware settings are calculated the first time a list is processed. With
long dwell times, this calculation can be performed while the list is being processed; the
entered dwell times are observed. With very short dwell times, calculation of the hardware
settings increases the dwell time for the initial processing cycle; the entered value is only
observed from the second processing cycle onwards. In this case a message appears to
inform the user that there is a deviation between the current and set dwell times. No
further calculations are required after the first run through a list. The current dwell times
will definitely no longer deviate from the set dwell times.

The list is processed from the beginning to the end of the list (modes "Auto", ("Exter-
nal") "Single", ("External") "Step").

List Mode Dialog

To open the "List Mode" menu, select "RF/A Mod > Configure > List Mode" or use the
MENU key under "RF/A Mod".

The menu is used to activate/deactivate the operating mode List, to create, select and
activate the lists, and to select the trigger mode and the dwell time.

|
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List Mode

State

Mode | Extern Single |
Dwell Time I 10.000 I ms 'I
Current Index I 0

Learn List Mode Data |

List Mode Data... | None

Edit List Mode Data... |
List Range In: | I 0 I 9 (wl

Import/Export >=> |

General Settings

State - List Mode
Activates/deactivates the List mode. The currently selected list is processed.

In case of a new or modified list, the necessary hardware settings are automatically
determined on activation of the list mode. The data determined in this way is stored along
with the list and is available whenever the list is used again.

This means that when activating the list mode, the system checks whether any hardware
settings are present. If so, the list is started immediately, but if not they are automatically
determined (the list is learnt).

A "Learn List Mode Data" button is available for deliberately activating list learning.

Note: Activating the list mode automatically deactivates all sweeps. During list mode the
frequency and level indications do not display the currently set values.

SCPI command:
[ : SOURce<hw>] : FREQuency : MODE on page 630

Mode - List Mode
Selects the cycle mode of the List mode.

"Auto" Cycle from the beginning to the end of the list with automatic restart at
the beginning. If a different mode was activated prior to the Auto mode,
the cycle continues from the beginning of the list. The duration of a list
step is determined by the set dwell time.

Button "Reset" restarts the list at the starting point.

"Single" Single cycle from the beginning to the end of the list. If "Single" is
selected, the cycle is not started immediately. The "Execute Single"
button appears under the "Mode" line. The cycle is started with this
button. The duration of a list step is determined by the set dwell time.
Button "Reset" restarts the list at the starting point.

IMode | Single J
Execute Single |
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"Step" Manual, step-by-step processing of the list. Activating "Step" stops the
current list and the cursor moves to the value displayed for "Current
Index". It is now possible to scroll up and down in the list in discrete
steps by varying the index. The duration of a list step is determined by
the time between two index entries.
Butt